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23 Monitoring [bookmark: sthref942]Oracle Business Activity Monitoring

This chapter describes how to view Oracle Business Activity Monitoring (Oracle BAM) performance statistics and logs using Oracle Enterprise Manager Fusion Middleware Control.

This chapter includes the following topics:


	
Section 23.1, "Introduction to Monitoring Oracle BAM"



	
Section 23.2, "Monitoring Oracle BAM Server Components"



	
Section 23.3, "Monitoring Oracle BAM Web Applications"



	
Section 23.4, "Monitoring Oracle BAM Web Services"



	
Section 23.5, "Monitoring Oracle BAM Performance"



	
Section 23.6, "Monitoring Oracle BAM Logs"





[bookmark: CIHDICCI][bookmark: SOAAG3696]

23.1 Introduction to Monitoring Oracle BAM

You can monitor several aspects of the Oracle BAM components using Oracle Enterprise Manager Fusion Middleware Control.

The OracleBamServer page in Fusion Middleware Control enables you to monitor each of the Oracle BAM Server Components: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. See Section 23.2, "Monitoring Oracle BAM Server Components" for more information.

The OracleBamWeb page in Fusion Middleware Control enables you to monitor Oracle BAM Report Server. See Section 23.3, "Monitoring Oracle BAM Web Applications" for more information.

In addition, the Performance Summary pages for each component allow you to track specific statistics of your choosing. See Section 23.5, "Monitoring Oracle BAM Performance" for more information.

Also, you can configure and monitor Oracle BAM logs using Fusion Middleware Control. See Section 23.6, "Monitoring Oracle BAM Logs" for more information.
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23.2 Monitoring Oracle BAM Server Components

Oracle BAM Server components are monitored on the Fusion Middleware Control page for Oracle BAM Server.

To monitor Oracle BAM Server components:

Go to the Oracle BAM Server home page by selecting BAM > OracleBamServer in the navigation tree.

In the OracleBamServer page, you can select each tab (Active Data Cache, Event Engine, Report Cache, Enterprise Message Sources) to monitor the individual Oracle BAM Server components.







	
Note:

Alternatively, on the farm home page, you can also select the Oracle BAM targets from the right side page content area, where it displays details of the farm.
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23.2.1 Monitoring Oracle BAM Active Data Cache

Oracle BAM [bookmark: sthref943]Active Data Cache (Oracle BAM ADC) is designed and optimized to handle large amounts of data in real time. Data coming into Oracle BAM ADC immediately updates all defined calculations and aggregates in real time in an in-memory cache so that this data can be pushed as quickly as possible to Oracle BAM dashboards and reports. Data fed to the Oracle BAM ADC is received from a combination of sources, from Java Message Service (JMS) topics and queues to more traditional data queries and databases. Oracle BAM ADC ensures that no matter the source, when Oracle BAM Server is aware of the incoming data, it is streamed to Oracle BAM alerts and dashboards as incremental changes.

There are two key components to the Oracle BAM ADC, data sets and view sets. Oracle BAM ADC receives transactions (insert, update, upsert, delete) into the data sets. These data sets are constructed based on the design that an Oracle BAM developer defines for data relationships when data objects are defined in Oracle BAM Architect. Data objects can be reflective of flat tables of data, or more complex, star-schema relationships between data objects, which are represented in Oracle BAM as data object look-ups.

After data is updated in the data sets, view sets that are listening on these data sets go into action. The view sets have knowledge of all of the open Oracle BAM dashboards and alerts that users are viewing in the Oracle BAM system. View sets ensure that data updates to these open objects are incrementally updated first, using a push-based mechanism to publish updates to open dashboards and alerts, providing users with the latest information.

Use the Oracle BAM pages in Fusion Middleware Control to monitor statistics for all data objects in Oracle BAM ADC as a group, or select a particular data object from the Data Objects list to monitor.

[image: Description of bam_server_adc_tab.gif follows]










	
Note:

When you select a data object from the list, cached data is displayed to preserve performance. You must refresh the page (using the Refresh icon) to display the latest data associated with the selected data object. [image: Description of bam_em_refresh.gif follows]
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25 Configuring Oracle User Messaging Service

This chapter describes how to configure Oracle User Messaging Service (UMS).

This chapter includes the following topics:

	
Section 25.1, "Introduction to User Messaging Service"


	
Section 25.2, "Introduction to Oracle User Messaging Service Configuration"


	
Section 25.3, "Accessing User Messaging Service Configuration Pages"


	
Section 25.4, "Configuring User Messaging Service Drivers"


	
Section 25.5, "Configuring User Messaging Service Access to LDAP User Profile"


	
Section 25.6, "Securing User Messaging Service"


	
Section 25.7, "Troubleshooting Oracle User Messaging Service"






25.1 Introduction to User Messaging Service

Oracle User Messaging Service enables two-way communication between users and deployed applications. Key features include:

	
Support for a variety of messaging channels: Messages can be sent and received through email, instant messaging (IM) (XMPP), short message service (SMS) (SMPP), and voice. Messages can also be delivered to a user's SOA/WebCenter worklist.


	
Two-way messaging: In addition to sending messages from applications to users (referred to as outbound messaging), users can initiate messaging interactions (inbound messaging). For example, a user can send an email or text message to a specified address; the message is routed to the appropriate application that can then respond to the user or invoke another process according to its business logic.


	
User messaging preferences: End users can use a web interface to define preferences for how and when they receive messaging notifications. Applications immediately become more flexible; rather than deciding whether to send to a user's email address or IM client, the application can simply send the message to the user, and let UMS route the message according to the user's preferences.




	
Note:

The User Messaging Preferences UI is available at:
http://host:port/sdpmessaging/userprefs-ui

The User Messaging Preferences UI is also embedded in Oracle BPM Worklist. You can access it by choosing Preferences > Notification.










	
Robust message delivery: UMS keeps track of delivery status information provided by messaging gateways, and makes this information available to applications so that they can respond to a failed delivery. Or, applications can specify one or more failover addresses for a message in case delivery to the initial address fails. Using the failover capability of UMS frees application developers from having to implement complicated retry logic.


	
Pervasive integration within Oracle Fusion Middleware: UMS is integrated with other Fusion Middleware components providing a single consolidated bi-directional user messaging service.

	
Integration with Oracle BPEL Process Manager: Oracle JDeveloper includes prebuilt BPEL activities that enable messaging operations. Developers can add messaging capability to a SOA composite application by dragging and dropping the desired activity into any workflow.


	
Integration with human workflow: UMS enables the human workflow service engine to send actionable messages to and receive replies from users over email.


	
Integration with Oracle BAM: Oracle BAM uses UMS to send email alerts in response to monitoring events.


	
Integration with Oracle WebCenter: UMS APIs are available to developers building applications for Oracle WebCenter Spaces. The API is a realization of Parlay X Web Services for Multimedia Messaging, version 2.1, a standard web service interface for rich messaging.









25.1.1 Components

There are three types of components that make up Oracle User Messaging Service. These components are standard Java EE applications, making it easy to deploy and manage them using the standard tools provided with Oracle WebLogic Server.

	
UMS Server: The UMS Server orchestrates message flows between applications and users. The server routes outbound messages from a client application to the appropriate driver, and routes inbound messages to the correct client application. The server also maintains a repository of previously sent messages in a persistent store, and correlates delivery status information with previously sent messages.


	
UMS Drivers: UMS Drivers connect UMS to the messaging gateways, adapting content to the various protocols supported by UMS. Drivers can be deployed or undeployed independently of one another depending on what messaging channels are available in a given installation.


	
UMS Client applications: UMS client applications implement the business logic of sending and receiving messages. A UMS client application might be a SOA application that sends messages as one step of a BPEL workflow, or a WebCenter Spaces application that can send messages from a web interface.




In addition to the components that make up UMS itself, the other key entities in a messaging environment are the external gateways required for each messaging channel. These gateways are not a part of UMS or Oracle WebLogic Server. Since UMS Drivers support widely-adopted messaging protocols, UMS can be integrated with existing infrastructures such as a corporate email servers or XMPP (Jabber) servers. Alternatively, UMS can connect to outside providers of SMS or text-to-speech services that support SMPP or VoiceXML, respectively.






25.1.2 Architecture

The system architecture of Oracle User Messaging Service is shown in Figure 25-1.

For maximum flexibility, the components of UMS are separate Java EE applications. This allows them to be deployed and managed independently of one another. For example, a particular driver can be stopped and reconfigured without affecting message delivery on all other channels.

Exchanges between UMS client applications and the UMS Server occur as SOAP/HTTP web service requests for web service clients, or through remote Enterprise JavaBeans (EJB) and JMS calls for BPEL messaging activities. Exchanges between the UMS Server and UMS drivers occur through JMS queues.

Oracle UMS server and drivers are installed alongside Oracle SOA Suite or Oracle BAM in their respective Oracle WebLogic Server instances. A WebCenter installation includes the necessary libraries to act as a UMS client application, invoking a server deployed in a SOA instance.


Figure 25-1 UMS Architecture

[image: Description of Figure 25-1 follows]












25.2 Introduction to Oracle User Messaging Service Configuration

Oracle User Messaging Service enables users to receive notifications sent from SOA applications that are developed and deployed to the Oracle WebLogic Server using Oracle JDeveloper.

At the application level, there is notification activity for a specific delivery channel (such as SMS or email). For example, when you build a SOA application that sends email notification, you drag and drop an Email activity from the Oracle JDeveloper Component Palette to the appropriate location within a workflow. The application connects then sends notifications.

For more information about Oracle JDeveloper, see your Oracle JDeveloper documentation.

To enable the workflow participants to receive and forward notifications, use Oracle Enterprise Manager Fusion Middleware Control to set the Oracle User Messaging Service environment by configuring the appropriate driver instances that reside on the same Oracle WebLogic Server on which you deploy the workflow application (Figure 25-2). Oracle User Messaging Service includes drivers that support messaging through email, IM, SMS, and voice channels. For more information, see Section 25.4, "Configuring User Messaging Service Drivers."


Figure 25-2 Oracle Enterprise Manager Fusion Middleware Control

[image: EM Grid Control]






For workflow participants to receive the notifications, they must register the devices that they use to access messages through User Messaging Preferences (Figure 25-3).


Figure 25-3 User Messaging Preferences

[image: User Preferences screen]










25.3 Accessing User Messaging Service Configuration Pages

You configure Oracle User Messaging Service through Oracle Enterprise Manager Fusion Middleware Control.



25.3.1 Setting the Storage Method

Use the Server Properties page to set the deployment type for the Messaging Server (that is, select the storage method for runtime and management data) and add (or remove) the User Messaging Preference Business Terms that are used for creating message filters.

Select Persistent (the default) to enable entries and the Messaging Store to persist when the server has been restarted. In the Transient mode (which is recommended for lightweight deployments), the Messaging Server does not maintain any data stored in the Messaging Store after a restart.






25.3.2 Adding or Removing User Messaging Preferences Business Terms

The Server Properties page enables you to add or remove the business terms used to construct the message filters in User Message Preferences. For more information about building messaging filters with business terms, see Section 25.3.2.1, "Adding Business Terms."



25.3.2.1 Adding Business Terms




	
Note:

Business terms are stored per server instance. If there are multiple instances (as in a cluster), then new business terms must be added to each instance individually.







To add a business term to User Messaging Preferences:

	
Click Add.


	
Enter a descriptive name for the business term.


	
Select a data type (string, number, or date).


	
Click Apply.









25.3.2.2 Removing Business Terms

To remove a business term from User Messaging Preferences:

	
Select the business term.


	
Click Delete.


	
Click Apply to confirm the new term.













25.4 Configuring User Messaging Service Drivers

Oracle User Messaging Service includes the following drivers.

	
Configuring the Messaging Extension Driver


	
Configuring the Email Driver


	
Configuring the SMPP Driver


	
Configuring the XMPP Driver


	
Configuring the VoiceXML Driver


	
Configuring the Worklist Driver


	
Configuring the Proxy Driver







	
Note:

For the cluster environment, when you use separate messaging drivers for separate managed server nodes, all the drivers must be configured separately.
UMS Messaging Drivers are configured per instance. Configuring only one does not populate the configuration values to the drivers on the other cluster nodes.











25.4.1 Configuring a Driver

To configure a driver:

	
Log in to Oracle Enterprise Manager Fusion Middleware Control as an administrator.


	
Expand the Fusion Middleware folder.


	
Navigate to the User Messaging Service home page.

[image: Description of ns_login.gif follows]




	
Click usermessagingserver(soa_server1). The Associated Drivers page appears.

[image: Description of ns_assoc_drv.gif follows]




	
Select the Local tab to access the drivers collocated with the UMS server instance. These drivers may or may not be registered with the UMS server depending on whether they are properly configured. The ALL tab lists all drivers that are deployed in the domain and registered to all the UMS server instances.


	
Find the email driver in the list, and then click the adjacent Configure Driver icon.

The configuration page is displayed.

[image: Description of ns_configdriver.gif follows]




	
If needed, expand the Driver-Specific Configuration section and configure the driver parameters. For more information, see Section 25.4.1.1, "Introduction to Driver Properties."






25.4.1.1 Introduction to Driver Properties

Oracle User Messaging Service drivers share common properties (listed in Table 25-1) that are used by the Messaging Engine when routing outbound messages. Typically, administrators set such Quality of Service (QoS) properties as driver cost (Cost) and driver speed (Speed), supported carriers (SupportedCarriers), and supported protocols (SupportedProtocols). Driver developers configure properties that typically do not require modification by the administrator, such as supported delivery types (SupportedDeliveryTypes), and supported content types (SupportedContentTypes).




	
Note:

Properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies.








Table 25-1 Common Driver Properties

	Name	Description	Mandatory Property?
	
Capability

	
Sets the driver's capability to send or receive messages. The values are SEND, RECEIVE, and BOTH.

	
Yes


	
Cost

	
The cost level of the driver (from 0 - 10). 0 is least expensive; 10 is most expensive. If the value is not in this range, cost is considered to be 0.

	
No


	
DefaultSenderAddress

	
The default address of the sender. The driver uses these addresses when sending a message that has no sender address specified, or when the specified sender address is not in the sender addresses list and the driver does not support using the application-provided sender address.

	
No


	
SenderAddresses

	
The list of sender addresses that the driver supports. If provided by the driver, the messaging engine can use this to route a sending message to the driver by matching against the sender address of the message.

	
No


	
SendingQueuesInfo

	
The information for the driver sending queue.

	
Yes


	
Speed

	
The speed level of the driver (from 0-10, with 10 being the fastest).

	
No


	
SupportedCarriers

	
A comma-delimited list of supported carriers.

	
No


	
SupportedContentTypes

	
The content type supported by the driver.

	
Yes


	
SupportedDeliveryTypes

	
The delivery types supported by the driver.

	
Yes


	
SupportedProtocols

	
A comma-delimited list of supported protocols. Enter an asterisk (*) for any protocol.

	
No


	
SupportedStatusTypes

	
The status types supported by the driver.

	
No


	
SupportsCancel

	
Supports a cancel operation on a message.

	
No


	
SupportsReplace

	
Supports a replace operation on a message.

	
No


	
SupportsStatusPolling

	
For certain protocols, an active polling of the remote gateway must be performed to check the status of a message previously sent. This property indicates whether the driver supports such status polling. If set to true, the messaging engine invokes the driver connection's getStatus() operation.

	
No


	
SupportsTracking

	
Supports a tracking operation on a message.

	
No












25.4.1.2 Securing Passwords

Sensitive driver properties (namely, passwords) can be stored securely in the credential store using Oracle Enterprise Manager Fusion Middleware Control. Properties are marked with the flag Encoded Credential and have a custom entry form field.

To store a sensitive driver property securely:

	
Go to the driver configuration page of the selected driver.


	
In the Driver-Specific Configuration section, locate the property with the Encoded Credential flag set.


	
Select the credential type. (Depending on the selected credential type, you are prompted to enter the username and/or password.) There are three options:

	
Indirect password, create new user (default option): specify the username and real password; the password is stored in the credential store with the username as part of the key. The key and a fixed folder (map name) are stored in the driver deployment's driverconfig.xml file.


	
Indirect password, use existing user: choose an existing username/key in the credential store (to reference the password you stored previously).


	
User a clear text password: specify the password, and it is stored directly in the driverconfig.xml file.





	
Click Apply to save the changes.


	
Restart the driver application or the container for the changes to take effect.




You can check the password in the driver deployment directory's driverconfig.xml file. For an indirect password, the format is:


value="->mapName:keyName"    (mapName is the driver target name, and the key is <parameter_name>.<username>)


For example, here is a sample entry in driverconfig.xml for an email driver's OutgoingPassword property:


<Property value="-&gt;
/Farm_base_domain/base_domain/server_soa/usermessagingdriver-email:
OutgoingPassword.ouser" encodedCredential="true" 
type="java.lang.String" mandatory="no" name="OutgoingPassword" description="oracle.sdp.messaging.EmailDriverConfig.outgoingPassword"/>






25.4.1.3 Configuring the Messaging Extension Driver

The extension driver extends the messaging capability of the User Messaging Service by enabling support for arbitrary administrator-defined channels (protocols) and delivering the notifications for such channels to an administrator-defined web service listener endpoint.




	
Note:

An instance of this driver is deployed, but not targeted to any servers in the default installation. To enable this driver instance, it must be targeted to the appropriate servers where UMS (usermessagingserver) is running.









25.4.1.3.1 Driver Application Archive (EAR)

The EAR file is $oracle_home/communications/applications/sdpmessagingdriver-extension.ear.






25.4.1.3.2 Common Properties

These are common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties (such as sendingqueuesinfo) are for advanced use and only require modification for advanced deployment topologies. See Table 25-2. For a complete description of these properties and available values, see the JavaDoc for driverconfigpropertynames.


Table 25-2 Extension Driver Common Properties

	Name	Description	Mandatory?	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
Extension-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
SEND


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
URI


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain, text/html, text/xml


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	

	
Speed

	
Speed

	
No

	

	
SupportedCarriers

	
Supported carriers

	
No

	

	
SupportedProtocols

	
Supported protocols

	
No

	
popup


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	

	
DefaultSenderAddress

	
Default sender address

	
No

	

	
SendingQueuesInfo

	
Driver sending queue info

	
Yes

	
OraSDPM/QueueConnectionFactory:OraSDPM/Queues/OraSDPMDriverDefSndQ1












25.4.1.3.3 Custom Properties

This driver supports multiple configuration groups called extension endpoint groups. An extension endpoint group holds the configuration for a remote endpoint at which to deliver extension notifications. Each endpoint must have a distinct combination of protocol and mapped domain. The properties of the extension endpoint group are listed in Table 25-3:


Table 25-3 Extension Driver Custom Properties

	Name	Description	Mandatory?
	
Group Name

	
The name of this extension endpoint configuration group.

	
Yes


	
Endpoint URL

	
Remote endpoint listener URL.

	
Yes


	
Mapped Domain

	
The extension endpoint used to deliver messages where the domain part of the recipient URI matches this value.

	
No


	
Protocol

	
The extension endpoint used to deliver messages where the protocol (scheme) part of the recipient URI matches this value.

	
Yes


	
Security Policies

	
Comma-separated list of WS-Security policies to apply to this endpoint.

	
No


	
Username

	
Username to propagate through WS-Security headers.

	
No


	
Keystore Alias

	
Keystore alias to use for looking up WS-Security policy public keys.

	
No


	
Credential Store Key

	
Key to use for looking up the WS-Security username and password from the Oracle Web Services Management credential store map.

	
No












25.4.1.3.4 Extension Driver Security

If the remote extension endpoint is secured using WS-Security, then additional configuration of the extension driver is required. There are two typical WS-Security configurations that are supported. The extension driver can either use SAML tokens or username tokens.

To use extension driver security:

	
To use SAML tokens, the Security Policies configuration property should contain value oracle/wss11_saml_token_identity_switch_with_message_protection_client_policy, and the Keystore Alias configuration property should contain a valid alias for keystore entries that is accepted by the remote extension endpoint.


	
To use username tokens, the Security Policies configuration property should contain value oracle/wss11_username_token_with_message_protection_client_policy, and the Credential Store Key configuration property should contain a valid alias for a credential store entry that is accepted by the remote extension endpoint.




For more details about using WS-Security policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.






25.4.1.3.5 Client API Messageinfo Support

Table 25-4 describes whether the protocol or driver implementation honors the following message delivery-related properties that are specified through the client API.


Table 25-4 Client API MessageInfo Support

	Name	Description	Supported?
	
Expiration

	
Expiration means how much later in seconds for the message to expire.

	
False


	
Delay

	
Delay means how much later to send the message out.

	
False












25.4.1.3.6 Usage Instructions

Perform the following steps to use the extension driver:

To use the extension driver:


	
Implement and deploy a web service listener endpoint based on the MessagingNotifyService WSDL (umsnotify.wsdl):


<?xml version="1.0" encoding="UTF-8" standalone="no"?>
<wsdl:definitions xmlns:soap="http://schemas.xmlsoap.org/wsdl/soap/"
                  xmlns:tns="http://xmlns.oracle.com/ucs/messaging/extension"
                  xmlns:wsdl="http://schemas.xmlsoap.org/wsdl/"
                  xmlns:xsd="http://www.w3.org/2001/XMLSchema"
                  name="MessagingNotifyService"
                  targetNamespace="http://xmlns.oracle.com/ucs/messaging/extension">
 
    <wsdl:types>
 
    <xsd:schema targetNamespace="http://xmlns.oracle.com/ucs/messaging/extension">
      <xsd:element name="notification">
        <xsd:complexType>
          <xsd:sequence>
            <xsd:element name="messageId" type="xsd:string" minOccurs="0" maxOccurs="1">
              <xsd:annotation>
                <xsd:documentation>Unique message identifier from User Messaging Service.</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="sender" type="xsd:string">
              <xsd:annotation>
                <xsd:documentation>The sender address.</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="recipient" type="xsd:string">
              <xsd:annotation>
                <xsd:documentation>The recipient address (typically username).</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="subject" type="xsd:string" minOccurs="0" maxOccurs="1">
              <xsd:annotation>
                <xsd:documentation>The subject of the message, if available.</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="contentType" type="xsd:string" default="text/plain">
              <xsd:annotation>
                <xsd:documentation>The MIME type of the message. e.g. text/plain, text/html, text/xml.</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="content" type="xsd:string">
              <xsd:annotation>
                <xsd:documentation>The main body of the message. Textual content only (no binary content).</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
            <xsd:element name="parameters" type="tns:parameter" minOccurs="0" maxOccurs="unbounded">
              <xsd:annotation>
                <xsd:documentation>Additional key-value pairs. This interface does not define any specific key-value pair meanings. Use of such parameters is defined on a private basis by particular implementations of this interface.</xsd:documentation>
              </xsd:annotation>
            </xsd:element>
          </xsd:sequence>
        </xsd:complexType>
      </xsd:element>
      <xsd:complexType name="parameter">
        <xsd:sequence>
          <xsd:element name="name" type="xsd:string">
            <xsd:annotation>
              <xsd:documentation>Parameter name</xsd:documentation>
            </xsd:annotation>
          </xsd:element>
          <xsd:element name="value" type="xsd:string">
            <xsd:annotation>
              <xsd:documentation>Parameter value</xsd:documentation>
            </xsd:annotation>
          </xsd:element>
        </xsd:sequence>
      </xsd:complexType>
      <xsd:element name="notificationResponse">
        <xsd:complexType>
          <xsd:sequence>
            <xsd:element name="messageId" type="xsd:string" minOccurs="0" maxOccurs="1">
              <xsd:annotation>
                <xsd:documentation>A message identifier returned in response to successfully accepting the message. If returned, the identifier should be unique. Note: A fault is raised if the message cannot be accepted.</xsd:documentation>
              </xsd:annotation></xsd:element>
          </xsd:sequence>
        </xsd:complexType>
      </xsd:element>
      <xsd:element name="notificationFault">
        <xsd:complexType>
          <xsd:sequence>
            <xsd:element name="code" type="xsd:string"/>
            <xsd:element name="message" type="xsd:string"/>
          </xsd:sequence>
        </xsd:complexType>
      </xsd:element>
    </xsd:schema>
  </wsdl:types>
  <wsdl:message name="notifyRequest">
    <wsdl:part element="tns:notification" name="parameters" />
  </wsdl:message>
  <wsdl:message name="notifyResponse">
    <wsdl:part element="tns:notificationResponse" name="parameters"/>
  </wsdl:message>
  <wsdl:message name="notifyException">
    <wsdl:part element="tns:notificationFault" name="parameters"/>
  </wsdl:message>
  <wsdl:portType name="Notify">
    <wsdl:operation name="invoke">
      <wsdl:input message="tns:notifyRequest"/>
      <wsdl:output message="tns:notifyResponse"/>
      <wsdl:fault message="tns:notifyException" name="NotifyException"/>
    </wsdl:operation>
  </wsdl:portType>
  <wsdl:binding name="NotifySOAPBinding" type="tns:Notify">
    <soap:binding style="document" transport="http://schemas.xmlsoap.org/soap/http" />
    <wsdl:operation name="invoke">
      <soap:operation
        soapAction="http://www.oracle.com/ucs/messaging/extension" />
      <wsdl:input>
        <soap:body use="literal" />
      </wsdl:input>
      <wsdl:output>
        <soap:body use="literal" />
      </wsdl:output>
      <wsdl:fault name="NotifyException">
        <soap:fault name="NotifyException" use="literal"/>
      </wsdl:fault>
    </wsdl:operation>
  </wsdl:binding>
 
  <wsdl:service name="NotifyService">
    <wsdl:port binding="tns:NotifySOAPBinding" name="Notify">
      <soap:address location="http://localhost:8001/NotifyService"/>
    </wsdl:port>
  </wsdl:service>
</wsdl:definitions>


	
Configure the extension driver.

	
Target the predeployed extension driver called usermessagingdriver-extension or a new deployment to the appropriate servers where UMS (usermessagingserver) is running and start the driver.


	
In Enterprise Manager Fusion Middleware Control, navigate to the usermessagingserver home page.


	
Click User Messaging Service > Driver Properties.


	
Select and Edit the driver usermessagingdriver-extension or create a new driver with the same name as your new driver deployment.


	
Under Driver-Specific Configuration, add a new extension endpoint configuration group and specify the correct properties: EndpointURL is the URL to the web service listener endpoint created in Step 1. Protocol is the value of the new messaging channel for which you want to add notification support (for example, popup).


	
Under Common Configuration, update Supported Protocols with a comma-separated list of protocols defined in each Extension Endpoint group.


	
Click OK to save the configuration.







This completes the configuration and integration of a new messaging channel (protocol) in UMS using the extension driver.

To send notifications to this new channel (protocol), recipients must be specified for the URI delivery type using the URI addressing format:


URI:scheme:scheme-specific-address-value


where scheme is the protocol. The URI delivery type is optional. For example, if the extension driver was configured to support the protocol popup, an application can compose a message to popup:john.doe@example.com.

End users can also declare their messaging preferences by creating a new messaging channel for the new channel type in the Worklist/UMS Preferences UI. Note that user preferences are only applied when applications send user-based notifications (that is, to recipients of the form USER:username).




	
Note:

Proper configuration of SSL/TLS in the Oracle WebLogic Server container is a prerequisite for secure connections between UMS and the email server. See "Configuring SSL" in Oracle Fusion Middleware Securing Oracle WebLogic Server.














25.4.1.4 Configuring the Email Driver

The email driver both sends and receives messages (that is, its capability property is set to both by default). The email driver sends messages over SMTP and uses either IMAP or POP3 for receiving messages.



25.4.1.4.1 Email Driver Interoperability

This section details interoperability features of the email driver.

The email driver is compatible with these protocols: POP3, IMAP4, and SMTP.

Email driver features include:

	
Automatic connection retry


	
SMTP for message sending


	
IMAP4 and POP3 for message receiving (using polling)


	
scalable, highly available


	
Message loss prevention and duplication avoidance




The gateway vendors and versions in Table 25-5 have been verified.


Table 25-5 Email Driver Gateway Vendors and Versions

	Vendor	Version
	
Oracle Beehive

	
Release 1 (1.4.3)


	
Oracle Collaboration Suite

	
10g Release 1 (10.1.2)


	
Microsoft Exchange

	
2003


	
Dovecot (IMAP4/POP3)

	
0.99.11


	
sendmail (SMTP)

	
8.13.1












25.4.1.4.2 Common Properties

Table 25-6 lists common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as sendingqueuesinfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of driverconfigpropertynames.


Table 25-6 Common Email Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
Email-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
Both


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
Email


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain, text/html, multipart/mixed, multipart/alternative, multipart/related


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE, USER_REPLY_ACKNOWLEDGEMENT_SUCCESS, USER_REPLY_ACKNOWLEDGEMENT_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue info

	
Yes
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25.4.1.4.3 Email Custom Properties

Table 25-7 lists properties specific to this driver and generally associated with configuring access to the remote gateway and certain protocol or channel-specific behavior.


Table 25-7 Custom Email Properties

	Name	Description	Mandatory?	Default Value
	
MailAccessProtocol

	
Email receiving protocol. The possible values are IMAP and POP3. Required only if email receiving is supported on the driver instance.

	
No

	
IMAP


	
RetryLimit

	
This value specifies the number of times to retry connecting to the incoming mail server, if the connection is lost for some reason. The default value is -1, which means there is no limit to the number of tries.

	
No

	
-1


	
MailDelFreq

	
The frequency to permanently remove deleted messages. The unit is in seconds and the default value is 600 seconds. A negative value indicates the messages should not be expunged. For the POP3 protocol, the message is expunged after it is processed.

	
No

	
600


	
AutoDelete

	
This value indicates if the driver should mark the messages deleted after they have been processed. The default is Disabled. For the POP3 protocol, the messages are always deleted right after they are processed.

	
No

	
Disabled


	
Debug

	
This value indicates if the driver is running in Debug mode. When enabled, JavaMail prints out requests and responses between the email driver and the mail server to Fusion Middleware Control. The default is Disabled.

	
No

	
Disabled


	
CheckMailFreq

	
The frequency with which to retrieve messages from the mail server. The unit is in seconds and the default value is 30 seconds.

	
No

	
30


	
ReceiveFolder

	
The name of the folder from which the driver is polling messages. The default value is INBOX.

	
No

	
INBOX


	
OutgoingMailServer

	
The name of the SMTP server. This is mandatory only if email sending is required.

	
No

	
N/A


	
OutgoingMailServerPort

	
The port number of the SMTP server; typically 25.

	
No

	
25


	
OutgoingMailServerSecurity

	
The security setting used by the SMTP server. Possible values are None, TLS, and SSL. The default value is None.

	
No

	
None


	
OutgoingDefaultFromAddr

	
The default FROM address (if one is not provided in the outgoing message).

	
No

	
N/A


	
OutgoingUsername

	
The username used for SMTP authentication. Required only if SMTP authentication is supported by the SMTP server.

	
No

	
N/A


	
OutgoingPassword

	
The password used for SMTP authentication. This is required only if SMTP authentication is supported by the SMTP server. This includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, and Use Cleartext Password) and Password.

	
No

	
N/A


	
IncomingMailServer

	
The hostname of the incoming mail server. Required only if email receiving is supported on the driver instance.

	
No

	
N/A


	
IncomingMailServerPort

	
Port number of IMAP4 (that is, 143 or 993) or POP3 (that is, 110 or 995) server.

	
No

	
N/A


	
IncomingMailServerSSL

	
Indication to enable SSL when connecting to IMAP4 or POP3 server. The default is Disabled.

	
No

	
Disabled


	
IncomingMailIDs

	
The email addresses corresponding to the user names. Each email address is separated by a comma and must reside in the same position in the list as their corresponding user name appears on the usernames list. Required only if email receiving is supported on the driver instance.

	
No

	
N/A


	
IncomingUserIDs

	
The list of user names of the mail accounts from which the driver instance is polling. Each name must be separated by a comma, for example, foo,bar. This is required only if email receiving is supported on the driver instance.

	
No

	
N/A


	
IncomingUserPasswords

	
The list of passwords corresponding to the user names. Each password is separated by a comma and must reside in the same position in the list as their corresponding user name appears on the usernames list. This is required only if email receiving is supported on the driver instance. This includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, and Use Cleartext Password) and Password.

	
No

	
N/A


	
ProcessingChunkSize

	
The number of messages processed during each message polling. The default is 100.

	
No

	
100


	
ImapAuthPlainDisable

	
Indication to disable or enable plain text authentication (AUTHENTICATE PLAIN command) for IMAP user authentication. The default is Disabled.

	
No

	
Disabled. When this property is disabled, that means that plain text is allowed.










25.4.1.4.4 Client API Messageinfo Support

These properties are message delivery-related that are specified through client API. Table 25-8 describes if the protocol or driver implementation honors such properties.


Table 25-8 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False


















25.4.1.5 Configuring the SMPP Driver

Short Message Peer-to-Peer (SMPP) is one of the most popular GSM SMS protocols. User Messaging Service includes a prebuilt implementation of the SMPP protocol as a driver that is capable of both sending and receiving short messages. If the sending feature is enabled, the SMPP driver opens one TCP connection to the Short Message Service Center (SMS-C) as a transmitter for sending. If the driver's receiving feature is enabled, it opens another connection to the SMS-C as a receiver for receiving. Only two TCP connections (both initiated by the driver) are needed for all communication between the driver and the SMS-C.




	
Note:

The SMPP Driver implements Version 3.4 of the SMPP protocol and only supports connections to an SMS-C or an SMS gateway that supports this version.









25.4.1.5.1 SMPP Driver Interoperability

This section details interoperability features of the SMPP Driver.

The SMPP driver is compatible with this protocol: SMPP v3.4.

SMPP driver features include:

	
Automatic connection retry


	
HTTP proxy for firewall traversal


	
Authentication configuration


	
Configurable chunk size


	
Bulk Sending


	
Encoding: UCS2, IA5, GSM_DEFAULT


	
Priority Setting


	
Configurable Window size


	
Plain text content only




The Gateway vendors in Table 25-9 have been verified.


Table 25-9 SMPP Driver Gateway Vendors

	Vendor
	
Syniverse


	
Clickatell


	
Logica CMG


	
OpenSMPP (simulator)












25.4.1.5.2 Common Properties

Table 25-10 lists common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values see the JavaDoc of DriverConfigPropertyNames.


Table 25-10 Common SMPP Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
SMPP-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
Both


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
SMS


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue info

	
Yes
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25.4.1.5.3 Custom Properties

Table 25-11 lists properties specific to this driver and generally associated with configuring access to the remote gateway and certain protocol or channel-specific behavior.


Table 25-11 Custom SMPP Properties

	Name	Description	Mandatory?	Default Value
	
SmsAccountId

	
The Account Identifier on the SMS-C.

	
Yes

	
N/A


	
SmsServerHost

	
The name (or IP address) of the SMS-C server.

	
Yes

	
N/A


	
TransmitterSystemId

	
The account ID that is used to send messages.

	
Yes

	
N/A


	
ReceiverSystemId

	
The account ID that is used to receive messages.

	
Yes

	
N/A


	
TransmitterSystemType

	
The type of transmitter system. The default is Logica.

	
Yes

	
The default value is Logica.


	
ReceiverSystemType

	
The type of receiver system. The default is Logica.

	
Yes

	
The default value is Logica.


	
TransmitterSystemPassword

	
The password of the transmitter system. This includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, and Use Cleartext Password) and Password.

	
Yes

	
N/A


	
ReceiverSystemPassword

	
The password for the receiver system. This includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, and Use Cleartext Password) and Password.

	
Yes

	
N/A


	
ServerTransmitterPort

	
The TCP port number of the transmitter server.

	
Yes

	
N/A


	
ServerReceiverPort

	
The TCP port number of the receiver server.

	
Yes

	
N/A


	
DefaultEncoding

	
The default encoding of the SMPP driver. The default is IA5. Choose from the drop-down list: IA5, UCS2, and GSM_DEFAULT.

	
No

	
IA5


	
EncodingAutoDetect

	
If enabled, the SMPP driver encodes automatically. The default is Enabled.

	
No

	
Enabled


	
LocalSendingPort

	
The local TCP port used by the SMPP driver to send messages to the SMS-C.

	
No

	
N/A


	
LocalReceivingPort

	
The local TCP port used by the SMPP driver to receive messages from the SMS-C.

	
No

	
N/A


	
LocalAddress

	
The hostname (or IP address) of the server that hosts the SMPP driver.

	
No

	
N/A


	
WindowSize

	
The window size for SMS. This value must be a positive number. Default is 1.

	
No

	
1


	
EnquireInterval

	
The interval, in seconds, to send an enquire message to the SMS-C. The default is 30 seconds.

	
No

	
30


	
ThrottleDelay

	
The delay, in seconds, between throttles. Default is 30.

	
No

	
30


	
BindRetryDelay

	
The minimum delay, in seconds, between bind entry attempts. Default is 30.

	
No

	
30


	
ResponseTimer

	
Time lapse allowed between SMPP request and response, in seconds. The default is 30.

	
No

	
30


	
RegisteredDeliveryMask

	
The registered delivery bit mask. The default is 0xFF, which does not change the delivery flag value.

	
No

	
0xFF


	
RangeSetNull

	
Set to true to set the address range field of BIND_RECEIVER to null. Set to false (the default value) to set the address range field to SmsSystemId. The default is Disabled.

	
No

	
Disabled


	
PriorityAllowed

	
The highest priority allowed for the SMPP driver. The range is 0 (normal) to 3 (highest). The default is 0.

	
No

	
0


	
BulkSending

	
Setting this value to enabled (the default) enables sending messages in bulk to the SMS-C.

	
No.

	
Enabled


	
PayloadSending

	
Determines if the message_payload parameter is always used when sending a message to the SMS-C. The default is Disabled.

	
No

	
Disabled


	
SourceTon

	
The type of number (TON) for ESME address(es) served through SMPP receiver session. The default is 0.

	
No

	
0


	
SourceNpi

	
The numbering plan indicator (NPI) for ESME address(es) served through the SMPP receiver session. The default is 0.

	
No

	
0


	
DestinationTon

	
The TON for destination. The default is 0.

	
No

	
0


	
DestinationNpi

	
The NPI for destination. The default is 0.

	
No

	
0


	
ExtraErrorCode

	
A comma-separated list of error codes.

	
No

	
N/A


	
MaxChunks

	
The maximum SMS chunks for a message. The default is -1 (no maximum).

	
No

	
-1 (no maximum)


	
ChunkSize

	
The size of each SMS message chunk. Default is 160.

	
No

	
160


	
LongMessageSending

	
Supports sending long messages. The default is Disabled.

	
No

	
Disabled


	
DatagramMessageMode

	
Supports datagram message mode. The default is Disabled.

	
No

	
Disabled












25.4.1.5.4 Client API MessageInfo Support

These properties are message delivery-related that are specified through client API. Table 25-12 describes if the protocol or driver implementation honors such properties.


Table 25-12 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
True


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False
















25.4.1.6 Configuring the XMPP Driver

The XMPP Driver provides unidirectional as well as bidirectional access from Oracle Fusion Middleware to end users for real-time IM through the Extensible Messaging and Presence Protocol (XMPP). This driver enables end users to receive alert notifications or interactively chat with applications through their IM client of choice.



25.4.1.6.1 Introduction to XMPP

XMPP is an open, XML-based protocol for IM and Presence. XMPP-based software is deployed on thousands of servers across the Internet and is used by millions of people worldwide. XMPP consists of a client/server architecture, which resembles the ubiquitous email network. XMPP servers are completely decentralized, allowing anyone to set up their own server. Messaging is achieved as in the email network, where recipients are addressed by an XMPP ID (or Jabber ID or JID) with the following form: [username]@domain[/resource]. See RFC 3920 for details on the addressing scheme.

In an XMPP network, users identified by their XMPP IDs as mentioned above (which typically consist of a username and the domain of the XMPP server to which the user connects). An end user of XMPP connects to an XMPP server using an XMPP client in order to send instant messages to other XMPP users. XMPP, however, is not the only protocol network available for IM. XMPP has an extensible and modular architecture. It integrates with proprietary IM networks, enabling XMPP users to communicate with those on other networks.

To use the XMPP Driver in UMS, you must have access to a Jabber/XMPP server and an XMPP account for the UMS XMPP Driver instance with which to log in.






25.4.1.6.2 XMPP Driver Interoperability

This section details interoperability features of the XMPP Driver.

The XMPP driver is compatible with these protocols: XMPP (RFC 3920, 3921).

XMPP Driver features include:

	
Automatic connection retry


	
HTTP proxy for firewall traversal


	
Plain text content only




In addition to Oracle Beehive, the gateway vendors and versions in Table 25-13 have been verified.


Table 25-13 XMPP Driver Gateway Vendors and Versions

	Vendor	Version
	
Jabberd

	
v1, v2


	
ejabberd

	
v2












25.4.1.6.3 Third-Party Software

The XMPP Driver uses or requires the following third-party software (you may optionally choose to install and configure your own XMPP server):


Table 25-14 Required Third-Party Software

	Name	Instructions	Version(s)
	
Apache Smack

	
This driver uses the Apache Smack XMPP Java library to connect to a Jabber/XMPP IM Server. This driver includes a licensed copy of Smack (version 3.0.4).

	
3.0.4











	
Note:

You are not required to install your own XMPP Server if you have access to an existing server. For a list of public servers, see http://www.jabber.org.












25.4.1.6.4 Driver Application Archive (EAR)

The EAR file is $ORACLE_HOME/communications/applications/sdpmessagingdriver-xmpp.ear.






25.4.1.6.5 Common Properties

Table 25-15 lists common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of DriverConfigPropertyNames.


Table 25-15 Common XMPP Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
XMPP-IM-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
Both


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
IM


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports a cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports a replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports a tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports a status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue information

	
Yes
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25.4.1.6.6 XMPP Custom Properties

The XMPP Driver includes the custom properties shown in Table 25-16.


Table 25-16 Custom XMPP Properties

	Name	Description	Mandatory	Default Values
	
IMServerHost

	
Jabber/XMPP server hostname.

	
No

	
N/A


	
IMServerPort

	
Corresponding Jabber/XMPP server port. The default is 5222.

	
Yes

	
5222


	
IMServerUsername

	
Jabber/XMPP username with which you log in. You may also enter a complete Jabber ID if its domain name is different from the Jabber/XMPP server hostname (for example: myUserName or myUserName@xmpp-domain).

Note: An attempt is made to register this user account if it does not exist and the server supports account registration.

	
No

	
N/A


	
IMServerPassword

	
Corresponding password for the username listed above. Includes Type of Password (choose from Indirect Password/Create New User, Indirect Password/Use Existing User, Use Cleartext Password) and Password.

	
No

	
N/A


	
SecurityMode

	
Security mode to use when making a connection to the server. Available options are: None (Security is disabled and only unencrypted connections are used), TLS (Security through TLS encryption is used whenever it is available), and SSL (Security through SSL encryption is used). The default is TLS.

	
No

	
TLS


	
SASLAuthenticationEnabled

	
Whether to use SASL authentication when logging into the server. If SASL authentication fails, then the driver tries to use non-SASL authentication. By default, SASL is enabled.

	
No

	
Enabled










25.4.1.6.7 Client API MessageInfo Support

These properties are message delivery-related that are specified through the client API. Table 25-17 describes if the protocol or driver implementation honors such properties.


Table 25-17 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False


















25.4.1.7 Configuring the VoiceXML Driver

The VoiceXML Driver supports the Genesys VoiceGenie gateway's outbound call protocol to send messages authored in VoiceXML. The gateway delivers the message using text-to-speech synthesis.



25.4.1.7.1 VoiceXML Driver Interoperability

This section details interoperability features of the VoiceXML Driver.

The VoiceXML driver is compatible with this protocol: VoiceXML over HTTP (VoiceGenie gateway protocol).

The VoiceXML driver features include:

	
VoiceXML content only




The gateway vendor and version in Table 25-18 has been verified.


Table 25-18 VoiceXML Driver Gateway Vendor and Version

	Vendor	Version
	
Genesys VoiceGenie

	
6.4.2












25.4.1.7.2 Common Properties

Table 25-19 lists common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of DriverConfigPropertyNames.


Table 25-19 Common VoiceXML Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
VoiceXML-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
SEND


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
VOICE


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/vxml, text/x-vxml


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender Addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default Sender Address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver Sending Queue Info

	
Yes
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25.4.1.7.3 VoiceXML Custom Properties

The VoiceXML Driver includes the custom properties shown in Table 25-20.


Table 25-20 Custom VoiceXML Properties

	Name	Description	Mandatory	Default Values
	
VoiceXMLOutboundServletURI

	
The URL of the VoiceXML gateway.

	
Yes

	
N/A


	
VoiceXMLOutboundServletUserName

	
The user name of the VoiceXML gateway.

	
No

	
N/A


	
VoiceXMLOutboundServletPassword

	
The password of the user of the VoiceXML gateway.

	
No

	
N/A


	
VoiceXMLOutboundServletDNIS

	
The number that should appear in the recipient's caller ID display.

	
No

	
N/A


	
VoiceXMLReceiveURL

	
The URL of this driver's servlet that handles incoming requests from the VoiceXML Gateway. The format is http://host:port/usermessagingdriver-voicexml/receive. The default behavior, if this property is not set, is to use the local container's HTTP listener host and port. The default behavior only works for the first driver instance. For additional instances, the context root is different and this property must be configured using the correct context root replacement for /sdpmessagingdriver-voicexml.

	
No

	
N/A











	
Note:

In a clustered (high-availability) environment with Oracle HTTP Server (OHS) configured, do not use the OHS port to configure the VoiceXML driver receive URLs. Using the OHS port to configure the VoiceXML driver receive URLs causes a conflict with the drivers.
Each VoiceXML driver must be configured with its own WLS server's port.











25.4.1.7.4 Client API MessageInfo Support

These properties are message delivery related which are specified through client API. Table 25-21 describes if the protocol or driver implementation honors such properties.


Table 25-21 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False


















25.4.1.8 Configuring the Worklist Driver

The Worklist driver enables notifications from all sources to be sent to users in the form of worklist tasks for integration into the users' WebCenter Unified Worklist.




	
Note:

Worklist message tasks are accessible both through an Oracle WebCenter that has been configured to search the BPEL connection to which the worklist message driver is sending messages, and through Oracle BPM Worklist. Oracle BPM Worklist also shows these message-based tasks as worklist items.







This integration is achieved by exposing a worklist channel (delivery type) to applications and end users. Messages sent through the user's worklist channel are processed by the worklist driver.




	
Note:

The worklist channel supports all rich text tags supported by the af:richTextEditor for the text/html content type. For more information about the Rich Text Editor, see <af:richTextEditor>.







The User Messaging Service API semantics are the same as those for existing channels such as IM or email. This driver handles sending messages only. The driver Application Archive (EAR) is located at: $ORACLE_HOME/communications/applications/sdpmessagingdriver-worklist.ear

You can install the Worklist Driver onto an Oracle WebLogic platform, or onto an IBM WebSphere platform. Choose the appropriate installation instructions below.



25.4.1.8.1 Install the Worklist Driver on Oracle WebLogic Platform

To enable the messaging worklist feature, the WebLogic SOA domain must be extended using the extension template available at $ORACLE_HOME/common/templates/applications/oracle.ums.driver.worklist_template_11.1.1.jar.

To extend a SOA domain using the Oracle Fusion Middleware Configuration Wizard:

	
Launch Oracle Fusion Middleware Configuration Wizard ($ORACLE_HOME/common/bin/config.sh or %ORACLE_HOME%\common\bin\config.cmd).


	
Select the Extend an existing WebLogic domain option.


	
Select the desired SOA domain directory.


	
Select the Extend my domain using an existing extension template option.


	
Click Browse, and navigate to $ORACLE_HOME/common/templates/applications


	
Select oracle.ums.driver.worklist_template_11.1.1.jar


	
Complete the remaining steps of the Oracle Fusion Middleware Configuration Wizard, and restart the SOA servers.







	
Note:

Special Considerations if the SOA managed server is on a remote computer: The oracle.ums.driver.worklist_template_11.1.1.jar extension template includes a SOA composite application (sca_sdpmessagingsca-worklist-composite_rev1.0.jar) that is copied to $DOMAIN_HOME/soa/autodeploy, and is auto-deployed by the SOA Infra runtime upon server restart. However, if the SOA Infra runtime is on a remote computer, and the domain is packed with the -managed=true option (the correct option to use), this directory is not included in the archive. Thus, the composite is not deployed upon restarting the SOA managed server.
To complete the installation, copy the contents of $DOMAIN_HOME/soa/autodeploy from the AdminServer computer to the corresponding location on the remote computer with the SOA managed server, and restart the SOA managed server. You may have to create the directory structure soa/autodeploy under $DOMAIN_HOME on the remote computer.














25.4.1.8.2 Install the Worklist Driver on IBM WebSphere Platform

To enable the messaging worklist feature, the WebSphere SOA cell must be extended using the extension template available at $ORACLE_HOME/common/templates/was/oracle.ums.driver.worklist_template_11.1.1.jar.

To extend a SOA cell using the Oracle Fusion Middleware Configuration Wizard:

	
Set the environment variable CONFIG_JVM_ARGS with the value -DTemplateCatalog.enable.selectable.all=true. For example, in Linux bash shell: exportCONFIG_JVM_ARGS="-DTemplateCatalog.enable.selectable.all=true" At the Windows command prompt: set CONFIG_JVM_ARGS=-DTemplateCatalog.enable.selectable.all=true


	
Launch Oracle Fusion Middleware Configuration Wizard ($ORACLE_HOME/common/bin/was_config.sh or %ORACLE_HOME%\common\bin\was_config.cmd).


	
Click Select and Configure Existing Cell.


	
Select the desired SOA cell and click Next.


	
Select Oracle User Messaging Service Worklist Driver on the Add Products to Cell screen and click Next.


	
Complete the remaining steps of the Oracle Fusion Middleware Configuration Wizard with default selections, and restart the SOA cell.









25.4.1.8.3 Common Properties

The common driver properties shown in Table 25-22 are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of DriverConfigPropertyNames.


Table 25-22 Common Worklist Properties

	Name	Description	Mandatory?	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
Worklist-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
SEND


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
WORKLIST


	
SupportedContentTypes

	
Supported content types

	
Yes

	
text/plain, text/html


	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
SupportedCarriers

	
No

	
N/A


	
SupportedProtocols

	
SupportedProtocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue information

	
Yes
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25.4.1.8.4 Custom Properties

The custom property shown in Table 25-23 is available.


Table 25-23 Custom Worklist Property

	Name	Description	Mandatory	Default Value
	
BPELConnectionURL

	
The URL of the BPEL server to connect to. The format is 'http://<bpel-host>:<bpel-port>'. The default behavior, if this property is not set, is to use the local container's HTTP connection URL.

	
	











25.4.1.8.5 Client API MessageInfo Support

Table 25-24 shows if the protocol or driver implementation honor the following message delivery-related properties that are specified through the client API.


Table 25-24 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False














25.4.1.9 Configuring the Proxy Driver

The Proxy Driver acts as a Messaging Web Service client to a Fusion Middleware Messaging server hosted elsewhere in the intranet or Internet. It uses SOAP over HTTP (the Parlay X Multimedia Web Service protocol) to send messages and receive messages as well as return message delivery status. The ParlayX Web Service relays messages from one UMS instance to another. It can be used to relay traffic from multiple instances in an Intranet to a terminating instance that has all of the protocol-specific drivers configured to an external gateway such as an SMSC, or to an SMTP or IMAP mail server.



25.4.1.9.1 Common Properties

Table 25-25 shows common driver properties that are indicative of the capabilities of this driver for use by the messaging engine when routing outbound messages. Some properties are set by the driver developer and do not normally require modification, while others can be modified by the administrator to change the routing behavior. Some properties such as SendingQueuesInfo are for advanced use and only require modification for advanced deployment topologies. For a complete description of these properties and available values, see the JavaDoc of DriverConfigPropertyNames.


Table 25-25 Common Proxy Properties

	Name	Description	Mandatory	Default Value
	
InstanceName

	
Instance name (for internal use only)

	
Yes

	
Proxy-Driver


	
Capability

	
Message sending and receiving capability

	
Yes

	
SEND


	
SupportedDeliveryTypes

	
Supported delivery types

	
Yes

	
EMAIL, SMS, VOICE, IM, WORKLIST


	
SupportedContentTypes

	
Supported content types

	
Yes

	
*



	
SupportedStatusTypes

	
Supported status types

	
No

	
DELIVERY_TO_GATEWAY_SUCCESS, DELIVERY_TO_GATEWAY_FAILURE


	
Cost

	
Cost

	
No

	
N/A


	
Speed

	
Speed

	
No

	
N/A


	
SupportedCarriers

	
Supported carriers

	
No

	
N/A


	
Supported Protocols

	
Supported protocols

	
No

	
N/A


	
SupportsCancel

	
Supports cancel operation on the message

	
No

	
False


	
SupportsReplace

	
Supports replace operation on the message

	
No

	
False


	
SupportsTracking

	
Supports tracking operation on the message

	
No

	
False


	
SupportsStatusPolling

	
Supports status polling operation on the message

	
No

	
False


	
SenderAddresses

	
Sender addresses

	
No

	
N/A


	
DefaultSenderAddress

	
Default sender address

	
No

	
N/A


	
SendingQueuesInfo

	
Driver sending queue information

	
Yes
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25.4.1.9.2 Proxy Custom Properties

The Proxy Driver includes the custom properties shown in Table 25-26.


Table 25-26 Custom Proxy Properties

	Name	Description	Mandatory	Default Values
	
GatewayURL

	
The URL to the hosted 11g UMS Web Service gateway. The URL is in the following format:


http://<host>:<port>/sdpmessaging/parlayx/SendMessageService

	
Yes

	
N/A


	
Username

	
Username of the messaging gateway.

	
No

	
N/A


	
Password

	
The password of the username

	
No

	
N/A


	
Policies

	
Comma-delimited list of Oracle Web Services Manager WS-Security policies to be attached to proxy driver requests

	
No

	
N/A










25.4.1.9.3 Client API MessageInfo Support

These properties are message delivery related which are specified through client API. Table 25-27 describes if the protocol or driver implementation honors such properties.


Table 25-27 Client API MessageInfo Support

	Name	Description	Support
	
Expiration

	
Expiration means how long the message may exist until it expires.

	
False


	
Delay

	
Delay means the amount of time that must elapse before the message is sent.

	
False






















25.5 Configuring User Messaging Service Access to LDAP User Profile

As part of the LDAP provider setup in a SOA deployment, you configure the "User Name Attribute" through the WLS admin console. If you configure that attribute with a value other than the default uid, you must make an additional configuration change in Oracle Platform Security Services (OPSS) for UMS to successfully access the user profile to obtain the list of communication channels provisioned in LDAP, such as business email.

To configure access:

	
Modify jps-config.xml (in $DOMAIN_HOME/config/fmwconfig) by adding the following line in the idstore.ldap serviceInstance section:


<property name=”username.attr” value=”username_attribute_value”/>


where username_attribute_value is the value of the User Name Attribute property in the LDAP provider configuration. For instance, if the User Name Attribute is configured to be "mail" in the LDAP provider, the line to add would be the following:


<property name=”username.attr” value=”mail”/> 


Here is a sample from jps-config.xml with the above line inserted:


<!-- JPS WLS LDAP Identity Store Service Instance --> 
  
<serviceInstance name="idstore.ldap" provider="idstore.ldap.provider"> 
 
  <property name="idstore.config.provider" value="oracle.security.jps.wls.internal.idstore.WlsLdapIdStoreConfigProvider"/> 

  <property name="CONNECTION_POOL_CLASS" 
value="oracle.security.idm.providers.stdldap.JNDIPool"/> 
 
  <property name=”username.attr” value=”mail”/> 
 
</serviceInstance> 





	
Note:

You may have other properties defined in the same section.








	
Restart your domain.




This change causes the OPSS APIs used by UMS to use the username.attr (mail, which is the email address) while searching the back-end LDAP server for user profile.






25.6 Securing User Messaging Service

The User Messaging Preferences User Interface and the Parlay X Web Services can be secured at the transport-level using Secure Sockets Layer (SSL). By default, all deployed web services are unsecured. Web Service Security should be enabled for any services that are deployed in a production environment.

	
To enable SSL in the Oracle WebLogic Server, see "Configure SSL for Oracle WebLogic Server" in the Oracle Fusion Middleware Administrator's Guide. This step is sufficient to secure the User Messaging Preferences User Interface.


	
To secure the Parlay X Web Services, see "Configuring Transport-Level Security" in the Securing WebLogic Web Services.




UMS supports the use of Oracle Web Services Manager WS-Security policies to protect UMS web services. For more information about Oracle Web Services Manager, see "Using Oracle Web Service Security Policies", in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server.

The recommended security configuration for web services uses Security Assertion Markup Language (SAML) tokens to pass identities between web service clients and UMS. With SAML tokens, instead of the web service client passing a username and password to UMS, a trust relationship is established between the client and UMS by means of exchanging certificates. Once this keystore configuration is in place, the web service client passes only the user identity, and vouches for the fact that it has authenticated the user appropriately.

The recommended policies to use for UMS web services are:

	
oracle/wss11_saml_token_with_message_protection_service_policy (server-side)


	
oracle/wss11_saml_token_with_message_protection_client_policy (client-side)


	
oracle/wss11_saml_token_identity_switch_with_message_protection_client_policy (client-side)




	
Note:

The choice of client-side policy depends on the security context in which your application is executing.
	
If the thread that is making the web service call has the intended Subject associated with it (for example, from a web application that performs user authentication, or a Java EE module with a run-as identity defined), then use the policy oracle/wss11_saml_token_with_message_protection_client_policy.

The current thread Subject is passed through using the SAML Policy WS-Security headers. In this case you should not specify the parameter javax.xml.ws.BindingProvider.USERNAME_PROPERTY when creating your web service client instance.


	
If the thread that is making the web service call has an undefined Subject associated with it, or if you need to programmatically supply a different identity, then use the policy oracle/wss11_saml_token_identity_switch_with_message_protection_client_policy, and specify the parameter javax.xml.ws.BindingProvider.USERNAME_PROPERTY when creating your web service client instance. If you want to perform dynamic identity switching, you must grant additional code permissions to your application. For more information, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.

















25.6.1 Web Service Security on Notification

The different web services include corresponding notification web services (MessageNotification, PresenceNotification) that run on the client side and receive notifications (message delivery status, message receipt, presence status change) when the appropriate event occurs.

This implementation does not provide for the use of Web Service security (WS-Security) by default during notification of the clients. That is, the server assumes that the notification web services running on the client side do not use WS-Security, and makes no attempt to authenticate itself when sending notifications. If you enable WS-Security on the client side, the notification from the server fails because the notification SOAP request is missing the required headers.






25.6.2 Enabling UMS Service Security

To enable a policy for an UMS web service, follow the steps in "Configuring Oracle WSM Security Policies in Administration Console" in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server, selecting policy oracle/wss11_saml_token_with_message_protection_service_policy. This configuration must be repeated for each service that you want to secure.






25.6.3 Enabling Client Security

Web service client security must be enabled programmatically. When using the client libraries described in Parlay X Messaging Client API and Client Proxy Packages (in Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite), WS-Security policy configuration is provided when a client object is constructed. The client constructors take an argument of type Map<String, Object>. In general when using SAML authentication, the key/value pairs (Table 25-28) should be added to the configuration map in addition to other required properties such as the endpoint address.


Table 25-28 Client Security Keys

	Key	Type	Typical Value
	
oracle.sdp.parlayx.ParlayXConstants.POLICIES

	
String[]

	
oracle/wss11_saml_token_with_message_protection_client_policy


	
javax.xml.ws.BindingProvider.USERNAME_PROPERTY

	
String

	
<valid username>


	
oracle.wsm.security.util.SecurityConstants.Config.KEYSTORE_RECIPIENT_ALIAS_PROPERTY

	
String

	
(optional) keystore alias for target service. See Client Aliases.









Example 25-1 Web Service Client Security


import oracle.sdp.parlayx.multimedia_messaging.send.SendMessageClient
 
...
 
Map<String, Object> config = new HashMap<String, Object>();
config.put(javax.xml.ws.BindingProvider.ENDPOINT_ADDRESS_PROPERTY, ums_url);
config.put(oracle.sdp.parlayx.ParlayXConstants.POLICIES, new String[] {"oracle/wss11_saml_token_with_message_protection_client_policy"});
config.put(javax.xml.ws.BindingProvider.USERNAME_PROPERTY, "test.user1");
 
SendMessageClient sendClient = new SendMessageClient(config);








25.6.4 Keystore Configuration

In order to use the recommended WS-Security policy, you must configure a keystore containing the public and private key information required by OWSM. Refer to "Configuring the Credential Store Using WLST" in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server for information on how to configure the keystore and corresponding credential store entries.

	
If both your web service client and UMS server are in the same domain, then they share a keystore and credential store.


	
If your web service client and UMS server are in different domains, then you must import the UMS public key into your client domain's keystore, and must import your client domain's public key into the UMS keystore.









25.6.5 Client Aliases

When using certain WS-Security policies such as the SAML policy recommended here, the client must use the server's public key to encrypt the web service request. However, there is generally only one keystore configured per domain. Therefore, if you have a domain in which there are web service clients that communicate with web services in multiple other domains, then you may be required to override the default keystore entry used by OWSM.

For example, if you have a domain in which application "A" is a web service client to a UMS web service, and application "B" is a web service client to a web service in another domain, then A's requests must be encrypted using the public key of the UMS domain, and B's requests must be encrypted using the public key of the other domain. You can accomplish this goal by overriding the keystore alias used by OWSM for each request:

	
Import (for example) the UMS public key with alias "ums_public_key", and the other public key with alias "other_public_key".


	
When creating an UMS web service client, specify the recipient keystore alias parameter, setting the key to oracle.wsm.security.util.SecurityConstants.Config.KEYSTORE_RECIPIENT_ALIAS_PROPERTY and the value to "ums_public_key" as shown in Example 25-2.


Example 25-2 Client Aliases


import oracle.sdp.parlayx.multimedia_messaging.send.SendMessageClient
 
...
 
Map<String, Object> config = new HashMap<String, Object>();
config.put(javax.xml.ws.BindingProvider.ENDPOINT_ADDRESS_PROPERTY, ums_url);
config.put(oracle.sdp.parlayx.ParlayXConstants.POLICIES, new String[] {"oracle/wss11_saml_token_with_message_protection_client_policy"});
config.put(javax.xml.ws.BindingProvider.USERNAME_PROPERTY, "test.user1");
config.put(oracle.wsm.security.util.SecurityConstants.Config.KEYSTORE_RECIPIENT_ALIAS_PROPERTY, "ums_public_key")
SendMessageClient sendClient = new SendMessageClient(config);




	
The other web service client similarly must override the keystore alias, but the exact mechanism may differ. For example if using a JAX-WS client stub directly, then you can add the override property to the JAX-WS request context. See "Policy Configuration Overrides for the Web Service Client" in Oracle Fusion Middleware Securing WebLogic Web Services for Oracle WebLogic Server for more details.









25.6.6 Securing JMS Resources

This (optional) procedure enables administrators to restrict access to the Oracle User Messaging Service's JMS resources (such as queues) for enhanced security.




	
Note:

This section details steps to follow in order to secure JMS Resources. If you are starting with a new installation (Patch Set 2) of Oracle User Messaging Service, then follow these steps.
If you are not upgrading to Patch Set 2, then these instructions are not to be used.

If you previously created a domain in an earlier release and are upgrading, but have not already done so, then complete the steps in the latest Release Notes before proceeding.









To secure the JMS system resources, lock all JMS sub-deployments that start with the name UMSJMSSystemResource (there may be multiple automatically-created resources for UMS in a multi-server or cluster deployment) with the role OracleSystemRole. Do this using the Oracle WebLogic Server Administration Console, or you may run a WLST script (available at $ORACLE_HOME/communications/bin/secure_jms_system_resource.py) as follows:


$ORACLE_HOME/common/bin/wlst.sh
$ORACLE_HOME/communications/bin/secure_jms_system_resource.py
--username=<admin_username> --password=<password>
--url=t3://<admin-host>:<admin-port> --jmsSystemResource
<UMSJMSSystemResource> --role OracleSystemRole


For example:


$ORACLE_HOME/common/bin/wlst.sh
$ORACLE_HOME/communications/bin/secure_jms_system_resource.py
--username=weblogic --password=<password> --url=t3://localhost:7001
--jmsSystemResource UMSJMSSystemResource --role OracleSystemRole


By default, the UMS system runs as the user OracleSystemUser for accessing JMS resources. If the user OracleSystemUser does not exist, or you secure the UMS JMS resources with any other role that some other user has been granted, you must override the default user identity used by the UMS system by specifying an alternate username for the following JVM system property when you start the container:


oracle.ums.system.user=<username>


For example, if the user is MySystemUser, you can pass the JVM system property on command line as: -Doracle.ums.system.user=MySystemUser








25.7 Troubleshooting Oracle User Messaging Service

To debug User Messaging Service, first check the server diagnostic logs. The logs may contain exception, error, or warning messages that provide details about incorrect behavior along with actions to remedy the problem. Table 25-29 describes additional methods for debugging common User Messaging Service problems.


Table 25-29 Troubleshooting UMS

	Symptom	Possible Causes	Solutions
	
Notifications are not being sent from BPEL or Human Workflow components in SOA.

	
Notification Mode is set to NONE in SOA Workflow Notification configuration.

	
Change the Notification Mode setting to EMAIL or ALL using Oracle Fusion Middleware Control.


	
Email notification is not being sent.

	
The Outgoing (SMTP) Mail Server settings in the UMS Email Driver are incorrect.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
OutgoingMailServer


	
OutgoingMailServerPort




Note: Validate the values by using them in any email client for connecting to the SMTP server.


	
	
The SMTP server requires authentication or a secure connection (TLS or SSL).

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
OutgoingUsername


	
OutgoingPassword


	
OutgoingMailServerSecurity





	
Notifications are not being sent because of error message: No matching drivers found for sender address = <address>

	
The UMS Driver for the appropriate channel is configured with a specific list of SenderAddresses, and the message sent by the application has set a non-matching Sender Address.

Note: UMS Server matches the outbound message's sender address, if set, against the available drivers' SenderAddresses to find a matching driver to use for delivering the message. If a driver has set one or more SenderAddresses, then the UMS Server only sends messages with the matching sender address to it.

	
	
Check the following settings in the appropriate UMS Driver using Oracle Fusion Middleware Control:

SenderAddresses

Note: The format for SenderAddresses is a comma-delimited list of <DeliveryType>:<Address>.

For example:

EMAIL:sender@example.com, EMAIL:sender@example2.com


	
Leave this property blank, if you want this driver to service outbound messages for all sender addresses for this channel (delivery type).


	
If there are multiple driver instances deployed for the same channel (delivery type) with different configurations, use the SenderAddresses to differentiate the driver instances. For example, one instance can be set with a specific value in SenderAddresses to only service outbound messages with that matching sender address, while the other instance can keep the SenderAddresses blank in order to service all outbound messages that do not specify any sender address or one that does not match that of the first driver instance.


	
SenderAddresses that are configured with the incorrect syntax (such as missing <DeliveryType>:) are ignored by the UMS Server for the purpose of driver selection.





	
The email client inconsistently receives notifications.

	
The Incoming Mail Server settings in the UMS Email Driver are configured with the same email account to which notifications are being sent.

If the notification is sent to the same account, the UMS Email Driver may download and process the email before the email client can display it.

	
Use an exclusive email account for Incoming Mail Server settings. Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
IncomingMailIDs


	
IncomingUserIDs





	
SOA Human Workflow notifications are sent, but are not actionable.

	
The Actionable Email Address is not configured in SOA Workflow Notification Properties.

	
Set the Actionable Email Address in SOA Workflow Notification Properties with the address of the email account configured in the UMS Email Driver.


	
	
The Human Workflow task is not set to send actionable notifications.

	
Set the actionable attribute for the Human Workflow task in JDeveloper and redeploy the SOA composite application.


	
SOA Human Workflow actionable notifications are sent, but no action is taken after responding.

	
The Incoming Mail Server settings in the UMS Email Driver are incorrect.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
MailAccessProtocol (IMAP or POP3, in uppercase)


	
ReceiveFolder


	
IncomingMailServer


	
IncomingMailServerPort


	
IncomingMailServerSSL


	
IncomingMailServerSSL


	
IncomingUserIDs


	
IncomingUserPasswords


	
ImapAuthPlainDisable




Note: Validate the values by using them in any email client for connecting to an IMAP or POP3 server.


	
	
The mail access protocol is incorrect.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
MailAccessProtocol (IMAP or POP3, in uppercase)





	
	
The email server is SSL-enabled.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
IncomingMailServerSS





	
	
The receive folder name is incorrect.

	
Check the following settings in the UMS Email Driver using Oracle Fusion Middleware Control:

	
ReceiveFolder




Note: Some email servers may expect the value INBOX to be inbox or Inbox (that is, case-sensitive). Based on your email server, use an appropriate value.


	
	
A non-default email client is configured for receiving notifications. When the user clicks the approval link, the default mail client page opens, which may send emails to a different email server.

	
Configure the default email client to receive actionable notifications.


	
SOA BPEL User Notification or Human Workflow notifications are sent to the correct delivery type (email, sms, and so on) but to the wrong address.

	
A self-provisioned messaging channel was created by the user in User Messaging Preferences for use in BPEL User Notification or Human Workflow use cases.

Note: The User Messaging Preferences UI allows the end user to create his or her own messaging channel for various use cases, but these are not to be used for BPEL User Notification and Human Workflow.

	
Do not use a self-provisioned messaging channel for BPEL User Notification or Human Workflow use cases (that is, do not set as Default channel, and do not use in a messaging filter for such use cases). BPEL User Notification and Human Workflow utilize User Messaging Preferences only for the delivery type preference, and the actual address is retrieved from the user profile in the identity management system.

Note: Addresses from the user profile in the identity management system are available through User Messaging Preferences using predefined channel names, such as Business Email, Business Mobile, Business Phone, Instant Messaging. Use these predefined messaging channels instead for BPEL User Notification and Human Workflow use cases.










 Managing SOA Composite Applications





8  Managing SOA Composite Applications

This chapter describes how to manage SOA composite applications, including initiating a test instance of an application; managing faults, policies, and instance states; and testing SOA composite applications.

This chapter includes the following topics:

	
Section 8.1, "Initiating a SOA Composite Application Test Instance"


	
Section 8.2, "Managing the State of Deployed SOA Composite Applications"


	
Section 8.3, "Monitoring and Deleting SOA Composite Application Instances from the Application Home Page"


	
Section 8.4, "Monitoring and Deleting SOA Composite Application Instances at the SOA Infrastructure Level"


	
Section 8.5, "Recovering from SOA Composite Application Faults at the SOA Infrastructure Level"


	
Section 8.6, "Recovering from SOA Composite Application Faults in the Application Home Page"


	
Section 8.7, "Automating the Testing of SOA Composite Applications"


	
Section 8.8, "Managing SOA Composite Application Policies"


	
Section 8.9, "Exporting a Running SOA Composite Application"


	
Section 8.10, "Grouping SOA Composite Applications into Partitions"


	
Section 8.11, "Disabling and Enabling BPEL and BPMN Business Monitors"







	
Note:

The procedures in this guide describe how to access Oracle Enterprise Manager Fusion Middleware Control pages from the SOA Infrastructure menu, soa-infra icon in the navigator, SOA Composite menu, and SOA Partition menu. You can also access many pages from the Farm home page. For more information, see Section 2.2.6, "Navigating to the SOA Infrastructure or SOA Composite Application Home Page."









8.1 Initiating a SOA Composite Application Test Instance

This section describes how to initiate a test instance of a deployed SOA composite application.

To initiate a SOA composite application test instance:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the Composite Menu...
	
	Select Home.
	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.


	
At the top of the page, click Test.




	
	Under soa-infra, select a specific SOA composite application.
	
At the top of the page, click Test.




	
	Select Test Service > client.












	
Note:

The Test button is disabled in the following situations:
	
The SOA composite application revision is stopped or retired.


	
There are no web services available for the application. Only composites having services with web service bindings can be tested from this page.













	
If the composite includes multiple services, the Test button has a drop-down list to select the service to test.

The Test Web Service page for initiating an instance appears.

This page provides many options for initiating an instance. At a minimum, you must specify the XML payload data to use in the Input Arguments section.

The WSDL file and end point URL are populated automatically based on the service you selected to test. The end point URL is derived from the WSDL and can be overridden to invoke that service at a different location. If the service selected has multiple ports, a drop-down list is displayed. Otherwise, the port of the current service is displayed.

[image: Description of sca_test_payload.gif follows]




	
Accept the default values for these fields or provide values appropriate to your test environment.


	
If you change the WSDL file, click Parse WSDL to reload the WSDL file.

If the WSDL URL does not contain the revision number, it is processed by the default composite application. For example, if there are two revisions of a composite application named HelloWorld, then the following end points are exposed by them:

	
http://host:port/soa-infra/services/default/HelloWorld!1.0/client


	
http://host:port/soa-infra/services/default/HelloWorld!2.0/client




However, if the WSDL specified for web service invocation does not contain the revision details (for example, http://host:port/soa-infra/services/default/HelloWorld/client), it is processed by the composite revision that is set as default.


	
If you want to edit the end point URL, click Edit Endpoint URL and make appropriate changes.

The lower part of the Test Web Service page consists of the Request tab. This tab enables you to specify security, quality of service, HTTP transport, stress testing options, and XML input arguments:

[image: Description of sca_test_payload2.gif follows]




The Security section includes the following fields for passing security properties with messages.:


	Field	Description
	WSS Username Token	Inserts a WS-Security SOAP header. The Username field is required, and the Password field is optional.
	Http Basic Auth	Inserts the username and password credentials in the HTTP transport header. Both the Username and Password fields are required.
	Custom Policy	Uses a custom policy to authenticate the user (specifies the URI for the custom policy). The Username and Password fields are optional.
	None	Select to not specify security credentials. This is the default selection.






	
Accept the default values for these fields or provide values appropriate to your test environment.

The Quality of Service section includes the following fields. Oracle Fusion Middleware uses a policy-based model to manage web services. A policy applies behavior requirements to the delivery of messages. For additional details about using the Test Web Service page, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.


	Field	Description
	WS-RM	Select one of the following options for testing WS-Reliable Messaging (RM) protocol policies. Reliable messaging policies support this protocol, which guarantees the end-to-end delivery of messages.
	
WSDL Default: Executes the default behavior of the WSDL. For example, if the WSDL contains a reference to a WS-RM policy, then the policy is enforced. If the WSDL does not contain a reference to a WS-RM policy, then reliable messaging is not tested.


	
None: No policy for WS-RM is tested even if the WSDL contains a reference to a policy.


	
Custom: Enforces a custom policy. Specify the URI of the custom policy in the Policy URI field. If a WS-RM policy is referenced in the WSDL, it is ignored, and the policy specified in the Policy URI field is used instead.





	MTOM	Select one of the following options for testing Message Transmission Optimization Mechanism (MTOM) policies. MTOM policies ensure that attachments are in MTOM format, a format for efficiently sending binary data to and from web services.
	
WSDL Default: Executes the default behavior of the WSDL. For example, if the WSDL contains a reference to an MTOM policy, then the policy is enforced. If the WSDL does not contain a reference to an MTOM policy, then MTOM is not tested.


	
None: No policy for MTOM is tested, even if the WSDL contains a reference to a policy.


	
Custom: Enforces a custom policy. Specify the URI of the custom policy in the Policy URI field. If an MTOM policy is referenced in the WSDL, it is ignored, and the policy specified in the Policy URI field is used instead.





	WS-Addressing	Select one of the following options for testing WS-Addressing policies. WS-Addressing policies verify that SOAP messages include WS-Addressing headers in conformance with the WS-Addressing specification.
	
WSDL Default: Executes the default behavior of the WSDL. For example, if the WSDL contains a reference to a WS-Addressing policy, then the policy is enforced. If the WSDL does not contain a reference to a WS-Addressing policy, then WS-Addressing is not tested.


	
None: No policy for WS-Addressing is tested even if the WSDL contains a reference to a policy.


	
Custom: Enforces a custom policy. Specify the URI of the custom policy in the Policy URI field. If a WS-Addressing policy is referenced in the WSDL, it is ignored, and the policy specified in the Policy URI field is used instead.











	
Accept the default values for these fields or provide values appropriate to your test environment.

The HTTP Transport Options section includes the following fields:


	Field	Description
	Enable SOAP Action	Specifies whether the WSDL soap:operation has a soapAction attribute. This flag is enabled if a soapAction attribute exists. If you do not want to send a request with the SOAP action HTTP header, then clear the checkbox.
	SOAP Action	Displays the soapAction attribute of the WSDL soap:operation, if one exists. You may specify a different SOAP action in this text box.






	
Accept the default values for these fields or provide values appropriate to your test environment.

The Additional Test Options section includes the following fields. This section provides a simple stress test that simultaneously invokes multiple instances.




	
Note:

This is not a real stress test tool. Therefore, do not enter huge values for both concurrent threads and the number of times to invoke the operation. Doing so can result in errors. 








	Field	Description
	Enable Stress Test	Click Enable to create a simple stress test. With this enabled, no conversation ID is displayed.
	Concurrent Threads	Enter the number of concurrent threads on which to send the invocations. The default is 5 threads.
	Loops per Thread	Enter the number of times to invoke the operation. The default is 10 times.
	Delay in Milliseconds	Specify the delay of milliseconds to wait between operation invocations. The default is 1000 milliseconds (1 second).






	
Accept the default values for these fields or provide values appropriate to your test environment.

The Input Arguments section includes the following fields for entering XML payload data.


	Field	Description
	Tree View	Displays a graphical interface of text fields in which to enter information. This field automatically generates the required headers and XML structure.
	XML View	Displays the XML file format for inserting values. You can paste the raw XML payload of your message into this field.









	
Note:

If you are using Oracle Enterprise Manager Grid Control, you can save the payload you enter. This feature is not available with Oracle Enterprise Manager Fusion Middleware Control.








	
Click Test Web Service.

The test results appear in the Response tab upon completion.

[image: Description of soaapp_testresult.gif follows]







	
Note:

The Response tab does not display payload data if you are performing a stress test or are testing an asynchronous service.








	
Click Launch Message Flow Trace to access the flow trace of the instance.


	
To return to the composite home page, click the name of the composite that appears at the top of the page or select Home from the composite target menu.


	
Return to the Dashboard page of the SOA composite application.

The Recent Instances table lists recent SOA composite application instances. Each created instance has its own unique ID.




For more information, see the following sections:

	
Section 1.2.3, "Introduction to SOA Composite Application Instances" for conceptual details about instances


	
Section 1.4.3.2, "Introduction to Policies" for an overview of policies


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for specific details about policies and testing web services from the Test Web Service page






8.1.1 Specifying RPC/Literal-Style WSDL Files on the Test Page

If you are specifying an RPC/literal-style WSDL file with a message defined by "element=", in the Test page in Oracle Enterprise Manager Fusion Middleware Control, use the XML View option of the Input Arguments section to modify the SOAP message. The SOAP body should look as follows:


<soap:Body>
    <ns:initiate>
        <payload>
          <value xmlns="...">3</value>
        </payload>
    </ns:initiate>
</soap:Body> 


where initiate is the operation name, payload is the part name, and value is the element defined in the WSDL message/part.








8.2 Managing the State of Deployed SOA Composite Applications

You can manage the lifecycle state of deployed SOA composite applications from either of two pages:

	
From the Deployed Composites page of the SOA Infrastructure, which lists all SOA composite applications deployed to the SOA Infrastructure


	
From the application home page of a specific SOA composite application (all tabs)




The management tasks that you can perform are based on the page you are on. Table 8-1 provides details.


Table 8-1 Application State Actions

	Action	Perform in the Deployed Composites Page of the SOA Infrastructure?	Perform on the Application Home Page (All Tabs)?
	
Shut Down and Start Up

	
Yes

	
Yes


	
Retire and Activate

	
Yes

	
Yes


	
Set as Default

	
Yes

	
	
No: If only one version of the composite application is set as the default.


	
Yes: If there are multiple versions of the same composite application, this option is visible for all other versions of the same composite expect the one that is the default.





	
Deploy

	
Yes

	
Yes (through the Composite menu by selecting SOA Deployment > Deploy Another Composite)


	
Undeploy

	
Yes

	
Yes (through the Composite menu by selecting SOA Deployment > Undeploy)


	
Redeploy

	
Yes

	
Yes (through the Composite menu by selecting SOA Deployment > Redeploy)


	
Test

	
No

	
Yes


	
Composite Audit Level

	
No

	
Yes


	
Payload Validation

	
No

	
Yes


	
Enable/Disable Business Monitoring

	
No

	
Yes


	
Show WSDL and Endpoint URI (icon)

	
No

	
Yes


	
Show XML Definition (icon)

	
No

	
Yes








See the following section based on the action you want to perform:

	
Section 8.2.1, "Managing the State of All Applications at the SOA Infrastructure Level"


	
Section 8.2.2, "Managing the State of an Application from the SOA Composite Application Home Page"




For more information, see Section 1.2.2, "Introduction to SOA Composite Applications."



8.2.1 Managing the State of All Applications at the SOA Infrastructure Level

You can manage the state of all SOA composite applications from the Deployed Composites page at the SOA Infrastructure level.

To manage the state of all applications at the SOA Infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	Select Home.


	
	Click soa-infra.


	
	Select SOA Infrastructure.









	
Click the Deployed Composites tab.

The Deployed Composites page displays the following details:

	
A utility for searching for a specific SOA composite application by specifying a full or partial composite name and clicking Search. You can also search for SOA composite applications by partition.


	
A list of all SOA composite applications deployed in the SOA Infrastructure, including the partition in which they are deployed, current mode (active or retired), number of instances, number of faulted instances, and last modification date (deployment time, redeployment time, or any composite configuration change). The green dot to the left of the composite name indicates that this is the default revision of the application.




[image: Description of sca_deployedcomps.gif follows]







	
Note:

To always see the latest details about deployed SOA composite applications, click the Refresh icon in the upper right corner or navigate away from this page and return to it.








	
Click Deploy to deploy a new application. For all other options listed above the Composite section, first select the composite application by clicking the column to the left of the name, then select a specific option to perform.

[image: Description of sca_selectinstance.gif follows]




The following table describes the available options:


	Action	Description
	Shut Down	Shuts down a running SOA composite application revision. Any request (initiating or a callback) to the composite is rejected if the composite is shut down. New incoming requests cannot be processed. All existing instances are allowed to complete as usual (the same as when a composite is retired).
Note: The behavior differs based on which binding component is used. For example, if it is a web service request, it is rejected back to the caller. A JCA adapter binding component may do something else in this case (for example, put the request in a rejected table).

This option is displayed when the composite application has been started.


	Start Up	Restarts a composite application revision that was shut down. This action enables new requests to be processed (and not be rejected). No recovery of messages occurs.
This option is displayed when the composite application has been stopped.


	Retire	Retires the selected composite revision. If the process lifecycle is retired, you cannot create a new instance. Existing instances are allowed to complete as usual.
An initiating request to the composite application is rejected back to the client. The behavior of different binding components during rejection is as described for the shut down option.

A callback to an initiated composite application instance is delivered properly.

This option is displayed when the composite application is active.


	Activate	Activates the retired composite application revision. Note the following behavior with this option:
	
All composite applications are automatically active when deployed.


	
Other revisions of a newly deployed composite application remain active (that is, they are not automatically retired). If you want, you must explicitly retire them.




This option is displayed when the application is retired.


	Set As Default	Sets the selected composite application revision to be the default. Default revisions are indicated by a green dot in the Composite table. If a new request comes in for a specific composite application revision, that composite application revision is invoked. If a new request comes in without specifying a revision, the default revision is invoked. The default revision does not change when a composite application is retired. The default revision is changed automatically when a default composite application revision is undeployed. 
The default composite revision also changes automatically when you redeploy a composite application. The newly redeployed revision automatically becomes the default revision, unless at the time of redeployment, you specify to keep the previous default revision unchanged.

Note that inbound adapters are activated only on the default revision.


	Deploy	Deploys a revision. Deployment activates the composite application in the SOA Infrastructure. Use this selection when you want to deploy:
	
A new SOA composite application for the first time.


	
A new revision (for example, 2.0) of a SOA composite application that has a different revision that is currently deployed (for example, 1.0). This option enables both revisions 1.0 and 2.0 to be deployed at the same time.




If you specify a revision that exists, you receive an error. You must change this revision outside of the Deploy SOA Composite wizard.

For more information, see Section 5.1, "Deploying Applications" and Section 8.10, "Grouping SOA Composite Applications into Partitions."


	Undeploy	Undeploys the selected composite application revision. The consequences of this action are as follows:
	
You can no longer configure and monitor this revision of the composite application.


	
You can no longer process instances of this revision of the composite application.


	
You cannot view previously completed processes.


	
The state of currently running instances is changed to stale and no new messages sent to this composite application are processed.


	
If you undeploy the default revision of the composite application (for example, 2.0), the next available revision of the composite application becomes the default (for example, 1.0).




Note: Undeploying multiple SOA composite applications at the same time is supported if they are in the same partition.

For more information, see Section 5.3, "Undeploying Applications" and Section 8.10, "Grouping SOA Composite Applications into Partitions."


	Redeploy	Redeploys an existing revision of a SOA composite application. The consequences of this action are as follows:
	
A new version of a revision of a currently deployed SOA composite application is redeployed (for example, old version 1.0 is redeployed as new version 1.0).


	
The older, currently deployed version of this revision is removed (overwritten).


	
If the older, currently deployed version of this revision has running instances, the state of those instances is changed to stale.




For more information, see Section 5.2, "Redeploying Applications."








For more information, see Section 1.4.3.3, "Introduction to the Lifecycle State of SOA Composite Applications."









8.2.2 Managing the State of an Application from the SOA Composite Application Home Page

You can manage the state of an individual SOA composite application from the application's home page.

To manage the state of an application from the SOA composite application home page:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select the Deployed Composites tab.


	
Select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application.









The Dashboard page of the selected SOA composite application is displayed (for this example, POApprovalEventPublisher).

[image: Description of sca_helloworld.gif follows]







	
Notes:

	
The Total field of the Recent Instances section sometimes does not display the correct number of total instances despite instances having completed successfully. In these cases, click the Refresh icon in the upper right corner to view the actual number of total instances.


	
When the Capture Composite Instance State checkbox is enabled on the SOA Infrastructure Common Properties page, created instances are displayed immediately even if you have defined a constraint that appears to prevent an instance from being displayed immediately (for example, you have defined a flush delay of 10 minutes or specified a batch size of 100 records to write to a database). This is because instance tracking is moved to the immediate mode since the state of the composites must be captured.


	
After the SOA Infrastructure is started, it may not be completely initialized to administer incoming requests until all deployed composites are loaded. During SOA Infrastructure initialization, a warning message is displayed at the top of the SOA composite application home page. Do not perform operations such as composite deployment, composite undeployment, and others while this message is displayed. For more information, see Section 3.2.1, "Waiting for SOA Infrastructure Startup Initialization to Complete."













	
From the list of options at the top of the page, select a specific action to perform. These options are also displayed at the top of the Instances, Faults and Rejected Messages, Unit Tests, and Policies pages of the SOA composite application.





	Action	Description
	Shut Down	See the table under Step 3 for a description of this option.
	Start Up	See the table under Step 3 for a description of this option.
	Retire	See the table under Step 3 for a description of this option.
	Activate	See the table under Step 3 for a description of this option.
	Test	Enables you to initiate a test instance from the Test Web Service page.
Note: This button is disabled when the SOA composite application is stopped or retired. This is because you cannot create an instance for a stopped or retired application. This button is also disabled when there are no web services available for the application. Only composite applications having services with web service bindings can be tested from this page.

For more information, see Section 8.1, "Initiating a SOA Composite Application Test Instance."


	Settings: Composite Audit Level	Sets the level of audit tracking to perform at the SOA composite application level. This setting can override the audit level defined at the SOA Infrastructure level. By default, the value is Inherit, which does not override the SOA Infrastructure level setting.
If you select to set the audit tracking level, the following options are available:

	
Inherit: Logging matches the SOA Infrastructure audit level that you set on the SOA Infrastructure Common Properties page. This is the default setting.


	
Production: Minimal information for SOA composite application instances is collected. For example, the BPEL process and Oracle Mediator service engines do not capture the payload. Therefore, the payload details are not available in the flow audit trails. The BPEL service engine collects payload details for all activities except assign activities. This level is optimal for most standard operations and testing.


	
Development: Complete information for SOA composite application instances is collected. This option allows both composite instance tracking and payload tracking. This setting may have an impact on performance because the payload is stored at each step in the message flow. This setting is useful for debugging purposes.


	
Off: No logging is performed. Composite instance tracking information and payload tracking information are not collected.




Setting audit level tracking at the SOA composite application level overrides the same tracking set at the SOA Infrastructure level. By default, the settings are the same at the SOA composite application and SOA Infrastructure levels. SOA composite application settings are automatically changed when the global SOA Infrastructure settings are changed. By choosing any other setting at the SOA composite application level, you are overriding the inherited settings.

One form of overriding is when you explicitly select the same local composite value that happens to be the current global value. If the SOA Infrastructure setting is then changed, this specific composite application does not inherit the new value. For example, assume the SOA Infrastructure setting is Off. Therefore, all composite applications have their audit tracking set to Off. Then, you explicitly set composite application XYZ to Off. Then, go to the SOA Infrastructure and change the setting to Production. The tracking levels for all composite applications are now Production; except for XYZ, which is still set to Off.

Note the following impact of instance tracking changes on message flows that span several SOA composite applications (for example, a composite application invoking another composite application through a reference binding component or an event published in one composite application and subscribed to in another composite application).

	
If an intermediate composite application has disabled instance tracking, then a single message flow across multiple composite application instances appears as separate, unconnected flows. For example, assume a message flows through composite applications C1, C2, and C3. C1 and C3 have enabled instance tracking, while C2 has disabled it. Two separate flows for C1 and C3 are displayed in Oracle Enterprise Manager.


	
Sources or targets of events or messages may not be displayed. For example, assume you have two composite applications: C1 and C2. If C1 has disabled instance tracking, the flow trace does not show the origin of the message flow and makes it appear as if C2 were directly invoked.





	Settings: Payload Validation	Validates the XML schema-based payload at the inbound and outbound points of the composite application revision. If you enable payload validation and there is an invalid payload (that does not follow the schema), a fault is generated for that message.
The exception to this is the response message of a synchronous service. That message is not validated, even with payload validation enabled. Note that the inbound message is still validated; only the outbound message is not.


	Settings: Enable/Disable Business Monitoring	Select an option to invoke a confirmation dialog that displays the current status of the sensors.
	
Disable: Select to disable BPEL sensors for all BPEL components in this SOA composite application.


	
Enable: Select to enable BPEL sensors for all BPEL components in this SOA composite application.




The Enable/Disable Business Monitoring selection is only displayed for composites that have a BPEL service component, regardless of whether that component includes sensors.

Note that when BPEL sensors are disabled at the service engine level, you cannot enable or disable BPEL sensors at the SOA composite application level. You can enable or disable BPEL monitors and sensors at the service engine level in the BPEL Service Engine Properties page.

For more information, see Section 8.11, "Disabling and Enabling BPEL and BPMN Business Monitors" and Section 11.1, "Configuring BPEL Process Service Engine Properties."


	Show WSDL and endpoint URI (icon)	Click to display the end point addresses and WSDLs of all external services for this SOA composite application.
Note: If you are using the Safari Browser to view this information, see Section B.11, "Limitation on Using the Safari Browser to View WSDL File Content."


	Show Composite XML Definition (... icon)	Click to show the XML definition of the SOA composite application.






For more information, see the following sections:

	
Section 1.4.3.3, "Introduction to the Lifecycle State of SOA Composite Applications"


	
Section 3.1, "Configuring SOA Infrastructure Properties"









8.2.3 Starting and Stopping a Managed Oracle WebLogic Server

If you start and stop a managed Oracle WebLogic Server on which the SOA Infrastructure is deployed in the middle of BPEL processing in a SOA composite application, note the following issues:

	
For synchronous BPEL processes

The whole scenario is synchronous and the instances that are in a running state (after server restart) are pending in the BPEL wait activity. Therefore, the flow thread ends with the server (while sleeping in the wait activity). When the server is restarted, the same instance is not restarted because the flow is synchronous. Therefore, these instances always remain in a running state because no processing can happen on them after server restart.


	
For asynchronous BPEL process

If server shutdown occurred in the middle of a BPEL invoke activity, the messages received by BPEL are not handled. BPEL does not automatically recover these messages during restart; they must be recovered manually using Facade API calls.











8.3 Monitoring and Deleting SOA Composite Application Instances from the Application Home Page

Section 8.2, "Managing the State of Deployed SOA Composite Applications" describes how to manage the lifecycle state of SOA composite applications. You can also monitor and delete specific SOA composite application instances from the Instances page of the application home page. 

To monitor and delete SOA composite application instances from the application home page:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select the Deployed Composites tab.


	
Select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application from its partition.









	
Click the Instances tab.

The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
SOA composite application instance ID, name, conversation ID, most recent known state of each instance since the last data refresh of the page (for example, completed successfully, running, unknown, and so on), instance start time, and a log file describing any faults. A unique instance ID is created whenever a new instance of a SOA composite application is initiated either automatically by an external consumer of the application, or manually by an administrator from the Test Web Service page.

If a ? icon is displayed, the Capture Composite Instance State checkbox was not enabled on the SOA Infrastructure Common Properties dialog. Therefore, the instance state was not evaluated. Determining the composite instance state requires evaluating the states of the underlying component, Therefore, this can be disabled to improve performance.




[image: Description of soaapp_instance.gif follows]







	
Note:

It is possible to generate orphaned service component instances. These instances are generated without any associated composite application instances. The orphaned component instances are generated under the following circumstances:
	
The SOA Infrastructure audit level is set to Off or the composite audit level is set to Off. Even in such cases, the BPEL process service engine can generate instance data for the service components that are included in the SOA composite application.


	
The SOA Infrastructure audit level is set to Off. However, the BPEL process or Oracle Mediator service engine audit level is set to a value other than Off.


	
All the audit levels are set to Off, but some faults are generated in one of the service engines. In these cases, the component instance gets generated.




To delete orphaned instances or large numbers of instances, use the purge script described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts." Selecting the Delete All Instance options in the Delete with Options dialog does not delete orphaned component instances.









If composite sensors are included in your SOA composite application, the Instances tab has the following differences:

	
The Add Fields button appears next to Search and Reset in the search utility. This button enables you to add sensor values to your search criteria.


	
A Composite Sensors column appears in the Instances table. Click the sensor icon in that column to display the details about sensor values available in a given instance of the composite.





	
From the Add Fields list, select composite sensors to add to the search criteria. In this example, four have been selected (CustomerDetails, NameSensor, Datesensor, and Yearsensor).


	
Input specific values by which each sensor searches. Only the composite instances in which the sensor values match your specified criteria are returned.

[image: Description of soaapp_instance2.gif follows]




	
Click Reset to remove all composite sensor fields from the search criteria or click the Remove icon to the right of the field to remove an individual sensor.


	
Select a specific instance to delete by clicking a row in the Instances table. To select multiple instances, press Ctrl-Click or Shift-Click for the rows you want to select.


	
Select a specific action to perform.


	Action	Description
	Delete Selected	Deletes the selected instance.
After deleting an instance, instance details are no longer available for review.


	Delete With Options	Prompts you to first specify criteria for deleting the selected instance directly from the database:
	
Common Delete Options: Select a preset range of instances to delete from a list (for example, older than 24 hours).


	
Delete All Instances Of This Composite: Select to delete all instances of the composite. This option deletes the rejected messages associated and all component, service, and reference instances associated with the composite, including those not associated with any composite instance ID.

Note: If this composite has thousands of instances to delete, do not use this option. Instead, use the purge script described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."


	
Delete All Instances That Match These Criteria: Specify criteria for deleting instances, including the start and stop times, and instance state.




Any selections you may have made in the Instances page (such as specifying and executing a search criteria) are ignored for this operation.

To monitor the progress of instance deletion, you must check the log files. For information about log files, see Section 3.4, "Configuring Log Files."


	Abort	Terminates the selected instance. However, instance details are still available for review. 






	
From the View list, select Columns > Partition to display the partition in which the instance of the SOA composite application revision is contained.


	
From the View list, select Columns > ECID to display execution context IDs (ECIDs). An ECID enables you to track a message flow that crosses instances of different composites.


	
In the Instances table, perform the following additional tasks:

	
In the Instance ID column, click a specific instance ID to show the message flow through the various service components and binding components. If an instance ID is listed as unavailable, you can click the Unavailable link for details.


	
In the State column, if an instance state is marked as Unknown, click it to display more details.


	
If the Composite Sensors column is available, click a sensor icon to display details about composite sensors included in the instance, such as name, location, and value.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.







	
Note:

Multiple revisions of a SOA composite application that includes inbound JCA adapters are displayed as running. However, only the most recent revision (the default version) is considered active. All previous revisions are not considered active. This is because for inbound JCA adapters, there can only be one active revision of a SOA composite application at any time. The JCA adapter end points in all previous revisions are de-activated.










For more information, see the following sections:

	
Section 1.2.3, "Introduction to SOA Composite Application Instances"


	
Section 1.4.3.3, "Introduction to the Lifecycle State of SOA Composite Applications"


	
Section 8.1, "Initiating a SOA Composite Application Test Instance"


	
Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files






8.3.1 Mismatch Between the Number of SOA Composite Application Instances and Service Component Instances

The number of SOA composite application instances may not always match the number of service component instances displayed in Oracle Enterprise Manager Fusion Middleware Control.

A SOA composite application instance is first created when the composite is invoked. When the service components within the composite receive a subsequent invocation, a corresponding service component instance is created that refers to the composite instance ID previously created.

There can be scenarios under which the composite instance is created, but the underlining service component instance is not created. For example:

	
The composite instance is created, but the invocation has not yet reached the service component due to a system failure.


	
The composite instance is created, but the invocation fails payload validation and is rejected. In this case, invocation does not reach the underlining service components.




You can also have orphaned service component instances for which no SOA composite application instance has been created.






8.3.2 Instance States of Service Components and SOA Composite Applications

Assume you have a SOA composite application with multiple service components (for example, two BPEL process service components). If these service components are marked with the following instance states:

	
Instance state of one BPEL process is marked as completed.


	
Instance state of the other BPEL process is marked as faulted.




This results in the overall composite instance state being marked as faulted. This behavior differs from 11g Release 1 (11.1.1.2), in which the same scenario resulted in the overall composite instance state being marked as completed.

Assume you have a parent SOA composite application that calls a child SOA composite application, and a fault occurs in the child composite (and is handled by the parent composite). This results in the following instance states:

	
The instance state of the child composite is marked as faulted.


	
The instance state of the parent composite is marked as completed.









8.3.3 Setting the Composite Instance Name at Design Time

You can set the instance name of a SOA composite application during design time in Oracle Mediator and Oracle BPEL Process Manager. The instance name appears in the Name column on the Instances page of a SOA composite application. When you specify a search criteria on the Instances page of a SOA composite application or the SOA Infrastructure, you can specify this name in the Name field.



8.3.3.1 Setting the Composite Instance Name in Oracle Mediator

To set the composite instance name in Oracle Mediator:

	
Set the composite instance name through one of the following options:

	
Use the setCompositeInstanceTitle(title) XPath expression function as the source and tracking.compositeInstanceTitle as the target property name in the Assign Value dialog.

[image: Description of soaapp_comptitle2.gif follows]




	
Use the setCompositeInstanceTitle(title) XPath expression function in the XSLT Mapper.

[image: Description of soaapp_comptitle.gif follows]














8.3.3.2 Setting the Composite Instance Name in a BPEL Process

To set the composite instance name in a BPEL process:

	
Use the Java BPEL exec extension bpelx:exec. This extension includes the built-in method setCompositeInstanceTitle(String title)for setting the instance name.

For more information, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.













8.4 Monitoring and Deleting SOA Composite Application Instances at the SOA Infrastructure Level

Section 8.2, "Managing the State of Deployed SOA Composite Applications" described how to manage the lifecycle state of all instances of a specific SOA composite application. You can also monitor and delete any number of instances across all deployed SOA composite applications by using the Instances page of the SOA Infrastructure home page. This page lists all SOA composite application instances deployed to the SOA Infrastructure.

To monitor and delete SOA composite application instances at the SOA infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	Select Home.


	
	Click soa-infra.


	
	Select SOA infrastructure.









	
Click the Instances tab.

The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
All SOA composite application instances in the SOA Infrastructure, including instance and conversation IDs, composite name and revision, SOA composite application instance state, and instance start time. 




[image: Description of sca_instanceids.gif follows]




You can also terminate and delete instances from this page.


	
Select a specific instance by clicking a row in the Instances table. To select multiple instances, press Ctrl-Click or Shift-Click for the rows you want to select.


	
Select a specific action to perform.


	Action	Description
	Delete Selected	Deletes the selected instance. 
	Delete With Options	Prompts you to first specify criteria for deleting the selected instance directly from the database.
	
Common Delete Options: Select a preset range of instances to delete from a list (for example, older than 24 hours).


	
Delete All Instances That Match These Criteria: Specify criteria for deleting instances, including the start and stop times, and instance state.




Any instance state selections you made at the top of the Instances page are ignored for this operation.

To monitor the progress of instance deletion, you must check the log files. For information about log files, see Section 3.4, "Configuring Log Files."

Notes:

	
If this composite has thousands of instances to delete, do not use this option. Instead, use the purge script described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."


	
If you delete an instance with faults, those faults are no longer displayed in the Faults and Rejected Messages page.


	
This option does not purge BPEL process service engine recoverable invoke and callback messages. To completely purge those messages, use the purge scripts described in Section 9.3, "Deleting Large Numbers of Instances with the Purge Scripts."





	Abort	Terminates the selected instance. However, instance details are still available for review.
Note: If you delete an instance with faults, those faults are no longer displayed in the Faults and Rejected Messages page. In addition, if a terminated instance (shown as aborted) had a fault, it is not added to the fault count.








	
From the View list, select Columns > Partition to display the partition in which the instance of the SOA composite application revision is contained.


	
From the View list, select Columns > ECID to display execution context IDs (ECIDs). An ECID enables you to track a message flow that crosses instances of different composites.


	
In the Instance ID column, click a specific instance ID to show the message flow through the various service components and binding components. If the instance ID is unavailable, the message flow cannot be accessed. However, you can still click the link for details.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.









8.5 Recovering from SOA Composite Application Faults at the SOA Infrastructure Level

You can monitor and perform individual and bulk fault recoveries for BPEL process and Oracle Mediator service components across any number of your SOA composite applications. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault. Examples of performing both individual and bulk recovery are provided in this section. Human task service component or human workflow service engine faults are recovered from Oracle BPM Worklist.

To recover from SOA composite application faults at the SOA Infrastructure level:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	Select Home.


	
	Click soa-infra.


	
	Select SOA Infrastructure.









	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for all SOA composite application faults:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults and rejected messages, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the SOA composite application in which the fault occurred, the fault location, the instance ID, and a link to log files describing the fault.
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Note:

You cannot search for human workflow error messages by entering details in the Error Message Contains field because these faults do not persist in the dehydration store.







Faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following options. Note that fault recovery selection at the SOA Infrastructure level matches the SOA composite application level and BPEL process and Oracle Mediator service component levels.


	For...	Then...
	Single fault recovery	There are three options from which to choose for single-fault recovery:
	
Click the row of the fault that has been identified as recoverable. With the row highlighted, select a specific action from the Recovery Action list, as described in Step 4.


	
In the Recovery column, click the Recover link to access the Faults page of the instance audit trail to perform fault recovery.


	
In the Error Message column, click the message of a fault that has been identified as recoverable. This displays complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. A Recover Now option is displayed for recoverable faults. Click Recover Now to access the Faults page of the instance audit trail to perform fault recovery.





	Bulk fault recovery	There are two options from which to choose for bulk-fault recovery:
	
Use Shift+Click or Control+Click to select specific faults in the rows.

or


	
From the Select menu, choose Select All Recoverable. Then use Shift+Click or Control+Click to deselect the faults to not include in the recovery operation.

Then:


	
Select an action from the Recovery Action list, as described in Step 4.

Note: Only the actions applicable to all selected faults are available.





	Recovery of all faults	
	From the Select menu, choose Select All Recoverable.
	
Select an action from the Recovery Action list, as described in Step 4.

Note: Only the actions applicable to all selected faults are available.











	
Select an action from the Recovery Action list.


	Action	Description	Action is Available for...
	Retry	Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.	BPEL process and Oracle Mediator
	Abort	Terminates the entire instance.	BPEL process and Oracle Mediator
	Replay	Replays the entire scope again in which the fault occurred.	BPEL process
	Rethrow	Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.	BPEL process
	Continue	Ignores the fault and continues processing (marks the faulted activity as a success).	BPEL process









	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.








	
If you want to delete rejected messages, click Delete Rejected Messages.

This displays the Delete: Rejected Messages dialog for specifying criteria for deleting rejected messages of all the composites directly from the database.

[image: Description of bp_delrejmess.gif follows]




	
Specify criteria and click Delete.


	
If you want to perform a bulk recovery of messages, click Recover with Options.

This displays the Recover with Options dialog for specifying criteria for recovering BPEL and Oracle Mediator messages of all composites directly from the database. Human workflow messages can be recovered manually from Oracle BPM Worklist. Business event and business rule messages cannot be recovered.

[image: Description of soaapp_recovwithopts.gif follows]




	
Specify criteria. Retry and Abort are the only recovery actions permitted.




	
Note:

For bulk fault recovery at the SOA Infrastructure level, a check of the state of composites cannot be performed. If the state of a composite is set to off, a recovery of its faults cannot be performed. However, no error or warning message is displayed. Upon submission of the bulk fault recovery request, the server checks if the originating composite's state is set to off. That fact is then noted in the log, and the fault is skipped.
You are also not notified when a fault has been skipped during recovery for any other reason (for example, an unsupported service engine, an unrecoverable fault, and so on).










	
Click Recover. Depending upon the number of messages, recovery can take some time.


	
Perform the following additional tasks from within the faults table:

	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Fault Location column, click a specific location to access the faults page for the location of the fault. The location can be a service, service component, or reference.


	
In the Composite Instance ID column, click a specific ID to access the flow trace of the instance.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.





	
See the following sections for examples of single and bulk fault recovery with BPEL processes and Oracle Mediator.

	
Section 8.5.1, "Examples of Fault Recovery for BPEL Processes"


	
Section 8.5.2, "Examples of Fault Recovery for BPMN Processes"


	
Section 8.5.3, "Examples of Fault Recovery for Oracle Mediator"







For more information about concepts and instructions on designing a fault policy, see the following documentation:

	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite






8.5.1 Examples of Fault Recovery for BPEL Processes

This section provides examples of how to define a fault policy that enables human intervention on a BPEL process fault and perform single and bulk fault recovery on a BPEL process service component.

	
Section 8.5.1.1, "Example: Single Fault Recovery for BPEL Processes"


	
Section 8.5.1.2, "Example: Bulk Fault Recovery for BPEL Processes"




In this example, you define a fault policy by specifying that a fault can be manually recovered through human intervention. If an invalid social security number is submitted from a loan broker BPEL process to a credit rating service, the credit rating service returns a negative credit fault. This human intervention action is defined with the ora-human-intervention action in the fault-policies.xml file. Without fault policies, BPEL instances do not generate recoverable faults (instead they are nonrecoverable); the ora-human-intervention action makes the fault recoverable.


<faultPolicies xmlns="http://schemas.oracle.com/bpel/faultpolicy">
<faultPolicy version="2.0.1"
           id="CRM_ServiceFaults"
           xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
           xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns="http://schemas.oracle.com/bpel/faultpolicy"
           xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
            <Conditions>
               <faultName xmlns:credit="http://services.otn.com" 
               name="credit:NegativeCredit">
               <!-- get this fault when SSN starts with 0-->
                  <condition>
                     <test>$fault.payload="Bankruptcy Report"</test>
                     <action ref="ora-human-intervention"/>
                  </condition>
               </faultName>
            </Conditions>
</faultPolicy>
</faultPolicies>


The fault-bindings.xml file associates the fault policies defined in the fault-policies.xml file with the CRM_ServiceFaults composite application.


<faultPolicyBindings version="2.0.1"
 xmlns="http://schemas.oracle.com/bpel/faultpolicy"
 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <composite faultPolicy="CRM_ServiceFaults"/>
</faultPolicyBindings>


Because human intervention is defined as an action, you perform BPEL process fault recovery in Oracle Enterprise Manager Fusion Middleware Control.

For more information about creating and designing fault-policies.xml and fault-bindings.xml files, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.



8.5.1.1 Example: Single Fault Recovery for BPEL Processes

This example assumes the following:

	
An instance was initiated on the Test Web Service page shown in Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
An invalid social security number that begins with 0 was entered.




To perform single fault recovery for BPEL processes:

	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.


	
In the faults table, locate the fault that has been identified as recoverable. You can use the search utility to locate the specific fault.


	
In the Recovery column, click Recover. If you first want to see details about the fault, click the error message. Then, click Recover Now.

The Faults page for that BPEL process instance is displayed.


	
In the Recovery column, click Recoverable.

The page refreshes to display the fault recovery section at the bottom of the page.
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From the Recovery Action list, select Retry.


	
Select None from the Chain Action Upon Successful Retry list. This list enables you to select Java callout recovery actions. For more information, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
Select a variable from the Variable list. The content of this variable is displayed in the Value field. For this example, the variable crInput is selected. This variable is used in an invoke activity and contains an incorrect social security number value.


	
Enter the correct value in the Value field. For this example, the social security number is edited to begin with 1:


<ssn xmlns="http://service.otn.com">123456789</ssn>


	
Click Set Value, and click Yes when prompted to continue.


	
Click Recover to recover from the fault, and then click Yes when prompted to continue.

The page refreshes to indicate that no faults occurred.









8.5.1.2 Example: Bulk Fault Recovery for BPEL Processes

For the social security number example, selecting Retry is not an option for performing a bulk recovery, because the value for the social security number is incorrect and requires correction. An example of performing a bulk recovery with the Retry option is if the social security number is correct, but the system providing the credit rating service was temporarily unavailable and caused a composite reference fault. This prevents the messages from being delivered. Once the credit rating service is available again, selecting Retry attempts the invocation to the credit rating service through the composite reference again.

To perform bulk fault recovery for BPEL processes:

	
Perform Step 1 and Step 2 of Section 8.5.1.1, "Example: Single Fault Recovery for BPEL Processes."


	
In the search utility, enter criteria based on known fault parameters (for example, the time range, composite name, component type (BPEL process), and so on).


	
If the search returns too many results, limit it by selecting the Show only recoverable faults checkbox.


	
From the Select list, choose Select All Recoverable.


	
From the Recovery Action list, select Abort.

All selected faults are manually terminated.











8.5.2 Examples of Fault Recovery for BPMN Processes

This section provides examples of how to define a fault policy that enables human intervention on a BPMN process fault and perform single and bulk fault recovery on a BPMN process service component.




	
Note:

When a multi-instance process has met the conditions for its completion, it raises a nonrecoverable system fault (to cancel remaining instances). Although this fault appears in the Oracle Enterprise Manager Fusion Middleware Control, you do not need to take any action. It appears simply to notify you that the multi-instance process was finalized because the condition was completed.







	
Section 8.5.2.1, "Example: Single Fault Recovery for BPMN Processes"


	
Section 8.5.2.2, "Example: Bulk Fault Recovery for BPMN Processes"




In this example, you define a fault policy specifying that a fault be manually recovered through human intervention. If an invalid social security number is submitted from a loan broker BPMN process to a credit rating service, the credit rating service returns a negative credit fault. This human intervention action is defined with the ora-human-intervention action in the fault-policies.xml file. Without fault policies, BPMN instances do not generate recoverable faults (instead they are nonrecoverable); the ora-human-intervention action makes the fault recoverable.


<faultPolicies xmlns="http://schemas.oracle.com/bpmn/faultpolicy">
<faultPolicy version="2.0.1"
           id="CRM_ServiceFaults"
           xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
           xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns="http://schemas.oracle.com/bpmn/faultpolicy"
           xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
            <Conditions>
               <faultName xmlns:credit="http://services.otn.com" 
               name="credit:NegativeCredit">
               <!-- get this fault when SSN starts with 0-->
                  <condition>
                     <test>$fault.payload="Bankruptcy Report"</test>
                     <action ref="ora-human-intervention"/>
                  </condition>
               </faultName>
            </Conditions>
</faultPolicy>
</faultPolicies>


The fault-bindings.xml file associates the fault policies defined in the fault-policies.xml file with the CRM_ServiceFaults composite.


<faultPolicyBindings version="2.0.1"
 xmlns="http://schemas.oracle.com/bpmn/faultpolicy"
 xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
    <composite faultPolicy="CRM_ServiceFaults"/>
</faultPolicyBindings>


Because human intervention is defined as an action, you perform BPMN process fault recovery in Oracle Enterprise Manager Fusion Middleware Control.

For more information about creating and designing fault-policies.xml and fault-bindings.xml files, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.



8.5.2.1 Example: Single Fault Recovery for BPMN Processes

This example assumes the following:

	
An instance was initiated on the Test Web Service page shown in Section 8.1, "Initiating a SOA Composite Application Test Instance."


	
An invalid social security number that begins with 0 was entered.




To perform single fault recovery for BPMN processes:

	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.


	
In the faults table, locate the fault that has been identified as recoverable. You can use the search utility to locate the specific fault.


	
In the Recovery column, click Recover. If you first want to see details about the fault, click the error message. Then, click Recover Now.

The Faults page for that BPMN process instance is displayed.


	
In the Recovery column, click Recoverable.

The page refreshes to display the fault recovery section at the bottom of the page.
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From the Recovery Action list, select Retry.


	
From the Chain Action Upon Successful Retry list, select None. This list enables you to select Java callout recovery actions. For more information, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.


	
From the Variable list, select a variable. The content of this variable is displayed in the Value field. For this example, the variable crInput is selected. This variable is used in an invoke activity and contains an incorrect social security number value.


	
In the Value field, enter the correct value. For this example, the social security number is edited to begin with 1:


<ssn xmlns="http://service.otn.com">123456789</ssn>


	
Click Set Value, and click Yes when prompted to continue.


	
Click Recover to recover from the fault, then click Yes when prompted to continue.

The page refreshes to indicate that no faults occurred.









8.5.2.2 Example: Bulk Fault Recovery for BPMN Processes

For the social security number example, selecting Retry is not an option for performing a bulk recovery because the value for the social security number is incorrect and requires correction. An example of performing a bulk recovery with the Retry option is if the social security number is correct, but the system providing the credit rating service was temporarily unavailable and caused a composite reference fault. This prevents the messages from being delivered. Once the credit rating service is available again, selecting Retry re-attempts the invocation to the credit rating service through the composite reference.

To perform bulk fault recovery for BPMN processes:

	
Perform Steps 1 through 2 of Section 8.5.1.1, "Example: Single Fault Recovery for BPEL Processes."


	
In the search utility, enter criteria based on known fault parameters (for example, the time range, composite name, component type (BPMN process), and so on).


	
If the search returns too many results, limit it by selecting the Show only recoverable faults checkbox.


	
From the Select list, choose Select All Recoverable.


	
From the Recovery Action list, select Abort.

All selected faults are manually terminated.











8.5.3 Examples of Fault Recovery for Oracle Mediator

This section provides an example of how to perform single and bulk fault recovery on an Oracle Mediator service component.

	
Section 8.5.3.1, "Example: Single Fault Recovery for Oracle Mediator"


	
Section 8.5.3.2, "Example: Bulk Fault Recovery for Oracle Mediator"




In this example, a service binding component for an inbound Siebel adapter submits a payload message to Oracle Mediator for transformation. The processed payload message is then delivered to a reference binding component for an outbound file adapter. However, the outbound directory into which to write the payload message is not configured with write permissions. This causes a fault to occur. The fault policy defined during design time specifies that the fault be manually recovered through human intervention. Note that three retries are attempted, as defined with the retryCount attribute. The condition and action are defined as follows in the fault-policies.xml file.

Recoverable Oracle Mediator faults do not require a fault policy (though it is one way to make faults recoverable, as described through an ora-human-intervention action). Any parallel routing rule that receives a remote fault from the outbound end point also creates a recoverable fault (in this specific example, the fault policy is not required if the Oracle Mediator uses a parallel routing rule to invoke the outbound file adapter).


<faultPolicies xmlns="http://schemas.oracle.com/bpel/faultpolicy">
<faultPolicy version="2.0.1"
           id="ConnectionFaults"
           xmlns:env="http://schemas.xmlsoap.org/soap/envelope/"
           xmlns:xs="http://www.w3.org/2001/XMLSchema"
           xmlns="http://schemas.oracle.com/bpel/faultpolicy"
           xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
              <Conditions>
                <faultName xmlns:medns="http://schemas.oracle.com/mediator/faults"
                name="medns:mediatorFault">
                   <condition>
                      <test>contains($fault.mediatorErrorCode, "TYPE_FATAL_
                         MESH")</test>
                      <action ref="ora-retry"/>
                   </condition>
                </faultName>
              </Conditions>
. . .
. . .      <Action id="ora-retry">
        <retry>
          <retryCount>3</retryCount>
          <retryInterval>5</retryInterval>
          <retryFailureAction ref="ora-human-intervention"/>
          <retrySuccessAction ref="ora-terminate"/>
        </retry>
      </Action>
   </Actions>
</faultPolicy>
</faultPolicies>


Note that processing is set to retry 3 times before terminating.

The fault policies are associated with the ConnectionFaults composite application in the fault-bindings.xml file:


<faultPolicyBindings version="2.0.1" xmlns="http://schemas.oracle.com/bpel/fault
policy" xmlns:xsi="http://www.w3.org/2001/XMLSchema-instance">
        <composite faultPolicy="ConnectionFaults"/>
</faultPolicyBindings>




8.5.3.1 Example: Single Fault Recovery for Oracle Mediator

For this example, the sap output directory is made read-only. An inbound file adapter retrieves the sender.xml file from the siebel directory and the message is routed through Oracle Mediator to an outbound file adapter reference for placing a file in the sap directory.

To perform single fault recovery for Oracle Mediator:

	
Change the directory permissions at the operating system command prompt.


chmod 000 sap
cp sender.xml siebel/


	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.

Note that three faults appear, based on three retries being attempted. In this case, you see three retries only because the fault policy on the Oracle Mediator interaction with the outbound file adapter defines three retries. Without the fault policy, there is only one fault (no automated retries).


	
Click the specific instance ID in the Composite Instance ID column.

The Flow Trace appears. The faults table at the top of the page displays the fault messages. If you want to see where the faulted Oracle Mediator instance is located in the overall message flow, select the fault in the faults table. This highlights the associated instance in the trace table. You can then click the instance to access its audit trail to see more details about the faulted flow.




	
Note:

Steps 4 through 10 represent one way to recover this single fault. The fault can also be recovered directly from the Oracle Mediator faults page through the Recovery Action list.








	
Locate the Oracle Mediator component instance fault you want to recover in the Faults table and click Recover in the Recovery column.


	
Select Sender from the Payload Part list.

The payload is automatically displayed in the Payload field. If necessary, payload modifications can be performed in this field. For this example, payload modification is not necessary.


	
Change the sap directory to be writable at the operating system command prompt.


chmod 777 sap


	
Return to the Faults tab and click the Refresh icon in the upper right corner of the page.


	
Click Retry.


	
Click Yes when prompted to resubmit the selected fault for recovery.

The page refreshes to indicate that no faults occurred.


	
Click the Audit Trail tab.

The final message indicates that manual recovery was successful and the message payload was written to the sap directory.

[image: Description of bp_flt29.gif follows]











8.5.3.2 Example: Bulk Fault Recovery for Oracle Mediator

Assume the sap directory to which to write the sender.xml payload message is again configured with read-only permissions at the operating system command prompt. Three copies of the sender.xml file are placed in the siebel directory of the service binding component for the inbound Siebel adapter. This creates three instances.


chmod 000 sap
cp sender.xml siebel/
cp sender.xml siebel/
cp sender.xml siebel/


To perform bulk fault recovery for Oracle Mediator:

	
Change the sap directory to be writable.


	
From the SOA Infrastructure menu, select Home.


	
Click the Faults and Rejected Messages tab.


	
In the search utility, enter criteria based on known fault parameters (for example, the time range, composite name, and so on).


	
If the search returns too many results, limit it by selecting the Show only recoverable faults checkbox.


	
Change the sap directory to be writable at the operating system command prompt.


chmod 777 sap


	
Select all the faults to be recovered.


	
Select Retry from the Recovery Action list.


	
Select Yes when prompted to perform fault recovery.


	
Click the Audit Trail tab.

The final message indicates that manual recovery was successful and the message payload was successfully written to the sap directory.













8.6 Recovering from SOA Composite Application Faults in the Application Home Page

You can monitor and perform individual and bulk fault recoveries in your SOA composite application. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault. Human workflow faults can also be recovered, but not directly from Oracle Enterprise Manager Fusion Middleware Control. Instead, the audit trail provides a link to the Oracle BPM Worklist, from which the fault can be addressed.

To recover from SOA composite application faults in the application home page:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application.









	
Click the Faults and Rejected Messages tab.

The Faults and Rejected Messages page displays the following details for the selected SOA composite application:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults and rejected messages in SOA composite application instances, including the error message, whether you can recover from the fault, the time of the fault, if the fault message is classified as a rejected message (if so, a checkmark is displayed), the fault location, the composite instance ID, and links to log files that describe the fault.




[image: Description of sca_soaapp_search.gif follows]







	
Note:

You cannot search for human workflow error messages by entering details in the Error Message Contains field because these faults do not persist in the dehydration store.







Faults identified as recoverable can be recovered.


	
Select faults for recovery. As with fault recovery at the SOA Infrastructure level and BPEL process and Oracle Mediator service component levels, you can perform single fault recovery, bulk fault recovery, and recovery of all faults. See Step 3 of Section 8.5, "Recovering from SOA Composite Application Faults at the SOA Infrastructure Level" for instructions on selecting faults to perform these types of recovery.


	
Select an action from the Recovery Action list.


	Action	Description	Action is Available for...
	Retry	Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.	BPEL process and Oracle Mediator
	Abort	Terminates the entire instance.	BPEL process and Oracle Mediator
	Replay	Replays the entire scope again in which the fault occurred.	BPEL process
	Rethrow	Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.	BPEL process
	Continue	Ignores the fault and continues processing (marks the faulted activity as a success).	BPEL process









	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.








	
If you want to delete rejected messages, click Delete Rejected Messages.

This displays the Delete: Rejected Messages dialog for specifying criteria for deleting rejected messages of the current composite directly from the database.

[image: Description of bp_delrejmess.gif follows]




	
If you want to perform a bulk recovery of messages, click Recover with Options.

This displays the Recover with Options dialog for specifying criteria for recovering BPEL and Oracle Mediator messages of the current composite directly from the database. Human workflow messages can be recovered manually from Oracle BPM Worklist. Business event and business rule messages cannot be recovered.

[image: Description of soaapp_recovwithopts.gif follows]




	
Specify criteria. Retry and Abort are the only recovery actions permitted.




	
Note:

For bulk fault recovery at the SOA composite application level, a check of the state of the composite is performed. If the state of the composite is set to off, a message is displayed warning you that a recovery cannot be performed.
You are not notified when a fault has been skipped during recovery for any reason (for example, an unsupported service engine, an unrecoverable fault, and so on).










	
Click Recover. Depending upon the number of messages, recovery can take some time.


	
Perform the following additional monitoring tasks from within the faults table:

	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Fault Location column, click a specific location to access the faults page for the location of the fault. The location can be a service, component, or reference.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Note that rejected messages do not have a component instance ID.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.







For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section 8.5.1, "Examples of Fault Recovery for BPEL Processes"


	
Section 8.5.3, "Examples of Fault Recovery for Oracle Mediator"









8.7 Automating the Testing of SOA Composite Applications

You can create, deploy, and run test cases that automate the testing of SOA composite applications. Test cases enable you to simulate the interaction between a SOA composite application and its web service partners before deployment in a production environment. This helps to ensure that a process interacts with web service partners as expected by the time it is ready for deployment to a production environment. You create test cases in Oracle JDeveloper and include them in a SOA composite application that is then deployed and administered from Oracle Enterprise Manager Fusion Middleware Control.

To automate the testing of SOA composite applications:




	
Note:

Before testing SOA composite applications from Oracle Enterprise Manager Fusion Middleware Control, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for instructions on creating test cases.







	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	Select Home.
	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.


	
Click the Unit Tests tab.




	
	Under soa-infra, select a specific SOA composite application beneath the partition.
	
Click the Unit Tests tab.




	
	Select Unit Test.









The test cases that are displayed were designed in Oracle JDeveloper and included in a deployed SOA composite application.


	
Select the entire test suite or individual tests of a suite to run, and click Execute.

[image: Description of sca_unittest.gif follows]




You are prompted to create a test.


	
Enter the following values, and click OK.


	Field	Description
	Test Run Name	Enter a name for the test instance. When testing is complete, report details are captured under this name.
	Timeout	Enter a value in seconds in which to complete this test. If the test does not complete within this time limit, then testing is terminated.
	Number of Concurrent Test Instances	Enter the number of test instances to create.






The Test Runs page is automatically displayed for tracking the running tests.

The Test Runs page enables you to track running test cases and view test results. Test suites consist of a logical collection of one or more test cases. Each test case contains a set of commands to perform as the test instance is executed. The execution of a test suite is known as a test run.

[image: Description of sca_unittest2.gif follows]




	
In the Test Run Name column, click a specific test run to display details in the Results of Test Run section. If you want to create more test runs, you can switch back to the Test Cases page at any time.

The Results of Test Run section displays details about the executed test run, such as a test summary and the success rate. Click the Help icon for additional details.


	
View assertion details at the bottom of the page. Assertions enable you to verify variable data or process flow.

[image: Description of sca_unittest3.gif follows]




	
Click a composite instance number to view specific test details.

The composite instances created by executing unit test runs are displayed with a yellow square next to the instance ID in the Instances page of a SOA composite application and in the Recent Instances tables of the SOA Infrastructure and SOA composite application. This yellow box distinguishes these instances from test instances created on the Test Web Service page or automatically created by external consumers of the application.




For more information, see the following documentation:

	
Section 1.4.3.4, "Introduction to SOA Composite Application Automated Testing"


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for instructions on creating test cases in Oracle JDeveloper









8.8 Managing SOA Composite Application Policies

You can attach or detach security policies to and from currently deployed SOA composite applications. Policies apply security to the delivery of messages.




	
Note:

Before attaching policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use in your environment.







To manage SOA composite application policies:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...	From the SOA Composite Menu...
	
	Select Home.
	
Select Deployed Composites.


	
In the Composite section, select a specific SOA composite application.


	
Click the Policies tab.




	
	Under soa-infra, select a specific SOA composite application beneath the partition.
	
Click the Policies tab.




	
	Select Policies.









The Policies page enables you to attach and detach policies to and from BPEL process service components. The policies table displays the attached policy name, the component to which the policy is attached, the policy reference status (enabled or disabled) that you can toggle, the category (Management, Reliable Messaging, MTOM Attachment, Security, or WS-Addressing), the violations, and the authentication, authorization, confidentiality, and integrity failures since the SOA Infrastructure was last restarted.

[image: Description of sca_policy.gif follows]




	
Click Attach/Detach To.

If multiple services or components are available, you are prompted to select the service or component for which to perform the attachment or detachment.


	
Select the component to which to attach or detach a policy.

[image: Description of soaapp_policy1.gif follows]




This invokes a dialog for attaching or detaching policies.

Currently attached policies appear in the Attached Policies section. Additional policies available for attachment appear in the Available Policies section.

[image: Description of soaapp_policy2.gif follows]




	
Select policies to attach that are appropriate to your environment.


	
Click Attach.

The attached policy appears in the Attached Policies section.

[image: Description of soaapp_policy3.gif follows]




	
Attach additional policies as needed.


	
When you are finished attaching policies, click Validate.


	
If an error message appears, make the necessary corrections until you no longer have any validation errors.


	
Click OK.

The attached policy is displayed in the policies table.

[image: Description of soaapp_policy4.gif follows]






For more information about policies, see the following documentation:

	
Section 1.4.3.2, "Introduction to Policies"


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use for your environment






8.8.1 WS-RM Sessions

Multiple requests from Oracle SOA Suite in a single WS-RM session are not currently supported. Each request is in an individual WS-RM session.






8.8.2 Policy Attachments and Local Optimization in Composite-to-Composite Invocations

OWSM supports an Oracle SOA Suite local optimization feature for composite-to-composite invocations in which the reference of one composite specifies a web service binding to a second composite. Local optimization enables you to bypass the HTTP stack and SOAP/normalized message conversions during runtime. Local optimization is not used if the composites are in different containers. If a policy is attached to the web service binding, the policy may not be invoked if local optimization is used.

By default, an OWSM security policy includes a local-optimization property that identifies if the policy supports local optimization. You can view the setting for a policy in Oracle Enterprise Manager Fusion Middleware Control.

To view the local optimization setting for policies:

	
In the navigator, expand the WebLogic Domain folder.


	
Right-click WLS_SOAWC, and select Web Services > Policies.


	
Select a policy and click Export to File.


	
Open the file with a text editor and search for local-optimization to identify the value. This property supports the following values:

	
on: Local optimization is used in the attached policy, and the policy is not applied at runtime.


	
off: Local optimization is not used in the attached policy, and the policy is applied at runtime.


	
check-identity: If a JAAS subject exists in the current thread, local optimization is used. Otherwise, local optimization is not used.







For information on the default local optimization settings for security policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services.

You can override the local optimization setting for a policy by adding the oracle.webservices.local.optimization property in the binding section of the composite.xml file. The following values are supported:

	
true (default value): Local optimization is used, and the policy is applied if it is applicable to optimized calls (details are defined in the individual policy file).


	
false: Local optimization is not used, regardless of the default setting for the local-optimization property at the OWSM policy level. This setting forces the policy to be applied.




For example, the following setting of false causes oracle/wss_username_token_client_policy to be applied.


 <binding.ws
port="http://xmlns.oracle.com/CalledBPELProcessApp_
jws/CalledBPELProcess/CalledBPELProcess#wsdl.endpoint(calledbpelprocess_client_
ep/CalledBPELProcess_pt)"

location="http://sta00634.us.oracle.com:8001/soa-infra/services/default/CalledBPEL
Process!1.0/calledbpelprocess_client_ep?WSDL">
      <wsp:PolicyReference URI="oracle/wss_username_token_client_policy"
                           orawsp:category="security"
orawsp:status="enabled"/>
      <wsp:PolicyReference URI="oracle/log_policy"
orawsp:category="management"
                           orawsp:status="enabled"/>
                            <property
name="oracle.webservices.local.optimization">false</property>
    </binding.ws> 








8.9 Exporting a Running SOA Composite Application

You can export the contents of a running SOA composite application to an archive JAR file. The file can include some or all of the following data:

	
The original design-time composite


	
Postdeployment changes in the rules dictionary and domain value maps (DVMs)


	
Postdeployment property changes such as binding component properties, composite properties such as audit level settings and payload validation status, and policy attachments







	
Notes:

	
SOA composite application exporting is currently only allowed at the individual SOA composite level.


	
Shared metadata is not exported as part of the composite export SOA archive (SAR).












To export a running SOA composite application:

	
Go to the home page of the SOA composite application to export.


	
From the SOA Composite menu, select Export.

The Export Composite page appears.

[image: Description of soaapp_export.gif follows]




	
Select an option.

	
Option 1: Generates an archive file containing the original design-time composite and the postdeployment details described in Option 2 and Option 3.


	
Option 2: Includes the original design-time composite and postdeployment changes in the rules dictionary and DVMs.


	
Option 3: Includes the original design-time composite and postdeployment property changes such as binding component properties, composite properties such as audit level settings and payload validation status, and policy attachments.


	
Option 4: Generates an archive file containing only the original design-time composite. Options 2 and 3 are not included.





	
If you want to append an additional name to the existing file, select Specify Custom Extension Text. For example, entering MyText to a file named sca_OrderBookingComposite_rev1.0.jar names the exported file as sca_OrderBookingComposite_rev1.0-MyText.jar.


	
Click Export.

The Processing: Export Composite dialog displays the progress of archive file generation. When generation completes, you are prompted to save the file.


	
Click Save File.

A dialog appears for either opening or saving the file to a directory on your local host.




	
Note:

It is important that you click the Save File button. Do not simply close this dialog. Although the composite is exported, you cannot retrieve the actual exported file.








	
Specify the local directory in which to save the JAR file.


	
In the upper right of the Processing: Export Composite dialog, click the x icon to close the dialog.


	
On the Export Composite page, note that the Cancel button has changed to Done.


	
Click Done.

The Export Composite is closed and you are returned to the SOA composite application home page.









8.10 Grouping SOA Composite Applications into Partitions

You can deploy SOA composite applications into separate sections of the SOA Infrastructure known as partitions. Deploying to partitions enables you to logically group SOA composites and perform bulk lifecycle management tasks on all SOA composite applications within a specific partition. Partitions are similar to the domain feature that was part of 10.1.x releases of Oracle BPEL Process Manager. However, note that you cannot perform specific configuration tasks on partitions, such as restricting login access to a specific partition or configuring partitions (such as configuring threading).

At least one partition is required for deploying SOA composite applications. A default partition named default is automatically included with Oracle SOA Suite.

You can manage partitioning from either of two pages:

	
From the Manage Partitions page of the SOA Infrastructure, which lets you create partitions, delete partitions, and perform bulk lifecycle management tasks on all SOA composite applications in a specific partition


	
From the partition home page, which also enables you to perform bulk lifecycle management tasks on all SOA composite applications in a specific partition







	
Note:

If SOA composite applications using the same inbound resource are deployed to different partitions, it cannot be guaranteed which partition picks up the message for processing. 
For example, assume you are using the file adapter and /home/Directory1 is the inbound directory for the composite SOAComposite1. If this composite is deployed to both Partition1 and Partition2, when a file is placed in /home/Directory1, either the composite in Partition1 or Partition2 may pick up the file.

With the socket adapter, however, there is a limitation that does not permit you to deploy any composite that uses the same inbound port. In that case, an exception is thrown indicating that the inbound port is in use.









Table 8-2 provides more specific details on the tasks you can perform from both pages.


Table 8-2 Partition Management Actions

	Action	Perform on the Manage Partitions Page?	Perform on the Partition Home Page?
	
Create a partition

	
Yes

	
No


	
Delete a partition

	
Yes

	
Yes. Select the SOA Partition menu, then select Delete This Partition.

Note: You can also delete a partition by right-clicking it in the navigator and selecting Delete This Partition.


	
Perform bulk lifecycle management tasks on all composites deployed to a specific partition:

	
Start all


	
Shut down all


	
Retire all


	
Activate all


	
Undeploy all




	
Yes

	
Yes











	
Notes:

	
Partitions are not associated with a particular state such as started, stopped, activated, or retired. Only the composites within the partition are associated with a particular state. Therefore, you cannot start, stop, activate, or retire a partition.


	
After the SOA Infrastructure is started, it may not be completely initialized to administer incoming requests until all deployed composites are loaded. During SOA Infrastructure initialization, a warning message is displayed at the top of the Manage Partitions and Partitions home pages. Do not perform operations such as composite deployment, composite undeployment, and others while this message is displayed. For more information, see Section 3.2.1, "Waiting for SOA Infrastructure Startup Initialization to Complete."












See the following section based on the tasks you want to perform:

	
Section 8.10.1, "Creating and Deleting Partitions"


	
Section 8.10.2, "Performing Bulk Lifecycle Management Tasks on Composites in Partitions"




For more information about partitions, see Section 1.4.3.5, "Introduction to Partitioning of the SOA Infrastructure."



8.10.1 Creating and Deleting Partitions

You can create and delete partitions on the Manage Partitions page. A default partition named default is automatically included with Oracle SOA Suite. You can delete the default partition. Note that you cannot rename existing partitions; only creation and deletion of partitions is supported.

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the Home Page of a Specific Partition...
	
	Select Manage Partitions.


	
	From the Related Links list of a specific partition, select Manage Partitions.









The Manage Partitions page displays the following details:

	
The name of each partition, the number of active and retired SOA composite application revisions in each partition, the name of the composites contained in each partition (under the View link), and the total number of running and faulted instances in each partition.


	
A utility for searching for a specific partition. Enter a full or partial partition name and click the Search icon or press the Return key. The search is not case-sensitive.




[image: Description of soaadmin_partition4.gif follows]




	
To add a partition, click Create.

The Create New SOA Partition dialog is displayed.

[image: Description of soaadmin_createpartition.gif follows]




	
In the Name field, enter a partition name, and click Create.




	
Note:

The name must conform to the following conventions:
	
ASCII letters and numbers are permitted.


	
Underscores (_) are permitted.


	
Hyphens (-) are permitted (except as the first character).


	
Non-ASCII letters are permitted.


	
Spaces are not permitted.




Examples of valid names are mypartition, partition2, dept-a, customer_services, and 22. Examples of invalid names are -part2, /partition, and null or empty names.









You cannot rename an existing partition or later transfer the composite applications you deployed to it to a different partition.

The new partition is displayed in both the navigator under soa-infra and the SOA Partition column of the Manage Partitions page. You can now deploy composites to this partition by selecting Deploy to This Partition from the Deployment dropdown list or right-clicking a specific partition in the navigator and clicking Deploy to This Partition.

When a composite is deployed to a partition, it is displayed beneath the partition in the navigator. Once deployed, a composite cannot be transferred to a different partition.

[image: Description of soaadmin_createpartition2.gif follows]







	
To delete a partition, select a specific partition and click Delete. Note that you can also right-click a specific partition in the navigator and click Delete This Partition.

The Delete SOA Partition dialog is displayed. Note the following:

	
If you want to re-create some of your composite deployments in another partition, you can export those composites to a JAR file before you delete this partition. 


	
Before deleting the selected partition, all SOA composite application revisions in the partition are undeployed. The states of all undeployed instances of these revisions become stale.







	
Note:

You must have at least one partition. If you delete all partitions, you cannot deploy a SOA composite application.
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Click Delete (Undeploy All Composites).

All composites that were deployed in the partition are undeployed and no longer appear in the navigator. The partition is then deleted from both the navigator under soa-infra and the SOA Partition column of the Manage Partitions page.







For information about performing bulk lifecycle management tasks from the Composites Control and Deployment lists, see Section 8.10.2, "Performing Bulk Lifecycle Management Tasks on Composites in Partitions."

You can also create partitions with the WebLogic Scripting Tool (WLST) and ant commands. For information, see Oracle Fusion Middleware WebLogic Scripting Tool Command Reference and Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.






8.10.2 Performing Bulk Lifecycle Management Tasks on Composites in Partitions

You can perform bulk lifecycle management tasks on all SOA composite applications in a specific partition on the Manage Partitions page, on the home page of a specific partition, and from the menu that is displayed when you right-click a partition in the navigator.

Bulk lifecycle management tasks impact not one, but many, composites at once. If a composite has running instances and a lifecycle changing operation is performed on the composite, the instances may not complete. For information about how different lifecycle operations impact the composite instances, see Step 3 of Section 8.2.1, "Managing the State of All Applications at the SOA Infrastructure Level."

To perform bulk lifecycle management tasks on all SOA composite applications in a specific partition:

	
Access either page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Manage Partitions.


	
	Under soa-infra, select a specific partition.












	
Note:

As a shortcut, you can also right-click a specific partition in the navigator to display a menu for selecting the bulk lifecycle management actions described in this section. For more information about this menu, see Step 3 of Section 2.2.3, "Navigating Through the Partition Home Page and Menu."







Two dropdown lists that are displayed on either page enable you to perform bulk lifecycle management actions:

	
Composites Control list


	
Deployment list




On the home page of a specific partition, these lists are displayed at the top of the page.
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On the Manage Partitions page, these lists are displayed above the SOA Partition table:

[image: Description of soaadmin_partition4.gif follows]







	
Note:

You can also select to deploy composites to a partition and perform bulk lifecycle management tasks by selecting the SOA Partition menu at the top of the partition home page.








	
To perform one of the following bulk lifecycle management tasks for all SOA composite applications contained in the selected partition, select the Composites Control list:

	
Start all composites.


	
Shut down all composites.


	
Activate all composites.


	
Retire all composites.




[image: Description of soaadmin_comp_control.gif follows]




	
Select an operation to perform.

A dialog is displayed that prompts you to confirm your selection. When the operation completes, a confirmation message is displayed at the top of the page.





	
To perform one of the following management tasks, select the Deployment list:

	
Specify a composite to deploy to this partition. This selection invokes the Deploy SOA Composite wizard where you specify a composite revision to deploy.


	
Undeploy all composites in this partition. 

A dialog is displayed that prompts you to confirm your selection. When the operation completes, a confirmation message is displayed at the top of the page.
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8.11 Disabling and Enabling BPEL and BPMN Business Monitors

The term business monitoring comprises different types of sensors that can be defined for some types of SOA components, such as the following:

	
BPEL sensors: Enable you to create sensors in BPEL faults, activities, and variables.


	
BPEL Monitors: Enable you to capture BPEL process metrics that are sent to Oracle BAM Server, and then used for analysis and graphic display.


	
BPMN measurements: Enable you to measure a business indicator at a certain point in the process or in a section of the process.




At the SOA composite application level, you set the same status for all sensors defined for all types of service components comprising the selected composite. You cannot selectively enable or disable sensors defined for a specific type of service component for just one composite. However, you can globally disable service component-type specific sensors for all composites in the respective BPEL Service Engine Properties page or BPMN Service Engine Properties page.

By default, BPEL and BPMN sensors defined in SOA composite applications are enabled. Disabling sensors means that sensor values are not captured during runtime. For example, this results in the values not being displayed in the Sensor Values section of the BPEL audit trail.

To disable sensors at the service engine level:

	
Access the BPEL Service Engine Properties page by following the steps in Section 11.1, "Configuring BPEL Process Service Engine Properties."


	
Select the Disable BPEL Monitors and Sensors checkbox.


	
Click Apply.


	
Access the BPMN Service Engine Properties page by following the steps in Section 36.1, "Configuring BPMN Process Service Engine Properties"




	
Note:

The BPMN Service Engine Properties page is only displayed if Oracle BPM Suite is installed.








	
Select the Disable BPMN Measurements checkbox.


	
Click Apply.




To disable or enable sensors at the SOA composite application level:

	
Go to the home page of the SOA composite application in which you want to disable or enable sensors.


	
From the Settings menu, select Enable/Disable BPEL Business Monitoring. This selection is only displayed for composites that have at least one BPEL or BPMN service component, regardless of whether those components include sensors.

[image: Description of sca_sensordis.gif follows]




A dialog is invoked that displays the current status of sensors and enables you to change that status. The dialog only displays the options applicable to the component types present in the selected composite. For example, if the composite contains only BPEL components but not BPMN, you see only the option to set the status of BPEL sensors.

The following steps describe the types of dialogs that can be displayed and the available actions.

	
If sensors are disabled at both service engine levels, the message Disabled Globally is displayed for each. You cannot select Enable All or Disable All in this dialog. Both buttons are disabled.

[image: Description of sca_sensordis3.gif follows]




In addition, if sensors are disabled at the BPEL service engine level and the BPMN service engine does not appear because Oracle BPM Suite is not installed, you cannot select Enable All or Disable All in this dialog. Both buttons are disabled.

[image: Description of sca_sensordis8.gif follows]




	
If sensors are not disabled at the composite level, checkmarks are displayed. If sensors are also not disabled at both the BPEL and BPMN service engine levels, the message Disabled Globally does not display.

Click Disable All to disable all types of sensors defined for service components that comprise the selected composite. (If sensors are disabled at the service engine level, they remain disabled.)

[image: Description of sca_sensordis4.gif follows]




	
If sensors are disabled at a specific service engine level, the sensor status you set for those types of sensors at the composite application level only takes effect when the corresponding Disable BPEL Monitors and Sensors or Disable BPMN Measurements checkbox in the service engine Properties page is deselected.

For example, if sensors are disabled at the BPMN service engine level (as shown below), and you select Enable All for all sensors at the selected composite level, that status is only applied to other types of sensors, such as BPEL. BPMN sensors and monitors remain disabled. However, if you later change the BPMN service engine setting, BPMN sensors are automatically enabled in this composite.

[image: Description of sca_sensordis5.gif follows]




	
If sensors are disabled at the composite level, no checkmark is displayed. Click Enable All to enable all types of sensors defined for service components that comprise the selected composite. (Sensors disabled at the service engine level remain disabled until you change the service engine level setting.) Note that because the composite does not include BPMN service components, BPMN is not displayed.

[image: Description of sca_sensordis7.gif follows]









After you select an action, an inline message is displayed in the page confirming that sensors were enabled or disabled.

For more information about BPEL sensors and monitors, see Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite.

For more information about BPMN measurements, see Oracle Fusion Middleware Modeling and Implementation Guide for Oracle Business Process Management.
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20 Monitoring Human Workflow Service Components and Engines

This chapter describes how to monitor human task service components and the human workflow service engine.

This chapter includes the following topics:

	
Section 20.1, "Monitoring Human Task Service Component Instances and Faults"


	
Section 20.2, "Viewing the Status of Human Workflow Tasks"


	
Section 20.3, "Monitoring Human Task Service Component Instances"


	
Section 20.4, "Monitoring Human Workflow Service Engine Instances and Faults"


	
Section 20.5, "Monitoring Human Workflow Service Engine Active Requests and Operation Statistics"


	
Section 20.6, "Monitoring Human Workflow Service Engine Instances"


	
Section 20.7, "Monitoring Deployed Human Workflows in the Service Engine"




For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.2.6, "Introduction to Service Engines"






20.1 Monitoring Human Task Service Component Instances and Faults

You can monitor recent instances and faults for human task service components. Each service component in a SOA composite application has its own instance ID. These IDs are different from the overall instance ID of the SOA composite application of which each service component is a part.

To monitor human task service component instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application.









	
Select the human task service component in the Component Metrics table.

The upper part of the Dashboard page displays the following details:

	
Recent instances of the human task service component, including the instance ID of the service component, the state of the instance (for example, completed or running), the instance start time, the last modification time, and links to log files describing the instances.


	
Recent faults in the human task service component, including the error message, whether the fault is recoverable, the time at which the fault occurred, the instance ID of the human task service component, and links to log files describing the faults.




[image: Description of hwf_comp_dash_upper.gif follows]




	
In the Recent Instances section, perform the following tasks:

	
In the Instance ID column, click an instance ID for a service component to monitor the current status of a task on which approval actions are being taken.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All below the section to access the Instances page of the service component.





	
In the Recent Faults section, perform the following tasks:

	
In the Error Message column, click an error message to display complete information about the fault. If the fault is identified as recoverable, click the Recover Now link to perform fault recovery.


	
In the Recovery column, click a fault identified as Recoverable to perform fault recovery at the component instance level.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All below the section to access the Faults page of the service component.




The lower part of the Dashboard page displays the following details:

	
A graphical representation of business outcomes.


	
Assignees that take the longest time to respond to and act upon tasks.


	
The number of successful, faulted, and instantiated instances processed per minute. Click Table View to display throughput details for the last five minutes, including the throughput for successful instances, the total faults throughput, and the instance throughput.


	
The notification channels used for task approval in the human task service component.




[image: Description of hwf_comp_dash_lower.gif follows]






For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances" and Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files.






20.2 Viewing the Status of Human Workflow Tasks

You can monitor the current status of human workflow tasks being acted upon by participants.

To view the status of human workflow tasks:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application.









	
Select the human task service component in the Component Metrics table.

The Dashboard page appears.

[image: Description of hwf_comp_dash_upper.gif follows]




	
In the Instance ID column, click an instance ID of a service component to monitor the current status of a task on which approval actions are being taken.

The Task Details page displays the following details:

	
Task details about the selected service component instance ID (task number), including the current state (for example, assigned), task outcome (if completed), task priority, creation date, updated date, expiration date, and task assignee.


	
A flow of the current status of a task (for example, assigned or approved).




[image: Description of hwf_mon_taskdetails.gif follows]




As the task is acted upon by participants, the flow is updated.

[image: Description of hwf_mon_taskdetails2.gif follows]




	
In the upper right-hand corner of the page, click Worklist Application to access the login page for Oracle BPM Worklist.




For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances."






20.3 Monitoring Human Task Service Component Instances

You can monitor human task service component instances. Each service component has its own unique instance ID. This ID is in addition to the instance ID of the overall SOA composite application of which this service component is a part.




	
Note:

Human workflow invocations from the BPEL service engine use different transactions than BPEL processes. Therefore, if a BPEL transaction is rolled back for any reason, the workflow task instances are still created.







To monitor human task service component instances:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application.









	
Select the human task service component in the Component Metrics table.


	
Click Instances.

The Instances page displays the following details:

	
A utility for searching for a specific human task service component instance by specifying criteria and clicking Search.


	
Instances, including the instance ID of the service component, the state of the instance (for example, completed successfully or faulted), the instance start time, the last modification time, and links to log files describing the instance.




[image: Description of hwf_comp_instances.gif follows]




	
In the Instance ID column, click a specific ID for a service component to monitor the current status of a task on which approval actions are being taken.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.




For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances" and Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files.






20.4 Monitoring Human Workflow Service Engine Instances and Faults

You can monitor instances and faults of all human task service component instances running in the human workflow service engine. These human task service components can be part of separate SOA composite applications.

To monitor human workflow service engine instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Service Engines > Human Workflow.


	
	Right-click soa-infra.
	
Select Service Engines > Human Workflow.











	
Click Dashboard.

The upper part of the Dashboard page displays the following details:

	
Recent instances of all human task service components running in the human workflow service engine, including the instance ID of the service component, the service component, the SOA composite application of which the service component is a part, the state of the instance (for example, completed, running, or faulted), the instance start time, and the last modification time.


	
Service components, including the service component name, SOA composite application, state of the service component, and total, running, and faulted instances.




[image: Description of hwf_se_dash_upper.gif follows]




	
In the Recent Instances section, perform the following tasks:

	
In the Instance ID column, click an instance ID for a service component to monitor the current status of a task on which approval actions are being taken.


	
In the Component column, click a specific service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All below the section to access the Instances page of the service engine.





	
In the Components section, perform the following tasks:

	
In the Name column, click a specific service component to access its home page.


	
In the Composite columns, click a specific SOA composite application to access its home page.


	
Click Show All below the section to access the Deployed Components page of the service engine.




The lower part of the Dashboard page displays the following details:

	
Recent faults, including the error message, the time at which the fault occurred, the SOA composite application, the service component, and the service component instance ID.


	
Task assignees who take the longest time to act upon a task and who have the highest backlog of pending tasks to which to respond.




[image: Description of hwf_se_dash_lower.gif follows]




	
In the Recent Faults section, perform the following additional tasks:

	
In the Error Message column, click an error message to display complete information about the fault. If the fault is identified as recoverable, click the Recover Now link to perform fault recovery. Clicking this link invokes the human workflow audit trail page for the instance. The audit trail page has a link to Oracle BPM Worklist called Go to Worklist Application, where you can go to recover from the fault. This link does not take you directly to the fault; you must manually locate the fault.


	
In the Recovery column, click a fault identified as Recoverable to perform fault recovery at the component instance level.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.


	
Click Show All below the section to access the Faults page of the service engine.












20.5 Monitoring Human Workflow Service Engine Active Requests and Operation Statistics

You can view details about active requests in the human workflow service engine and operational statistics. such as service used, operations performed, and active and completed requests.

To monitor human workflow service engine active requests and operation statistics:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Service Engines > Human Workflow.


	
	Right-click soa-infra.
	
Select Service Engines > Human Workflow.











	
Click Statistics.

The Statistics page displays the following details:

	
Active requests in the service engine. Use this graph to get an idea of the current service engine load. Only under extreme load conditions is there data shown in the graph. This is because most requests are processed instantaneously by the service engine. The data is collected by a Dynamic Monitoring Service (DMS) state sensor. Once the requests are processed by the service engine, the count goes to zero. This action enables you to know the current load on the service engine (for example, if it is too high).


	
Average request message processing time in the service engine since the last startup of the SOA Infrastructure. Use this graph to check service engine performance. Note that while the processing time is calculated based on the last startup of the SOA Infrastructure, the data that is displayed in the graph is gathered only from the time at which you first accessed this page. The graph does not continue calculating and displaying data if you have not accessed this page. The DMS phase event sensor calculates the average request processing time and provides the processing time data.


	
Operation statistics about human workflow services used in the service engine, including the human workflow service used, the operation performed by the service, the number of active and completed requests, the count, and the average processing time.




[image: Description of hwf_se_stats.gif follows]




For more information, see the following documentation:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite for details about human workflow services and operations












20.6 Monitoring Human Workflow Service Engine Instances

You can monitor all human task service component instances running in the service engine. These human task service components can be part of separate SOA composite applications.

To monitor human workflow service engine instances:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Service Engines > Human Workflow.


	
	Right-click soa-infra.
	
Select Service Engines > Human Workflow.











	
Click Instances.

The Instances page displays the following details:

	
A utility for searching for a specific instance by specifying criteria and clicking Search.


	
Instances, including the instance ID of the service component, the service component, the SOA composite application of which the service component is a part, the state of the instance (for example, completed, running, or faulted), the instance start time, the last modification time, and links to log files that describe the instance.




[image: Description of hwf_se_instances.gif follows]




	
In the Instances section, perform the following additional tasks:

	
In the Instance ID column, click an instance ID for a service component to monitor the current status of a task on which approval actions are being taken.


	
In the Component column, click a specific service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Logs column, click a specific log to access the Log Messages page with filtered messages specific to that instance.







For more information, see Section 1.2.3, "Introduction to SOA Composite Application Instances" and Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files.






20.7 Monitoring Deployed Human Workflows in the Service Engine

You can monitor all deployed SOA composite applications with human task service components running in the service engine.

To monitor deployed human workflows in service engines:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Service Engines > Human Workflow.


	
	Right-click soa-infra.
	
Select Service Engines > Human Workflow.











	
Click Deployed Components.

The Deployed Components page displays the following details:

	
A utility for searching for a specific deployed SOA composite application by specifying the full name and clicking Search.


	
Details about deployed human task service components running in this service engine, including the service component name, the SOA composite application, the current status, and the number of total, faulted, and running instances.




[image: Description of hwf_se_deployedcomps1.gif follows]




	
In the Name column, click a specific service component to access its home page.


	
In the Composite column, click a specific SOA composite application to access its home page.
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Part IX



  Administering Oracle Business Activity Monitoring

This part describes how to administer Oracle Business Activity Monitoring.

This part includes the following chapters:

	
Chapter 22, "Configuring Oracle Business Activity Monitoring"


	
Chapter 23, "Monitoring Oracle Business Activity Monitoring"


	
Chapter 24, "Managing Oracle Business Activity Monitoring"






The image shows the Oracle BAM Web application home page in Oracle Enterprise Manager Fusion Middleware Control Console. The left side of the page shows the navigation pane. The right side of the page shows Oracle BAM Report Server statistics.


The image shows four tabs at the top from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages (selected). Below this is the Search section, with fields for Error Message Contains, Fault ID, Name, Fault Time From, Fault Time To, Composite Instance ID, and Composite Name. Search and Reset buttons appear on the right side of the page.

Below this is the Show only re cove able faults checkbox and the Fault Types list. All Faults is selected in this list.

Below this are the Select list, View list, Recovery Actions list, and Delete Rejected Messages button. Below this is a table with the following columns: Error Message, Recovery, Fault Time, Composite, Fault Location, Composite Instance ID, and Logs.


The image shows the web service page displaying the following tabs: Dashboard, Policies, Faults and Rejected Messages, and Properties. The Properties tab is selected and shows the following fields: REST Enabled, WSDL Enabled, Metadata Exchange Enabled, Endpoint Test Enabled, Logging Level, Schema Validation, Atomic Transaction Version, Atomic Transaction Flow Option, Maximum Request Size, and Unit of Maximum Request Size. The Apply and Revert buttons appear at the top right of the tab.


The image shows the Logs Levels page. There are two tabs that display at the top from left to right: Log levels (selected) and Log Files. Below this is a description of what you can accomplish on this page. Below this is a View list, with Runtime Loggers selected. Below this is a Search list with All Categories selected. Below this is a table with the following columns from left to right: Logger Name, Oracle Diagnostic Logging Level (Java Level), Log File, and Persistent Log Level State.


This image shows an audit trail with an if condition.


The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are four tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies (selected). Below this are the View list and Attach/Detach To list. Below this is a table with the following columns from left to right: Policy Name, Attached To, Policy Reference Status, Category, Total Violations, and Authentication.


This graphic shows an instance page. There are three tabs: Audit trail, Flow, and Faults. The Audit Trail page is selected. It contains the following columns: Activity, Loop Count Event, Date, and Copy. These columns are explained in the text.


The image shows the Subscriptions page. The following tabs appear at the top from left to right: Events, Subscriptions (selected), and Faults. Below this is the Search section, with fields for Subscription Type, Event Namespace, Event Name, Subscriber, Consistency Level, and XPath Filter. The Search and Reset buttons display on the right. Below this is the Database Subscriptions section. This section includes the View drop-down list, Create Database Agent icon, Edit Database Agent icon, Delete Database Agent icon, and Manage Database Agents button.

Below this is a table with the following columns from left to right: Event Name, Namespace, Subscription - Database Agent, XPath Filter, Consistency Level, and Failed Deliveries. Below this is the Component Subscriptions section. This section includes a View drop-down list and a table with the following columns from left to right: Event Name, Namespace, Subscription Component, Composite, XPath Filter, Consistency Level, and Failed Deliveries.


The image shows four tabs at the top from left to right: Dashboard, Deployed Composites (selected), Instances, and Faults and Rejected Messages. Below this is the Search field. Search and Reset buttons appear on the right side of the page. Below this are the View, Start Up, Activate, Set As Default, Deploy, Undeploy, and Redeploy buttons. Below this is a table with the following columns: Composite, Partition, Status, Mode, Instances, Faults, and Last Modified Date.


The image shows the BAM Server menu with the following menu items: Home, Monitoring, Control, Logs, BAM Server Properties, Security, System MBean Browser, and General Information. The System MBean Browser menu item is selected.


The image shows the Email Driver Properties page. In the upper left section is the Common Configuration section, which includes a Supported Delivery Types label, Capability label, Cost drop-down list, Speed drop-down list, Sender Addresses field, and Default Sender Address field. To the right are the Supported Protocols field, Supported Carriers field, Supported Content Types label, Supported Status Types label, and Sending Queues Info label.

Below this section is the Driver-Specific Configuration section, which includes a table with the following columns from left to right: Name, Description, Mandatory, Encoded Credential, and Value. Two properties that you can set in the Value column are displaying in the Name column: MailAccessProtocol and RetryLimit.


The image shows the Edit Function dialog. The title field is displayed at the top. To the right are the Add, Remove, Move Up, and Move Down buttons. In the lower left is the Examples table, which includes an example of how to use this function.


The image shows the Outbound Connection Groups with the oracle.bam.adapter.adc.soap.SOAPConnectionFactory radio button selected. The Back, Next, Finish, and Cancel buttons appear at the bottom.


The images shows the BAM Web drop-down menu for the Oracle BAM Web Properties page in Fusion Middleware Control. The following menu items are available: Home, Monitoring, Control, Logs, BAM Web Properties (selected), System MBean Browser, and General Information.


This figure displays how to invoke a test instance of the composite.


The image shows the Log Files page showing the available logs for Oracle BAM as a table with the following columns: Name, Directory, Log Type, Last Modified, and Size.


The image shows the User Messaging Preferences screen displaying the following tabs: Messaging Channels and Messaging Filters. The Messaging Filters tab is selected. The first area of the tab shows the following fields: Filter Name and Description. The second area of the tab shows the Condition as a table with the following columns: Attribute, Operator, Value, Value2 (if required), and Delete.

The third area of the tab shows the Action as a table with the following columns: Channel, Address, Up, Down, and Delete. The OK and Cancel buttons appear at the top right of the tab.


The image shows the General Information dialog box displaying the following fields: Target Name, Version, Oracle Home, and Host. The OK and Cancel buttons appear at the bottom right of the dialog box.


This image is described in the surrounding text.


The image shows the Farm_base_domain node expanded to show the following nodes: Application Deployments, SOA, WebLogic Domain, BAM, Metadata Repositories, and User Messaging Service. The User Messaging Service node is expanded and the usermessagingdriver-email sub-node is selected.


The image shows the Dashboard page for the B2B_Send_ebMS_PO (B2B) reference binding component. The following areas are displayed: Instances and Faults, which is a graph showing time on the x-axis (12:59 PM through 01:19) and number of messages on the y-axis (0 through 40); Top 5 Recently Active Trading Partners; and Recent Faults. The fields in these areas are described in the surrounding text.


The image shows four tabs at the top from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages. Below this is the Search field. Search and Reset buttons appear on the right side of the page. Below this are the View, Start Up, Activate, Set As Default, Deploy, Undeploy, and Redeploy buttons. Below this is a table with the following columns: Composite, Partition, Status, Mode, Instances, Faults, and Last Modified Date.


The image shows the Oracle BAM Administrator Distribution List management page. The left side of the page shows a list of Distribution Lists. The right side of the page shows the distribution list information for myDistList including the Distribution List Name, Distribution List Members, and Last Modified date and time.


The image shows the Oracle BAM Administrator displaying example user information, and the mouse is positioned over the Reassign Ownership link at the top of the page.


The image shows the Outbound Connection Pool Configuration Table and the oracle.bam.adapter.adc.soap.SOAPConnectionFactory. The New and Delete buttons appear above and below the table.


The image shows the two tabs at the top from left to right: Services (selected) and References. Below this is a View list. Below this is a table consisting of the following columns from left to right: Service, Type, Composite, Partition, Total Messages, Average Processing Time (sec), and Faults.


The image shows the Delete: Rejected Messages dialog. Below this is a description of the page. Below this is the Common Delete Options radio button (selected). Below this is the Preset Batches list, with a value of Older than 24 Hours selected. Below this is the Delete All radio button. This deletes all rejected messages of this composite.

Below this is a Delete All Rejected Messages That Match These Criteria radio button. Below this are fields for Start Time From and Start Time To. In the lower right are Delete and Cancel buttons.


This image shows the Create New SOA Partition dialog. The Name field is displayed. Help, Create, and Cancel buttons display at the bottom.


This image is described in the surrounding text.


The image shows the following tabs from left to right: Dashboard, Instances (selected), Faults and Rejected Messages, Unit Tests, and Policies. Below this is a Search section, with fields for Instance ID, Name, Conversation ID, Start Time From, Start Time To, CustomerDetails, NameSensor, Datesensor, and Yearsensor. Search and Reset buttons and the Add Fields list appear on the right.

Below this is the Show menu, with a value of Any selected. Below this are the View list, and Delete Selected, Delete with Options, and Abort buttons.

Below this is a table with the following columns from left to right: Instance ID, Name, Conversation ID, State, Composite Sensors, Start Time, and Logs.


The image shows the Performance Summary for the usermessagingserver as a graph. The Show Metric Palette button appears above the graph.


The image shows the Oracle BAM start page with login fields displayed. In the Sign In box there are two fields: User name and Password. A Go button is located to the right of the Password field for submitting the credentials to the Oracle BAM Server.


The image shows the OracleRules1 (Decision Service Component) page which displays the following tabs: Dashboard, Instances, Faults and Policies. The Dashboard tab is selected. The first section of the page shows the Recent Instances as a table with the following columns: Instance ID, State, Start Date, Last Modified Date, and Logs. The second section of the page shows the Recent Faults as a table with the following columns: Error Message, Fault Time, Component Instance ID, and Logs.

The final section of the page shows the Instance Rate per Min (Real-Time Data). The top right of the page shows the Related Links drop-down menu.


The image shows the Oracle BAM Administrator function drop-down list displaying the following items: User management, Roles management, and Distribution List management (selected).


The image shows the Instances tab of the Mediator Component Home page. The Search section lets you enter the following details to search for particular Mediator instances: Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State. The View section displays the following information for the instances meeting the specified criteria, from left to right: Instance ID, State, Start Date, Last Modified Date, Source, and Logs.


The image shows the deployed Java EE applications under the Application Deployments folder. The Internal Applications and Resource Adapters subfolders have also been expanded. Internal Applications displays the components such as Oracle B2B. Resource Adapters displays the JCA Adapters. Other applications such as worklistapp display at the top level Application Deployments folder.


The image shows the organizational hierarchy of the demo users. The image is described in the table immediately above the image.


The image shows the Metrics Palette expanded to show the options for the usermessagingserver.


The image shows the UMS architecture diagram connecting the WebLogic Server Web Center Instance and WebLogic Server SOA Instance.


The image shows the Workflow Notification Properties screen. The first area of the screen shows the Notification Mode drop-down list with NONE chosen. The second area of the screen shows the Notification Service with the following fields: Email From Address, Email Actionable Address, and Email Reply To Address. The Apply and Revert buttons appear at the top right of the screen.


The image shows the Create a New Authentication Provider page. The first area of the page. The first area shows the Name field. The second area shows the Type drop-down list. Above and below the two fields are the OK and Cancel buttons.


The image shows the Faults tab of the Mediator Instance Details page of a Mediator component instance, after clicking on the fault that occurred to the Mediator component instance. The upper pane displays details of the occurred fault and the lower pane displays the XML representation of the payload.


The image shows the B2B Infrastructure (SOA Binding) page, with a drop-down list of Related Links. The links are SOA Infra Home, B2B Server Properties, B2B Console, and WebLogic Server Console.


The image shows the Oracle Enterprise Manager Select Archive screen. The first area of the screen shows the Archive and Exploded Directory settings with the following radio button selected: Archive or exploded directory is on the server where Enterprise Manager is running. The second area of the screen shows the Deployment Plan settings with the following radio button selected: Deployment plan is on the server where Enterprise Manager is running.


The upper half of the Dashboard page. This illustration is described in the text.


The image shows the Sensor Values page. At the top are the following tabs from left to right: Audit Trail, Flow, Sensor Values (selected), and Faults. Below this is the Activity Sensors section, which includes a table with the following columns from left to right: Sensor and Activity. Below this is the Variable Sensors section, which includes a table with the following columns from left to right: Sensor and Variable.

Below this is the Fault Sensors section, which includes a table with the following columns from left to right: Sensor and Fault. Below this is the Sensor Values section, which includes a table with the following columns from left to right: Sensor and Value.


The image shows the Policies page. At the top are the following tabs from left to right: Dashboard, Instances, Faults, Policies (selected), and Administration. Below this is the View drop-down list and Attach/Detach button. Below this is a table with the following columns from left to right: Policy Name, Policy Reference Status, Category, Total Violations, Authentication, Authorization, and Confidentiality. These last three columns are part of a larger column header entitled Security Violations.


The image shows the JNDI Name field. The Back, Next, Finish, and Cancel buttons appear at the bottom.


The image shows the context menu for the OracleBamWeb node. The following menu items are available: Home, Monitoring, Control, Logs, BAM Web Properties, System MBean Browser, and General Information. The Logs menu item is expanded to show the following sub-menu items: View Log Messages and Log Configuration (selected).


The image shows the Policies tab of the Mediator Component Home page. You can view the following details of the policies associated with a Mediator component, from left to right: Policy Name, Policy Reference Status, Category, Authentication, Security Violations, and Integrity.

You can also attach or detach policies from this page by clicking Attach/Detach to the right of the View menu.


The image shows Oracle BAM Server context menu showing the following menu items: Home, Monitoring, Control, Logs, BAM Server Properties, Security, System MBean Browser, and General Information. The Control menu item is expanded and shows the following sub-menu items: Start Up and Shut Down (selected).


The image shows a deployed Java EE application. The Summary section appears in the upper left section. Below this is the General section with details about the state and the location of the deployment. Below this is the Servlets and JSPs section with details about active sessions, request processing times, and requests per minute. Below this is the Work Manager section with details about requests per minute and pending requests. Below this is the Entry Points section. This section includes subsections about Web Modules and Web Services.

The Web Modules section includes columns for Name and Test Point. The Web Services section includes columns for Service Name, Port, and Test. In the upper right part of the page is the Modules section, which includes details about Module Name and Module Type. Below this is the Response and Load section, which includes a graph describing request processing times (in milliseconds) and requests per minute.


The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Statistics tab is selected. The first section of the page shows the Average Request Processing Time as a graph. The second section of the page shows the Business Rules Cache Statistics as a table with the following columns: Cache Name, Object Count, and Object Access Count.

The third section of the page shows the Business Rules Operation Statistics as a table with the following columns: Operation Name, Count, and Average (in milliseconds). The Related Links drop-down menu appears at the top right of the page.


The image shows the information screen for a group, and includes the Group, Attributes, Subtree Access, and Local Access tabs. The Group tab is selected. The first area of the screen shows the following non-editable fields: Distinguished Name, Created by, Created at, Modified by, and Modified at. The Group tab shows the following fields: Owner, Description, and Members. Each field shows plus and minus buttons. At the top right of the screen are the Apply and Revert buttons.


This image is described in the surrounding text.


The image shows the Dashboard page of the BPEL service engine. The following tabs display at the top from left to right: Dashboard (selected), Statistics, Instances, Faults, Deployed Components, and Recovery. Below this is the Components section, which includes a table with the following columns from left to right: Name, Composite, Status, Total Instances, Running Instances, and Faulted Instances - Non Recoverable).

Below this is the Recent Faults section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Recovery, Fault Time, Composite, Component, Component Instance ID, Activity, and Logs.


The image shows the Flow Trace page. Below this is the Faults section (currently closed). Below this is the Sensors section, which includes a table that consists of the following columns from left to right: Composite Instances, Name, Value, Location, and Action. Below this is the Trace section, which includes a table that consists of the following columns from left to right: Instance, Type, State, Time, and Composite Instance.


The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are the following tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, and a table consisting of the following columns from left to right: Instance ID, Name, Conversation ID, State, and Start Time.

Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.


This image shows the Services tab (selected) and the References tab. Below this are the Actions list and View list. The Publish To UDDI option is being selected from the Actions list. Below this is a table with the following columns from left to right: name, Type, Composite, Partition, Total Messages, and Average Processing Time.


The image shows the Oracle BAM Server page displaying the following tabs: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. The Event Engine tab is selected and the page shows the following information: General, Rule Fire Rate Per Second, and Processing Queues Sizes.


This image is described in the text immediately above the image.


The image shows the Routing Statistics section of the Dashboard tab of the Mediator Component Home page. It displays the following data: Number of Successfully Processed Messages, Number of Faulted Messages, Number of Incoming Messages, Average Processing Time for Successful Messages, and Average Processing Time for Faulted Messages.


The image shows the error message window that appears when you click an error message from the Error Message column and click Recover Now....


The image shows the OK, Validate, and Cancel buttons in the upper right corner. Below this is the Attached Policies table, with the following columns left to right: Policy Name, Category, Enabled, Description, and View Full Description. The attached policies display in this table.


The image shows a graphical representation of a SOA composite application.


This illustration is described in the text.


This figure displays how to set the audit levels for a SOA composite.


The image shows the Log Messages screen for usermessagingdriver-xmpp. The first area of the screen shows the Search settings including the following fields: Date Range, Time Interval (Start Date, End Date, Start Time, End Time), Message Types (Incident Error, Error, Warning, Notification, Trace, and Unknown), and Maximum Rows Displayed. The first area also shows the Search and Add Fields buttons.

The second area of the screen shows the log messages as a table with the following columns: Incident Errors, Errors, Warnings, Notifications, Traces, Unknowns, and Log File. The Broaden Target Scope drop-down menu and Log Files button appear at the top of the screen.


The image shows the Assertion details for Simple Assertions section. The Show failure only checkbox appears. Below this is a table with the following columns from left to right: Composite Instance, Location, Type, Status, Expected Value, Actual Value, Description, and Error Message.


The image shows the Select Distinguished Name (DN) Path dialog box. The dialog box shows an expanded hierarchy of distinguished names with the cn=Users entry selected. At the bottom right of the dialog box are the Select and Cancel buttons.


The image shows a human workflow component. At the top are the following tabs from left to right: Dashboard, Instances, Faults, Policies, and Administration. Below this is a Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, and Modified Date To. A State list also appears.

Below this is a table with the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs.


This image is described in the following text.


This image is described in the text immediately above.


The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected), Statistics, Instances, Faults, Deployed Components, and Notification Management. Below this is the Recent Instances section, which includes a Show Only Running Instances checkbox, and a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.

Below this is the Components section, which includes a table with the following columns from left to right: Name, Composite, Status, Total Instances, Running Instances, and Faulted Instances - Recoverable and Non Recoverable.


This image is described in the text immediately above the image.


The image shows the Settings for oracle.bam.adapter.adc.soap.SOAPConnectionFactory page displaying the following tabs: General, Properties, Transaction, Authentication, Connection Pool, and Logging. The Properties tab is selected and the page shows the Outbound Connection Properties as a table with the following columns: Property Name, Property Type, and Property Value. The Save button appears above and below the table.


The image shows Oracle BAM nodes in the BAM folder in the Oracle Enterprise Manager Fusion Middleware Control navigation tree.


The image shows the Credential Mappings tab selected in the Settings for OracleBamAdapter page.


The image shows the Request Breakdown section of the Statistics tab of the Mediator Component Home page. You can click the Help icon on the top right corner of the section to know more details about this section.


This image shows the Activity Time Distribution table, which includes, from left to right, the Name column, Count column, and the Average Execution Time (ms) column.


The image shows the Flow Trace page. The Faults section includes a table that consists of the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, and Composite Instance.

Below this is the Sensors section (currently closed). Below this is the Trace section, which includes a table that consists of the following columns from left to right: Instance, Type, Usage, State, Time, and Composite Instance.


The image shows the Recent Faults section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Composite, Component, Component Instance ID, and Logs.

Below this is the Users with Highest Backlog section, which includes a table with the following columns from left to right: Assignee, Average Time on Task (hour), Mean Deviation, and Pending Tasks.


The image shows the Log Configuration page displaying the following tabs: Log Levels and Log Files. The Log Levels tab is selected. The page shows the Runtime Loggers as a table with the following columns: Logger Name, Oracle Diagnostic Logging Level (Java Level), and Log File. The Apply and Revert buttons appear at the top right of the page.


This image shows the home page of a partition. The Composite Control and Deployment lists appear at the top. In the upper right is the Search field. Below this is a table with the following columns: Composite, Status, Mode, Instances Total, Instances Faulted, and Last Modified Date.


The image shows the eis/bam/rmi instance selected in the Outbound Connection Pool list.


The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Instances tab is selected. The first section of the page shows the Search settings and includes the following fields: Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State (a drop-down list). The first section also shows the Search and Reset buttons.

The second section of the page shows the search results as a table with the following columns: Instance ID, Component, Composite, State, and Start Date. The Related Links drop-down menu appears at the top right of the page.


This image shows the Manage Partitions page. A Search field is displayed in the upper right corner. Below this are the View list, Create Partitions button, Delete Partitions button, Composite Control list, and Deployment list.

Below this is a table with the following columns from left to right: SOA Partition, Active, Composites Retired, View, Instances Total, and Instances Faulted.


The image shows the Select Names dialog opened to display a list of the Oracle BAM users to whom the objects can be assigned.


The image shows the Statistics page of the human workflow service engine. The following tabs display at the top from left to right: Dashboard, Statistics (selected), Instances, Faults, Deployed Components, and Notification Management. Below this are the Active Requests and Average Request Processing Time graphs. Below this is the Operation Statistics section, which includes a table with the following columns from left to right: Service Name, Operation Name, Active Requests, Completed Requests, Count, and Average (ms).


The image shows the Outbound Connection Pool Configuration Table with the oracle.bam.adapter.adc.soap.SOAPConnectionFactory item expanded to show eis/bam/https and eis/bam/soap. The New and Delete buttons appear above the table.


The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected), Policies, Faults and Rejected Messages, and Properties. Below this is the Instances and Faults graph, which shows the total number of outgoing messages and faults since server startup. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox and a table that includes the following columns from left to right: Error Message, Fault Time, and Composite Instance ID.


The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected), Statistics, Instances, Faults, Deployed Components, and Recovery. Below this is the Recent Instances section, which includes a Show Only Running Instances checkbox, and a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.


The image shows the Application Policies page for oracle-bam(11.1.1). The Search area shows the data as a table with the following columns: Principal and Permission.


The image shows the Oracle BAM Administrator Distribution List management page. The left side of the page shows a list of Distribution Lists. The right side of the page shows the Distribution List Name field. The Create and Cancel buttons are below the field.


The image shows the Oracle Enterprise Manager. The left side of the screen shows the navigation pane with the usermessagingserver node selected. The right side of the screen shows the Log Configuration displaying the following tabs: Log Levels and Log Files. The Log Levels tab is selected and shows the search information as a table with the following columns: Logger Name, Oracle Diagnostic Logging Level (Java Level), Log File, and Persistent Log Level State.

The Apply and Revert buttons appear at the top right of the Log Configuration display.


The image shows the Settings for myrealm page displaying the following tabs: Users and Groups. The Groups tab is selected. The page shows a list of groups, with each entry showing the name, the description, and the provider. A checkbox appears to the left of each entry. Above and below the list are the New and Delete buttons.


The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Dashboard tab is selected. The first section of the page shows the Recent Instances as a table with the following columns: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs. The second section of the page shows the Components as a table with the following columns: Name, Composite, Status, Total Instances, Running Instances, and Faulted Instances (Recoverable and Non Recoverable).

The final section of the page shows the Recent Faults as a table with the following fields: Error Message, Fault Time Composite, Component, Component Instance ID, and Logs. The top right of the page shows the Related Links drop-down menu.


The image shows the Request Processing page. At the top is the Service Engines section, which includes a table consisting of the following columns from left to right: Name, Average Request Processing Time - Synchronous (ms), Average Request Processing Time - Asynchronous (ms), Active Requests, Requests Processed, and Faults.

Below this is the Service Infrastructure section, which includes a table consisting of the same columns as the Service Engines. Below this is the Binding Components section, which includes a table consisting of the following columns from left to right: Name, Average Request Processing Time (ms), Requests Processed, and Errors.


The image shows the Outbound Connection Pool Configuration Table with the oracle.bam.adapter.adc.soap.SOAPConnectionFactory item expanded to show eis/bam/soap. The New and Delete buttons appear above and below the table.


The image shows the BPEL service engine. At the top are the following tabs from left to right: Dashboard, Statistics, Instances (selected), Faults, Deployed Composites, and Recovery.

Below this is a Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and Component. A State list also appears. Search and Reset buttons appear below this.

Below this is a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.


The image shows the Faults tab for the ValidationRequestProcess BPEL component. The Related Links drop-down menu is expanded and shows the following menu items: SOA Infra Home and BPEL Engine Home.


graphic described in previous and following text.


This image shows from left to right the Dashboard, Policies, Faults, and Properties (selected) tabs. Below this are the General section and HTTP Basic Authentication section. Below this are the HTTP Chunking section and HTTP Proxy section. Below this is the HTTP Timeout section. Each section includes fields of appropriate properties.


The image shows the Instances page of the human workflow service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances (selected), Faults, Deployed Components, and Notification Management. Below this is the Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State. The Search and Reset buttons display to the right.

Below this is the View drop-down list and a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.


The image shows the Component Metrics table, which includes the following columns from left to right: Name, Component Type, Total Instances, Running Instances, Recoverable Faulted Instances, and Non Recoverable Fault Instances. Below this is the Services and References table, which includes the following columns from left to right: Name, Type, Usage, Faults, Total Messages, and Average Processing Time (sec).


The image shows the Component Metrics table, which includes the following columns from left to right: Name, Component Type, Total Instances, Running Instances, Recoverable Faulted Instances, and Non Recoverable Fault Instances. Below this is the Services and References table, which includes the following columns from left to right: Name, Type, Usage, Faults, Total Messages, and Average Processing Time (sec).


This illustration is described in the text.


The figure displays the Confirmation dialog.


The image shows the Dashboard page. At the top are the following tabs from left to right: Dashboard (selected), Instances, Faults, Policies, and Administration. Below this is the Recent Instances section, which includes a Show Only Running Instances checkbox and a table that consists of the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs. Below this is the Show All link. Below this is the Recent Faults section, which includes a Show only system faults checkbox and a table that consists of the following columns from left to right: Error Message, Recovery, Fault Time, Component Instance ID, Activity, and Logs.


The image shows the Log Files tab. A description of what you can do on this page appears below this tab. Below this are the Create, Create Like, Edit Configuration, and View Configuration buttons. Below this is a table with the following columns: Handler Name, Log Path, Log File Format, and Rotation Policy.


This illustration is described in the text.


The image shows the Policies page. At the top are the following tabs from left to right: Dashboard, Instances, Faults, and Policies (selected). Below this is the View drop-down list and Attach/Detach button. Below this is a table with the following columns from left to right: Policy Name, Policy Reference Status, Category, Total Violations, Authentication, Authorization, and Confidentiality. These last three columns are part of a larger column header entitled Security Violations.


Flow Trace page showing a runtime trail of a message flow identified by an execution context ID (ECID) that is displayed in the upper right corner of the page. There are two main sections: one for Faults, the other for Trace.


The image shows the soainfra node in the navigation pane, with the following subnodes: Application Deployments, SOA, WebLogic Domain, Metadata Repositories, and User Messaging Service. The SOA node is expanded to show the soa-infra(soa_server1) subnode.


The image shows the Settings for myrealm page displaying the following tabs: Users and Groups. The Users tab is selected. The page shows a list of users, with each entry showing the name, the description, and the provider. A checkbox appears to the left of each entry. Above and below the list are the New and Delete buttons.


The image shows the Oracle Enterprise Manager Fusion Middleware Control page. The navigation pane on the left shows the Farm_soainfra node expanded with the following subnodes: Application Deployments, Internal Applications, Resource Adapters, SOA, WebLogic Domain, WebLogic Repositories, and User Messaging Service. The SOA node is expanded to show the Project_ebMS_PO [1.0] subnode.

The Project_ebMS_PO [1.0] page on the right shows the following tabs: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. The Dashboard tab is selected. The first section of the Dashboard page shows the Recent Instances as a table, and includes the following columns: Instance ID, Conversation ID, Faults, and Start.

The second section of the Dashboard page shows the Recent Faults and Rejected Messages as a table, and includes the following columns: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs. The third section of the Dashboard page shows the Component Metrics as a table, and includes the following columns: Name, Component Type, Running Instances, and Total Instances. The fourth section shows the Services and References table with the following columns: Name, Type, Faults, Total Messages, Average Processing Time (secs).


The image shows the Dashboard page. At the top are the following tabs from left to right: Dashboard (selected), Instances, Faults, Policies. Below this is the Business Outcomes graph, which shows rejections and approvals. To the right is the Highest Time Consuming Assignees, which includes a table with the following columns from left to right: Assignee, Average Time on Task (sec), and Main Deviation.

Below these sections is the Instance Rate per Min (Real-Time Data) graph, which shows instance throughput details. Below this section is the Notifications section, which includes a table with the following columns from left to right: Channel Used and Count.


The image shows the Faults page. At the top are the following tabs from left to right: Dashboard, Instances, Faults (selected), and Policies. Below this is the Search section, with fields for Error Message Contains, Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. To the right are the Search and Reset buttons.

Below this is the Show only recoverable faults checkbox and the Fault Type drop-down list, in which All Faults is selected. Below this are the Select, View, and Recovery Actions drop-down lists. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Component Instance ID, Activity, and Logs.


The image shows the Deployed Components tab of the Mediator Service Engine Home page. The Search section lets you enter the following details to search for particular Mediator components: Name and Component Name. The View section that appears below, displays the following details of all the Mediator components meeting the particular criteria, from left to right: Name, Composite, Status, Total Instances, Running Instances, and Faulted Instances.


The image shows the context menu in the navigation pane displaying the following menu items: Home, Monitoring, Control, Logs, SOA Deployment, Service Engines, Bindings, Services and References, Business Events, SOA Administration, Security, Administration, and General Information. The Logs menu item is expanded and shows the following sub-menu items: View Log Messages and Log Configuration.


The image shows the SOA Infrastructure drop-down menu displaying the following menu items: Home, Monitoring, Logs, SOA Deployment, Manage Partitions, Service Engines, Bindings, Services and References, Business Events, SOA Administration, Security, Administration, and General Information.


The image shows the Oracle Enterprise Manager Deployment Settings screen. The first area of the screen shows the Deployment Settings and includes the following fields: Archive Type, Archive Location, Deployment Plan, Deployment Target, Application Name, Version, Context Root, and Deployment Mode. The second area of the screen shows the Deployment Tasks as a table with the following columns: Name, Go To Task, and Description. The Cancel, Back and Deploy buttons appear at the top right of the screen.


The image shows the System MBean Browser. On the left is the navigational tree. On the right is the ServerURL property. A description of this property is provided, as well as a field for changing the value.


The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Deployed Components tab is selected. The first section of the page shows the Search settings and includes the following fields: Name and Composite Name. The first section also shows the Search and Reset buttons.

The second section of the page shows the search results as a table with the following columns: Name, Composite, Status, Total Instances, Running Instances, and faulted Instances (Recoverable and Non Recoverable). The Related Links drop-down menu appears at the top right of the page.


The image shows the Task Details section. The first area of the section shows the following fields: Task Number, State, Outcome, Priority, Creator, Created Date, Updated Date, Expiration Date, Assignees, and Acquired By. The second area of the field shows onMessage expanded to show Initiated, Outcome Updated, and Completed.


This image is described in the table immediately above this image.


The image shows the Faults page. The following tabs display at the top from left to right: Audit Trail, Flow, Sensor Values, and Faults (selected). Below this is a table consisting of the following columns from left to right: Error Message, Recovery, Fault Time, and Activity.


The image shows the Instances page. At the top are the following tabs from left to right: Dashboard, Instances (selected), Faults, Policies, and Administration. Below this is the Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State.

Below this is the View drop-down list. Below this is a table with the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs.


The image shows the Faults page. At the top are the following tabs from left to right: Dashboard, Statistics, Instances, Faults (selected), Deployed Composites, and Recovery. Below this is the Search section, with fields for Error Message Contains, Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. To the right are the Search and Reset buttons. Below this is the Show only recoverable faults checkbox and Fault Type drop-down list, in which All Faults is selected. Below this are the Select, View, and Recovery Actions drop-down lists. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Composite, Component, and Component Instance ID.


The image shows the Request Breakdown section, which includes a table with the following columns from left to right: Name, Count, Min Request Processing Time (ms), Max Request Processing Time (ms), and Avg Request Processing Time (ms).


The image shows the Application Roles page displaying the Search data as a table with the following columns: Role Name and Members. The Report Architect entry is selected.


The image shows the Metrics context menu showing Help selected.


The image shows the Create Database Subscription dialog box. The first area of the dialog box shows the Event information including the following fields: Event Namespace and Event Name. The second area of the dialog box shows the Agent information with the Database Agent field. The third area of the dialog box shows the Subscription Properties with the following fields: Consistency Level and XPath Filter. The Help, Subscribe, and Cancel buttons appear at the bottom of the dialog box.

This dialog box does not appear for EDN - JMS.


The image shows the Oracle BAM nodes in the Oracle Enterprise Manager Fusion Middleware Control navigation tree. The Farm_soabam node is expanded to show the following nodes: Application Deployments, WebLogic Domain, BAM, Metadata Repositories, and User Messaging Service. The BAM node is further expanded to show the OracleBamServer and OracleBamWeb nodes.


The image shows the Create a New Security Credential Mapping page. The first area of the page shows the Back, Next, Finish, and Cancel buttons. The second area of the page shows the following fields: EIS User Name, EIS Password, and Confirm Password.


The image shows the Settings for the authentication provider page displaying the following tabs: Common and Provider Specific. The Common tab is selected. The main area of the page shows the following fields: Name (non-editable), Description (non-editable), Version (non-editable), and the Control Flag drop-down list. Above and below the four areas is the Save button.


The image shows the Messaging Client Applications screen for usermessagingserver, displaying the data as a table with the following columns: Name, Version, Client Type, Listener End Point, and Receiving Queues. The De-register button appears above the table.


The image shows the Instances page of the BPEL service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances (selected), Faults, Deployed Components, and Recovery. Below this is the Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, State, and Component. The Search and Reset buttons display to the right. Below this is the View drop-down list and a table with the following columns from left to right: Instance ID, Component, Composite, State, Start Date, Last Modified Date, and Logs.


The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are four tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests (selected), and Policies. Below this is the Search section, with fields for Test Run Name, Test Run ID, Composite Instance ID, Start Time, and End Time. The Search and Reset buttons appear in the lower right corner of this section.

Below this are the Test Cases and Test Runs (selected) sub-tabs. Below this is a table with the following columns left to right: Test Run Name, Test Run ID, Start Time, End Time, Status, and Success Rate.

Below this is the Results of Test Run section. In this section are statistics for Total, Running, Passed, Failed, Unknown, and Success Rate. A Refresh Test Status button appears to the right. Below this is a table consisting of the following columns: Test suits and test cases, and Status.


The image shows the Oracle Enterprise Manager. The left side of the screen shows the navigation pane with the usermessagingserver node selected. The right side of the screen shows the System MBean Browser. The left side of the System MBean Browser shows a navigation pane with the ComponentAdministration bean selected. The right side of the System MBean Browser shows the listDriverInstances operation details and return values.


The image shows a portion of the settings for OracleBamAdapter page. The Properties sub-tab is selected.


This graphic shows the Advanced properties separated into the following sub-areas: Data Sources and Web Service Binding Properties. The Data Sources sub-area shows the following information: Server Data Source JNDI, Server Transaction Data Source JNDI, and the Nonfatal Connection Retry Count field. The Web Service Binding Properties sub-area shows the following fields: Oracle SSL Ciphers, Oracle Wallet Password, Use chunking (a checkbox), and Chunk Size.


The image shows the Log Configuration page displaying the following tabs: Log Levels and Log Files. The Log Levels tab is selected and the page shows the Runtime Loggers with the Logger Name and Oracle Diagnostic Logging Level (Java Level). The Oracle Diagnostic Logging Level drop-down list is selected showing the selection of levels.


The image shows onMessage expanded to show onCase "SAP.Write" highlighting four errors, all displaying the following error message: "Error during invoking 1-way operation "Write" on target service "SAP".


This image is described in the text immediately above the image.


The image shows the Incoming Notifications section, which includes a Search section with fields for Sender, Date From, Channel, Recipient, and Date To. Below this are the Select and View drop-down lists, the Mark as Spam button, Not Spam button, and Delete button. Below this is a table with the following columns from left to right: Message ID, Channel, Sender, Recipient, Status, Content, and Time.


The image shows the Oracle BAM Server Properties page in Fusion Middleware Control. The first area of the page shows the Data Source JNDI field. The second area of the page shows the Advanced settings including the following fields: Application URL, Viewset Sharing, Report Cache Persistence Manager, ODI User, ODI Password, ODI Work Repository Name, ODI Agent Host, ODI Agent Port, and Outbound Email account.


The image shows the following tabs from left to right: Dashboard, Instances (selected), Faults and Rejected Messages, Unit Tests, and Policies. Below this is a Search section, with fields for Instance ID, Name, ECID, Conversation ID, Start Time From, and Start Time To. Search and Reset buttons appear on the right.

Below this is the Show menu, with a value of Any selected. Below this are the View list, and Delete Selected, Delete with Options, and Abort buttons.

Below this is a table with the following columns from left to right: Instance ID, Name, Conversation ID, State, Start Time, and Logs.


The image shows the SOA Infrastructure drop-down menu displaying the following menu items: Home, Monitoring, Logs, SOA Deployment, Manage Partitions, Service Engines, Bindings, Services and References, Business Events, SOA Administration, Security, Administration, and General Information.


The image shows the Business Rules Engine page which displays the following tabs: Dashboard, Statistics, Instances, Faults, and Deployed Components. The Faults tab is selected. The first section of the page shows the Search settings and includes the following fields: Error Message Contains, Fault ID, Fault Time From, Fault Time To, Composite Instance ID, Component Instance ID, and Fault Type (a drop-down list). The first area also shows the Search and Reset buttons.

The second section of the page shows the search results as a table with the following columns: Error Message, Fault Time, Composite, Component, Component Instance ID, and Logs. The Related Links drop-down menu appears at the top right of the page.


The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are four tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies (selected). Below this are the View list and Attach/Death To list. Below this is a table with the following columns from left to right: Policy Name, Attached To, Policy Reference Status, Category, Total Violations, and Authentication. The currently attached policies display in this table.


The image shows the View Log File screen for the soa_server1-diagnostic.log file. The first area of the screen shows the Download button. The second area of the screen shows the following fields: Date Range, Start Date, and End Date. The second area also shows the Search button.

The third area of the screen shows the search results as a table with the following columns: Time, Message Type, Message ID, and Message. The fourth area of the screen shows the error message details including the following fields: Message ID, Message Level, ECID, Relationship ID, Component, and Message.


The image shows the Notification Management page. At the top are the following tabs from left to right: Dashboard, Statistics, Instances, Faults, Deployed Components, and Notification Management (selected). Below this is the Outgoing Notifications section, which includes a Search section with fields (when expanded) for Channel, Date From, Recipient, Status, and Date To.

Below this are the Select and View drop-down lists, the Resend button, Resend All Similar Notifications button, View Bad Addresses button, and Delete button. Below this is a table with the following columns from left to right: Source ID, Source Type, Channel, Recipient, Status, and Time.


The image shows the SOA Composite drop-down menu displaying the following menu items: Home, Monitoring, SOA Deployment, Export, Test Service, Unit Tests, Policies, SOA Infrastructure, SOA Infrastructure Common Properties, Service/Reference Properties, and General Information.


The image shows the BPEL Message Recovery Required message and icon displayed in the Trace table. The Show Details button displays to the right of the message.


The image shows the Oracle Enterprise Manager Fusion Middleware Control. The navigation pane on the left shows the soa_soainfra node expanded with the following subnodes: Application Deployments, SOA Composite Deployments, and Fusion Middleware.

The Fusion Middleware node is expanded to show the soa-infra(server_soa) subnode, which is selected. The B2B_EDI_X12 [1.0] page on the right shows the following tabs: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. The Instances tab is selected. The first section of the Instances page shows the Search criteria, and includes the following fields: Instance ID, Conversation ID, Start Time From, and Start Time To. The first section also shows the Search and Reset buttons.

The second section of the Instances page shows the search results as a table, and includes the following columns: Instance ID, Conversation ID, State, Faults, Start Time, and Logs.


The image shows the home page of the SOA Infrastructure. At the top are the following tabs from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, and a table consisting of the following columns from left to right: Instance ID, Composite, and Start Time.

To the right is the Deployed Composites table consisting of the following columns from left to right: Composite, Status, Mode, and Faulted Instances. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Composite, Fault Location, and Composite Instance.


The image shows the Log Messages screen for usermessagingserver. The first area of the screen shows the Search settings including the following fields: Date Range, Start Date, End Date, Message Types (Incident Error, Error, Warning, Notification, Trace, and Unknown), and Message. The first area also shows the Search and Add Fields buttons.

The second area of the screen shows the log messages as a table with the following columns: Time, Message Type, Message ID, Message, and Log File. The third area of the screen shows message details including the following fields: Message ID, Message Level, Relationship ID, Argument 1, Component, Module, Message, Host, Host IP Address, User, Thread ID, and ECID.

The Broaden Target Scope drop-down menu and Log Files button appear at the top of the screen.


The image shows the Workflow Task Service Properties screen. The first area of the screen shows the following fields: Actionable Email Account, Workflow Service Session Timeout (in minutes), and Workflow Custom Classpath URL. The second area of the screen shows the Dynamic Assignment nd Task Escalation Functions as a table with the following columns: Function Name and Classpath.

The final area of the screen shows the Parameters as a table with the following columns: Name and Value.

Below this is the Advanced section (unexpanded).


The image shows the Driver-Specific Configuration section displaying the information as a table with the following columns: Name, Description, Mandatory, Encoded Credential, and Value.


Payload XML page as described above


The image shows the Deployed Composites page of the human workflow service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances, Faults, Deployed Components (selected), and Notification Management. Below this is the Search section with fields for Name and Composite Name. To the right are the Search and Reset buttons. Below this is the View drop-down list.

Below this is a table with the following columns from left to right: Name, Composite, Status, Total Instances, Running Instances, Faulted Instances - Recoverable, and Faulted Instances - Non Recoverable.


This image shows the Processing: Number of Instances popup dialog. The following information has been found: the composite name and the number of instances.


The image shows the Message Status screen for the usermessagingserver. The first area of the screen shows the Search Message Status and includes the following fields: Maximum Messages Displayed, Operation, Overall and Status. The first area also shows the Search and Reset buttons, as well as the Add Fields drop-down menu.

The second area of the screen shows the search results as a table with the following columns: Message ID (Recipient), Recipient, Operation, Overall Status, and Timestamp. The Resend button appears at the top of the table.


The image shows the DB Subscriptions icons, from left to right, Create, Edit, and Delete.


The image shows the Dashboard tab displaying the Recent Instances. The Related Links drop-down menu is expanded and shows the following menu items: SOA Infra Home, BPEL Properties, WebLogic Server Console, and BPEL Engine Logs.


The image shows the Oracle Directory Services Manager, displaying the following tabs: Home, Data Browser, Schema, Security, and Advanced. The Data Browser tab is selected. The left pane of the tab shows the Data Tree hierarchy with the cn=oid1 node selected. The right pane shows the Attributes tab displaying the following fields: orclsslPort, orclsslVersion, orclsslWalletURL, orclsslinteropmode, orclstatsflag, orclstatslevel, and orclstatsperiodicity.


The image shows the Business Events page. The following tabs appear at the top from left to right: Events, Subscriptions, and Faults. Below this is the Search field. Below this is the View drop-down list, and Subscribe, Test, and Show Event Definition buttons. Below this is a table with the following columns: Namespaces and Events, Subscriptions, and Failed Deliveries.


The image shows the Component Metrics table, which includes the following columns from left to right: Name, Component Type, Total Instances, Running Instances, Recoverable Faulted Instances, and Non Recoverable Fault Instances. Below this is the Services and References table, which includes the following columns from left to right: Name, Type, Usage, Faults, Total Messages, and Average Processing Time (sec).


The image shows a trace diagram with an Oracle B2B Binding component, a Mediator component, and a File Adapter. The first area of the page shows the list of Faults, with no faults found. The second area of the page shows the Trace, and includes the Show Instance IDs checkbox and the Instance list.


This figure displays the rule execution trace report with the trace level set as Production.


The image shows a portion of the Settings for oracle-bam-adapter page. The Outbound Connection Pools sub-tab is selected.


The image shows the Attach/Detach drop-down list expanded to show the following list items: CreditRatingRules, AutoLoanProcess, LoanApproval, LoanAdvisorRules, and client.


The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are the following tabs from left to right: Dashboard (selected), Instances, Faults and Rejected Messages, Unit Tests, and Policies. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, and a table consisting of the following columns from left to right: Instance ID, Name, Conversation ID, State, and Start Time.

Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.


The image shows the Flow page. The following tabs display at the top from left to right: Audit Trail, Flow (selected), Sensor Values, and Faults. Below this is a graphical representation of all the activities in the BPEL process, top to bottom.


The image shows specific messages in the bam_server1.log file, displayed as a table with the following columns: Time, Message Type, Message ID, and Message.


The image shows the Oracle BAM Administrator Distribution List management page. The left side of the page shows a list of Distribution Lists. The right side of the page shows the Distribution List Name field and the Select Members list. The Save and Cancel buttons appear below the Select Members list.


The image shows the System MBean Browser navigator on the left. On the right is the setCustomNSDriverPropertyValue operation displaying the following fields: MBean Name, Operation Name, Description, and Return Type. The right side of the screen also shows the Parameters as a table with the following columns: Name, Description, Type, and Value. The Invoke and Return buttons appear at the top right of the screen.


The image shows the BPEL Service Engine Properties and includes the following fields: Audit Level (a drop-down list), Audit Trail Threshold (Byte), Large Document Threshold (Byte), Dispatcher System Threads, Dispatcher Invoke Threads, Dispatcher Engine Threads, Payload Validation (a checkbox), and Disable BPEL Monitors and Sensors checkbox. Below this is the More BPEL Configuration Properties link. The Related Links drop-down menu and Apply and Revert buttons appear at the top right.


The image shows the Credential Mappings table with the following columns: WLS User, EIS User, and Outbound Connection Pool. The New and Delete buttons appear above the table.


This image is described in the text immediately above the image.


This image is described in the surrounding text.


This image shows the Warning message that is displayed when you click Show Details or the recovery icon. The contents of this message are described in the surrounding text.


The image shows the Statistics page of the BPEL service engine. The following tabs display at the top from left to right: Dashboard, Statistics (selected), Instances, Faults, Deployed Components, and Recovery. Below this are the Pending Requests and Active Requests graphs. Below this is the Thread Statistics section, which includes a table with the following columns from left to right: Name and Statistics.


The image shows the Deployment Completed dialog box. The first area of the dialog box shows the Summary and includes the following fields: Version, Deployed Archive Location, Archive Type, Deployment Mode, Deployment Target, Application States, and Context Root. The second area of the dialog box shows the Progress Messages. The Close button appears at the bottom right of the dialog box.


The image shows the Edit Application Role: Report Architect page. The first area of the page shows the General information and includes the following fields: Application, Role Name, Display Name, and Description. The second area of the page shows the Members and Roles as a table with the following columns: Name and Type.

The final area of the page shows the Users as a table, with the Add User button highlighted.


The image shows the Email Driver Properties page for usermessagingdriver-email. The first area of page shows the Common Configuration and includes the following fields: Supported Delivery Types, Capability, Cost, Speed, Sender Addresses, Default Sender Address, Supported Protocols, Supported Carriers, Supported Content Types, Supported Status Types, and Sending Queues Info.

The second area of the page shows the Driver-Specific Configuration as a table with the following columns: Name, Description, Mandatory, Encoded Credential, and Value. The Apply and Revert buttons appear at the top right of the page.


The image shows the Domain Structure menu expanded to show the following items: Environment, Deployments, Services, Security Realms, Interoperability, and Diagnostics. The Deployments item is selected.


The image shows the Oracle BAM Server menu in Fusion Middleware Control. The following menu items are available: Home, Monitoring, Control, Logs, BAM Server Properties (selected), Security, System MBean Browser, and General Information.


The image shows four tabs at the top from left to right: Dashboard, Deployed Composites, Instances (selected), and Faults and Rejected Messages. Below this is the Search section, with fields for Instance ID, Name, ECID, Conversation ID, Start Time From, and Start Time To. Search and Reset buttons appear on the right side of the page.

Below this are the View list, and Delete Selected, Delete with Options, and Abort buttons. Below this is a table with the following columns: Instance ID, Composite, Name, Conversation ID, State, Start Time, and Logs.


The image shows the Instances page of the BPEL service engine. The following tabs display at the top from left to right: Dashboard, Statistics, Instances, Faults, Deployed Components (selected), and Recovery. Below this is the Search section with fields for Name and Composite Name. To the right are the Search and Reset buttons. Below this is the View drop-down list. Below this is a table with the following columns from left to right: Name, Composite, Status, Total Instances, Running Instances, Faulted Instances Recoverable and Faulted Instances Non Recoverable.


The image shows the Oracle BAM web services counters, available through the links in the JEE Web Services page. The JEE Web Services page shows a table with the following columns: Name, Application, Port Name, and Invocation count.


The image shows the home page of a SOA composite application. The following buttons appear at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are the following tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, and a table consisting of the following columns from left to right: Instance ID, Name, Conversation ID, State, and Start Time.

Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.


The image shows the top of the Test Web Service page. At the far right is the Test Web Service button. Below this is a description of the page. Below this is the WSDL field. To the right of this is the Parse WSDL button. Below this is the Service label, the Port label, the Operation list, the Endpoint URL field, and the Edit Endpoint URL checkbox. Below this are the Request and Response tabs.


The image shows the Instances page. At the top are the following tabs from left to right: Dashboard, Instances (selected), Faults, and Policies. Below this is the Search section, with fields for Instance ID, Start Time From, Start Time To, Modified Date From, Modified Date To, and State.

Below this is the View list. Below this is a table with the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs.


The image shows the Administration page. At the top are the following tabs from left to right: Dashboard, Instances, Faults, Policies, and Administration (selected). Below this is the View drop-down list, Add URI button, and Remove button. Below this is a table with the following columns from left to right: Application Name, Host Name, HTTP Port, HTTPS Port, and URI.


The image shows the Deployments table with the OracleBamAdapter link selected. The Install, Update, Delete, Start, and Stop buttons appear at the top of the table.


The image shows the Service Engines table, which includes the following columns from left to right: Name, Number of Components, and Faults.


The image shows the Add User dialog displaying the Search settings as the following two lists: Available Users and Selected Users. The Move, Move All, Remove, and Remove All buttons appear between the two lists.


The image shows the Select Archive page. At the top is the Archive or Exploded Directory section, in which you can select an archive that is on the machine where this web browser is running or select an archive or exploded directory on the server on which Enterprise Manager is running. Below this is the Configuration Plan section, in which you can select to not include a configuration plan, select a plan on the machine where this web browser is running or select a plan on the server on which Enterprise Manager is running.


This image is described in the text immediately above the image.


The image shows the context menu in the navigation pane displaying the following menu items: Home, Monitoring, Control, Logs, SOA Deployment, Service Engines, Bindings, Services and References, Business Events, SOA Administration, Security, Administration, and General Information. The Logs menu item is expanded and shows the following sub-menu items: View Log Messages and Log Configuration.


This image is described in the text immediately following this image.


The image shows the Associated Drivers screen displaying the following tabs: Local and All. The Local tab is selected and shows the data as a table with the following columns: Name, Driver Type, Status, and Configure Driver.


This illustration is described in the text.


The image shows the Oracle BAM Administrator application showing the function list open and User management option selected.


This figure displays how to enter input parameters for testing the decision trace in a SOA composite.


The image shows the Authentication Providers page. The page shows a list of authentication providers, with each entry showing the name, the description, and the version. A checkbox appears to the left of each entry. Above and below the list are the New, Delete, and Reorder buttons.


The image shows the Application Defined MBeans page. The Attributes tab is selected and the page shows a table with the following columns: Name, Description, Access, and Value. The Apply button appears at the top right of the page.


The image shows the Create a New Security Credential Mapping page with the following options for the WebLogic Server User: User for creating initial connections, Default User, Unauthenticated WLS User (selected), and Configured User Name. The Back, Next, Finish, and Cancel buttons appear above the options.


The image shows the Route Target section of the Dashboard tab of the Mediator Component Home page. It displays the following details of route targets, from left to right: Name, Average Processing Time, and Average Invocation Time.


This image shows the Recover with Options dialog. At the top is the Common Recovery Action list. Retry is selected. Below this is the Common Recovery Options radio button. Below this is the Preset Batches list. Older than 24 Hours is the selected option. Below this is the Recover All radio button. Below this is the Recover All Recoverable Faults that Match These Criteria radio button. Within this section are the Fault Time From, Fault Time To, and Error Message Contains fields.


The image shows the instance rate per min (Real-Time Data) section. On the left is the Instance Rate per Min (Real-Time Data) graph, which shows the throughput of instances in the last five minutes.


Flow Trace page showing Oracle B2B Faults and Trace messages.


The image shows four tabs at the top from left to right: Dashboard, Instances, Faults and Rejected Messages (selected), Unit Tests, and Policies. Below this is the Search section, with fields for Error Message Contains, Fault ID, Fault Time From, Fault Time To, and Composite Instance ID. Search and Reset buttons appear on the right side of the page.

Below this is the Show only re cove able faults checkbox and the Fault Types list. All Faults is selected in this list. Below this are the Select list, View list, Recovery Actions list, and Delete Rejected Messages button. Below this is a table with the following columns: Error Message, Recovery, Fault Time, Rejected Message, Fault Location, Composite Instance ID, and Logs.


The image shows the Oracle WebLogic Server Administration Console. On the left side from top to bottom is the Change Center, the Domain Structure (with entries for Environment, Deployments, Services, Security Realms, Interoperability, and Diagnostics), the How Do I section (with documentation links), and the System Status section. On the right side of the page are the Configuration, Monitoring, Control, Security, Web Service Security, and Notes tabs. Below this are the General, JTA, EJBs, Web Applications, Logging, and Log Filters tabs. Below this is the Save button. Below this are properties that you can define: Enable Administration Port, Production Mode, and Enable Cluster Constraints. Descriptions are provided for each.


The image shows the Attach/Detach Policies page that appears when you click Attach/Detach on the Policies tab of the Mediator Component Home page. This page displays the following details, from left to right: Name, Category, Enabled, Description, and View Full Description.

Use the Attach or Detach buttons appearing below to attach or detach a policy according to your need.


The image shows the Client Requests in Progress as a graph.


The image shows the Instance Rate per Min (Real-Time Data) section of the Dashboard tab of the Mediator Component Home page. This section displays a graph that shows real-time data for successful, faulted, and incoming instances in the last five minutes. Click Table View to get a tabular representation of the data.


The image shows the Performance Summary page for OracleBamServer showing graphs of Active Data Sessions, Outgoing Message Rate (per sec), and Events Fire Rate (per sec).


The image shows the Recovery Action section. In the upper left is a list with the value of Retry selected. To the right is the After Successful Retry label. A value of None is selected in the list. Below this and to the left is the Variable list. No value is selected. Below this is the Value field.


The image shows the farm home page. The navigational menu appears on the left. On the right is the Deployments section, which shows a deployments graph, and a deployment table with the following columns from left to right: Name, Status, and Target.


The image shows the BPMN Service Engine Properties and includes the following fields: Audit Trail Threshold (Byte), Large Document Threshold (Byte), Dispatcher System Threads, Dispatcher Invoke Threads, Dispatcher Engine Threads, Payload Validation (a checkbox), and Audit Level (a drop-down list). The Related Links drop-down menu and Apply and Revert buttons appear at the top right.


The image shows the OK, Validate, and Cancel buttons in the upper right corner. Below this is the Attached Policies table, with the following columns left to right: Policy Name, Category, Enabled, Description, and View Full Description. Attached policies appear in this table.

Below this table are the Attach and Detach buttons. Below this is the Available Policies section. A Search list is displayed below this. The value of Policy Category is selected. Below this is a table with the following columns from left to right: Policy Name, Category, Enabled, Description, and View Full Description.


The image shows the Operations page for the b2b MBean. The following operations (links) are listed: addProperty, getProperty, getPropertyComment, getPropertyValue, remove, setProperty, setPropertyComment, and setPropertyValue.


The image shows the Oracle BAM Web Properties page in Fusion Middleware Control displaying the following fields: Application URL, Report Loading Indicator, and Server Name.


This illustration is described in the text.


The image shows the Request and Response tabs. The Request tab is selected. The first area of the tab shows the Security settings and includes the following radio buttons: WSS Username Token, HTTP Basic Auth, Custom Policy, and None (selected). The second area of the tab shows the Quality of Service settings and includes the following fields: WS-RM with WSDL Default, None, and Custom radio buttons and Policy URI text field; MTOM with WSDL Default, None, and Custom radio buttons and Policy URI text field; WS-Addressing with WSDL Default, None, and Custom radio buttons and Policy URI text field.

The third area of the tab shows the HTTP Transport Options and includes the following fields: Enable SOAP Action (a checkbox) and SOAP Action. The fourth area of the tab shows the Additional Test Options and includes the following fields: Enable Stress Test (a checkbox), Concurrent Threads, Loops per Thread, and Delay in Milliseconds. The final area of the tab shows the Input Arguments and includes a drop-down list along with Name, Type, and Value fields.


This image shows the defined if condition.


The image shows the Log Messages page showing all message types selected and a few Warning messages in the table.


The image shows the Settings for oracle.bam.adapter.adc.soap.SOAPConnectionFactory page displaying the following tabs: General, Properties, Transaction, Authentication, Connection Pool, and Logging. The Properties tab is selected and the page shows the Outbound Connection Properties as a table with the following columns: Property Name, Property Type, and Property Value. The Property Value for the HostName property is selected. The Save button appears above and below the table.


This image shows the partitions in the navigator and in the Manage Partitions page.


The image shows the Oracle Enterprise Manager navigation pane with the User Messaging Server node expanded.


This illustration is described in the text.


The image shows the Faults page. The following tabs appear at the top from left to right: Events, Subscriptions, and Faults (selected). Below this is the Search section, Below this is the Search section, with fields for Error Message Contains, Fault ID, Fault Time From, Fault Time To, Subscription Type, Event Namespace, Event Name, and Subscriber.

The Search and Reset buttons display on the right. Below this is the Select drop-down list, View drop-down list, Retry button, and Abort button. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Event Namespace, Event Name, Subscriber Name, and Subscription Type.


The image shows the SOA Infrastructure Common Properties screen. The first area shows the following fields: Audit Level (a drop-down list), Capture Composite Instance State (a checkbox), and Payload Validation (a checkbox). The second area of the screen shows the UDDI Registry Properties and includes the following fields: Inquiry URL, User, and Password. The third area of the screen shows the Server URLs and includes the following fields: Callback Server URL and Server URL. The fourth area shows the Display Data Counts section with the Disable fetching of instance and fault count metrics checkbox and the Set default search criteria to fetch recent instances and faults only within a recent duration checkbox.

The bottom area of the screen shows the Advanced properties.

The top right of the screen shows the Related Links drop-down menu and the Apply and Revert buttons.


The image shows Fusion Middleware Control. The left side of the page shows the navigation pane with OracleBamServer selected. The right side of the page shows the BAM Server drop-down menu with the following menu items: Home, Monitoring, Control, Logs, BAM Server Properties, Security, System MBean Browser, and General Information. The Security menu item is expanded and shows the following sub-menu items: Application Policies and Application Roles.


The image shows the Faults tab of the Mediator Service Engine Home page. The Search section lets you enter the following details to search for particular faults that occurred to different Mediator components ran by the Mediator Service Engine, from left to right: Error Message Contains, Fault ID, Fault Time from, Fault Time to, Composite Instance ID, and Component Instance ID.

Below the Search section, the Show Only Recoverable Faults checkbox enables you to view only those faults on which you can perform recovery actions. The Fault Type list enables you to choose the type of the fault.

Below is the View section that displays the following details of all the faults meeting the particular criteria, from left to right: Error Message, Recovery, Fault Type, Composite, Component, Component Instance ID, Case, and Logs.


The image shows the Oracle Enterprise Manager Select Target screen. The screen shows the data as a table with the following columns: Select, Name, Type, and Deployed Applications. The Cancel, Back and Next buttons appear at the top right of the screen.


The image shows the following tabs: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. The Dashboard tab is selected. The first section of the page shows the Recent Instances as a table with the following columns: Instance ID, Name, Conversation ID, State, and Start Time. The second section of the page shows the Recent Faults and Rejected Messages as a table with the following columns: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.

The third section of the page shows the Component Metrics as a table with the following fields: Name, Component Type, Total Instances, Running Instances, and Faulted Instances (Recoverable and Non Recoverable). The top right of the page shows the Related Links drop-down menu.


This figure displays how to open the instance details page for viewing the details of the Decision Service Component.


This image shows the Enable/Disable BPEL Monitors and Sensors option being selected.


The image shows the Refresh icon in upper right corner of Fusion Middleware Control Console.


The image shows the Faults tab of the Mediator Instance Details page of a Mediator component instance, where a fault occurred. It displays the following details of a fault, from left to right: Message, Recovery, Time, and Case.


The image shows the Task Details section displaying the following fields: Task Number, State, Outcome, Priority, Creator, Created Date, Updated Date, Expiration Date, Assignees, and Acquired By.


The image shows the two tabs at the top from left to right: Services and References (selected). Below this is a View list. Below this is a table consisting of the following columns from left to right: Reference, Type, Composite, Partition, Total Messages, Average Processing Time (sec), and Faults.


The image shows the Oracle BAM Server page displaying the following tabs: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. The Enterprise Message Sources tab is selected and the page shows the following information: Messages and Operations Per Second.


The image shows the BAM Web drop-down menu. The following menu items are available: Home, Monitoring, Control, Logs, BAM Web Properties, System MBean Browser, and General Information. The Monitoring menu item is expanded to show the Performance Summary sub-menu item (selected).


This image shows the cursor selecting a partition.


The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are four tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests (selected), and Policies. Below this are the Test Cases (selected) and Test Runs sub-tabs. Below this is a table with the following columns from left to right: Name, Description and Select (which is a checkbox). In the Name column are two folders: SimpleAssertions and SimpleEmulations.


The image shows the Dashboard tab of the Mediator Component home page. This section displays information about the recent instances of the Mediator component, including a list of recent instances, a list of recent faults, routing statistics, and instance rate per minute.


This image is described in the surrounding text.


The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected) and Faults and Rejected Messages. Below this is the Instances and Faults graph, which shows the total number of incoming messages and faults since server startup. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox and a table that includes the following columns from left to right: Error Message, Fault Time, and Composite Instance ID.


This image shows the following tabs at the top from left to right: Dashboard, Policies, Faults and Rejected Messages (selected), and Properties. Below this is the Attach/Detach icon and Disable icon. Below this is a table with the following columns: Policy Name, Category, Policy Reference Status, Total Violations, Authentication, Authorization, and Confidentiality. Below this is the Security Configuration Details section. Which includes Apply and Revert buttons on the upper right side, and a table with the following columns: Name, Value, and Original Value.


The image shows the Recovery Action list with a value of Retry selected. Below this is the Variable list with a value of crInput selected. To the right of this is the Set Value button. Below this is the Value field in which you can enter values.


The image shows the Confirmation dialog that appears when you try to recover a fault. The Yes and No buttons appear at the bottom right.


The image shows the Reorder Authentication Providers page. The main area of the page shows the list of available authentication providers. To the right of the list, an up arrow and a down arrow is shown. Above and below the principal area are the OK and Cancel buttons.


This figure displays how to launch the Flow Trace page to view the decision flow trace.


The image shows the Dashboard page. At the top are the following tabs from left to right: Dashboard (selected), Instances, Faults, and Policies. Below this is the Recent Instances section, which includes a Show Only Running Instances checkbox and a table that consists of the following columns from left to right: Instance ID, State, Start Date, Last Modified Date, and Logs. Below this is the Show All link.

Below this is the Recent Faults section, which includes a Show only system faults checkbox and a table that consists of the following columns from left to right: Error Message, Recovery, Fault Time, Component Instance ID, Activity, and Logs.


The image shows the top of the Test Web Service page. At the far right is the Test Web Service button. Below this is a description of the page. Below this is the WSDL field. To the right of this is the Parse WSDL button. Below this is the Service label, the Port label, the Operation list, the Endpoint URL field, and the Edit Endpoint URL checkbox.

Below this are the Request and Response (selected) tabs. Below this is the Test Status label, the Response Time (ms) label, the Tree View list, and the Launch Message Flow Trace link. Below this is a table with the following columns from left to right: Name, Type, and Value.


The image shows the Oracle BAM Server page displaying the following tabs: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. The Report Cache tab is selected and the page shows the following information: General and View Sets.


The image shows the Oracle Enterprise Manager. The left side of the screen shows the navigation pane with the usermessagingserver node selected. The right side of the screen shows the System MBean Browser. The left side of the System MBean Browser shows a navigation pane with the ComponentAdministration bean selected. The right side of the System MBean Browser shows the unregisterDriverInstance operation details and parameters.


This image shows the flow of a BPEL 2.0 process.


This image is described in the text immediately below the graphic.


The image shows the Audit Trail page. The following tabs display at the top from left to right: Audit Trail (selected), Flow, Sensor Values, and Faults. Below this and to the right are the Audit Level Settings and View Raw XML links. Below this is the audit trail of each activity in the BPEL process.


The image shows the Delete: Rejected Messages dialog. Below this is a description of the page. Below this is the Common Delete Options radio button (selected). Below this is the Preset Batches list, with a value of Older than 24 Hours selected. Below this is the Delete All radio button. This deletes all rejected messages of this composite. Below this is a Delete All Rejected Messages That Match These Criteria radio button. Below this are fields for Start Time From, and Start Time To. In the lower right are Delete and Cancel buttons.


The image shows the Select Distinguished Name (DN) Path dialog box. The dialog box shows an expanded hierarchy of distinguished names with the dc=oracle entry selected. At the bottom right of the dialog box are the Select and Cancel buttons.


The image shows the web service page displaying the following tabs: Dashboard, Policies, Faults, and Properties. The Properties tab is selected and shows the following fields: Append, PhysicalDirectory, FileNamingConvention, and NumberMessages. The Apply and Revert buttons appear at the top right of the tab.


This image shows the following tabs at the top from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages.

Below this is the Recent Composite Instances section. In this section are the Show Only Running Instances checkbox, and the Running and Total counts. Below this is a table with the following columns: Instance ID, Composite, and Start Time. To the right is the Deployed Composites section, which includes a table with the following columns: Composite, Status, Mode, Instances, and Faulted Instances. An entry in the Instances tab is selected. A message is displaying that says the following: Click to calculate the number of instances for this composite (You may experience a delay).


The image shows the following buttons at the top from left to right: Active, Retire, Shut Down, Test, and Settings. Below this are the following tabs from left to right: Dashboard, Instances, Faults and Rejected Messages, Unit Tests, and Policies. Below this is the Recent Instances section. which includes a Show Only Running Instances checkbox, and a table consisting of the following columns from left to right: Instance ID, Name, Conversation ID, State, and Start Time. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox, and a table with the following columns from left to right: Error Message, Recovery, Fault Time, Fault Location, Composite Instance ID, and Logs.


The image shows the Associated Drivers section of the Oracle Enterprise Manager displaying the following tabs: Local and All. The All tab is selected and shows the data as a table with the following columns: Name, Driver Type, Status, and Configure Driver.


The image shows the BAM Web Statistics Report Server page. The first area of the page shows the Connections and includes the following fields: Open Connections, Message Rate (per second), and Message Rate Per Connection (second). The second area of the page shows the Reports and includes the Open Reports field. The final area of the page shows the View Sets and includes the following fields: Open and Average Open Time (seconds).


The image shows the Edit Application Role: Report Architect page with pre-seeded BamReportArchitects group in the Roles list.


The image shows the Faults page. At the top are the following tabs from left to right: Dashboard, Statistics, Instances, Faults, Deployed Composites, and Recovery (selected). Below this is the Search section, with fields for Type, Duration, Message State, Composite, and Component. To the right are the Search and Reset buttons. Below this are the Select drop-down list, View drop-down list, Recover button, and Mark Cancelled button. Below this is a table with the following columns from left to right: Conversation ID, Recover, Component, Composite, and Time.


The image shows that to select a composite, you must click to the left of the name.


The image shows the Log Messages page. The first section of the page shows the search settings and includes the following drop-down lists: Date Range and Hours. The first area also shows the following checkboxes: Message Types, Incident Error, Error, Warning, Notification, Trace, and Unknown. The first area further shows the following fields: Message, Composite Name, Component Name, Component Instance ID, and Composite Instance ID. The Search and Add Fields buttons appear at the bottom of the first area.

The second section shows the search results as a table with the following columns: Time, Message Type, Message ID, and Message.


The image shows the Cross References screen. The first area of the screen shows the Select Tables and Columns section and includes the following radio buttons: All tables and Select a table and columns. The section also shows the Tables list and Columns checkboxes. The second area of the screen shows the Select Values section and includes the following radio buttons: All, Marked for delete, and Updated between.


The image shows the navigation tree with the SOA node expanded and the soa-infra (soa_server1) node further expanded to show the child nodes. Running SOA composite applications display under the default partition of soa-infra.


The image shows the Advanced section of the Workflow Task Service Properties screen displaying the following fields: Worklist Application URL, Pushback Assignee, and Portal Realm Mapping. The section also shows the Task Auto Release Configuration as a table with the following columns: Priority, Default Duration, and Percentage of Expiration.


The image shows the View Log File screen for the soa_server1-diagnostic.log file. The first area of the screen shows the Download button. The second area of the screen shows the following fields: Date Range, Start Date, and End Date. The second area also shows the Search button.

The third area of the screen shows the search results as a table with the following columns: Time, Message Type, Message ID, and Message. The fourth area of the screen shows the message details including the following fields: Message Level, ECID, Relationship ID, Component, Module, Message, Host, Host IP Address, User, and Thread ID.



The image shows the Oracle Enterprise Manager. The left side of the screen shows the navigation pane with the usermessagingdriver-email node selected. The right side of the screen shows Message Latency as a graph.


The image shows the Message Status screen for the usermessagingserver. The first area of the screen shows the Search Message Status and includes the following fields: Maximum Messages Displayed, Operation, Overall and Status. The first area also shows the Search and Reset buttons, as well as the Add Fields drop-down menu.

The second area of the screen shows the search results as a table with the following columns: Message ID (Recipient), Recipient, Operation, Overall Status, and Timestamp. The Resend button appears at the top of the table.


The image shows the Oracle BAM start page displaying buttons for launching Oracle BAM Active Viewer, Oracle BAM Active Studio, Oracle BAM Architect, and Oracle BAM Administrator.


The image shows the Open Connections as a graph.


The image shows the Activity Details alert displaying the invokeCR error message with the following text: 'Faulted while invoking operation "process" on provider "CreditRatingService"'. The Close button appears at the bottom right of the alert.


The image shows the Dashboard page. The following tabs display at the top from left to right: Dashboard (selected), Policies, Faults and Rejected Messages, and Properties. Below this is the Instances and Faults graph, which shows the total number of incoming messages and faults since server startup. Below this is the Recent Faults and Rejected Messages section, which includes a Show only system faults checkbox and a table that includes the following columns from left to right: Error Message, Fault Time, and Composite Instance ID.


The image shows the fully-expanded Metric Palette for Oracle BAM Web.


This illustration is described in the text.


This image shows the Delete SOA Partition dialog. A table with the following columns appears: Composite, Status, Mode, Instances Total, Instances Faulted, and Last Modified Date.


The image shows the Composite Instances and Faults graph, which shows the total number of instance and faults since the last server startup.


The image shows the Oracle BAM Administrator Distribution List management page. The left side of the page shows a list of Distribution Lists. The right side of the page shows the Continue button.


The image shows the Operation: setProperty page. A table lists parameters with the following names: key, value, and comment. The key is the name of the property. The value is the value of the property, and the comment is a comment about the property. All are of type java.lang.String. The Value field for key shows b2b.payloadObfuscation. The Value field for value shows true. The Value field for comment is empty.


The image shows the User Message Email Driver drop-down menu with the following menu items: Home, Control, Logs, Performance Summary, Email Driver Properties (selected), System MBean Browser, and General Information.


The image shows the soa-infra node in the navigation pane, with the following subnodes: Application Deployments, SOA, WebLogic Domain, Metadata Repositories, and User Messaging Service. The SOA node is expanded to show the soa-infra (11.1.1) (soa_server1) subnode.


This image is described in the surrounding text.


The image shows the Information window that appears to let you know whether the fault recovery has been successful or not. The OK button appears at the bottom right.


The image shows the Oracle BAM Server page displaying the following tabs: Active Data Cache, Event Engine, Report Cache, and Enterprise Message Sources. The Active Data Cache tab is selected and the page shows the following information: View Sets, Threads, Operations Per Second, Average BatchSize for Operations, and Total Transactions.


The image shows the Mediator Service Engine Properties page. You can set value for the following properties displayed from top to bottom on the page: Audit Level, Metrics Level, Parallel Worker Threads, Parallel maximum Rows Retrieved, Parallel Locker Thread Sleep, Error Locker Thread Sleep, Parameters, Container ID Refresh Time, and Container ID Lease Timeout.


The image shows the Log Configuration displaying the following tabs: Log Levels and Log Files. The Log Levels tab is selected and shows the search information as a table with the following columns: Logger Name, Oracle Diagnostic Logging Level (Java Level), and Log File. The Oracle Diagnostic Logging Level drop-down list is expanded and shows the possible logging levels.


This image is described in the table immediately below this image.


The image shows the information screen for a user, and includes the Person, Attributes, Subtree Access, and Local Access tabs. The Person tab is selected. The first area of the screen shows the following (non-editable) fields: Distinguished Name, Created by, Created at, Modified by, and Modified at. The first area of the Person tab shows the Basic User Information and includes the following fields: User Name, First Name, Last Name, Title, Manager, Employee Number, Email Address, and Upload Photo (with a Browse button). The second area of the Person tab show part of the Contact Information and includes the following fields: Postal Address, Home Postal Address, Telephone Number, and Mobile. At the top right of the screen are the Apply and Revert buttons.


This figure displays the rule execution trace for the Decision Service Component.


The image shows the Outbound Connection Properties as a table with the following columns: Property Name, Property Type, and Property Value. The Property Value for the HostName property is selected. The Save button appears above the table.


The image shows the XML Definition: OrderReceivedEvent dialog box showing the Event Definition (EDL). The OK button appears at the bottom right of the dialog box. The dialog box is identical for both EDN-DB and EDN-JMS.


This image shows the following tabs at the top from left to right: Dashboard, Deployed Composites, Instances, and Faults and Rejected Messages.

Below this is the Recent Composite Instances section. In this section are the Show Only Running Instances checkbox, and the Running and Total counts. Below this is a table with the following columns: Instance ID, Composite, and Start Time. To the right is the Deployed Composites section, which includes a table with the following columns: Composite, Status, Mode, Instances, and Faulted Instances.


The image shows the Policies page. The following tabs display at the top of the page: Dashboard, Policies (selected), Faults and Rejected Messages, and Properties tabs.

Below this is a table with the following columns from left to right: Policy Name, Policy Set, Category, Total Violations, Authentication, Authorization, and Confidentiality. These last three columns fall under a main header of Security Violations.

Below this is the Directly Attached Policies table. Below this is the Attach/Detach button. Below this are the following columns, from left to right, of the Directly Attached Policies table: Policy Name, Category, Policy Reference Status, Total Violations, Authentication, Authorization, and Confidentiality. These last three columns fall under a main header of Security Violations.


The image shows the System MBean Browser with the Application Defined MBeans expanded (several levels) to show the BAMCommonConfig, BAMServerConfig, and BAMWebConfig beans.


The image shows the Faults tab of the Mediator Component Home page. The Search section lets you enter the following details to search for particular faults occurring to the Mediator instances: Error Message Contains, Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. Below this section is the Show only recoverable faults checkbox that lets you see only recoverable faults, if selected. Right to this checkbox is the Fault Type list that lets you select the fault type. The View section displays the following details of all the faults meeting the particular criteria, from left to right: Error Message, Recovery, Fault Time, Component Instance ID, Case, and Logs.


The image shows the Faults and Rejected Messages page. The following tabs display at the top from left to right: Dashboard, Policies, Faults and Rejected Messages (selected), and Properties. Below this is the Search section with fields for Error Message Contains, Fault ID, Fault Time From, Fault Time To, and Composite Instance ID. The Search and Reset buttons appear to the right. Below this is the Fault Type drop-down list, with All Faults as the selected value. Below this is the View drop-down list and the Delete Rejected Messages button. Below this is a table with the following columns left to right: Error Message, Fault Time, Rejected Message, and Composite Instance ID.


The image shows the Faults page. At the top are the following tabs from left to right: Dashboard, Instances, Faults (selected), Policies, and Administration. Below this is the Search section, with fields for Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. To the right are the Search and Reset buttons.

Below this is the Show only recoverable faults checkbox and the Fault Type drop-down list, in which All Faults is selected. Below this are the Select and View drop-down lists. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Component Instance ID, and Logs.


The image shows the context menu for the OracleBamWeb node, showing the following menu items: Home, Monitoring, Control, Logs, BAM Web Properties, System MBean Browser, and General Information. The Logs menu item is expanded to show the following sub-menu items: View Log Messages (selected) and Log Configuration.


The image shows the Select Distinguished Name (DN) Path dialog box. The dialog box shows an expanded hierarchy of distinguished names with the cn=Groups entry selected. At the bottom right of the dialog box are the Select and Cancel buttons.


This figure displays how to enable a more detailed rule execution trace report.


The image shows the Assign Value dialog. In the upper left is the From section, which includes the Type list. To the right is the To section, which includes the Type list. Below the From section is the Expression field. To the right is the Property section.


The image shows the Outbound Connection Pool Configuration Table with the oracle.bam.adapter.adc.soap.SOAPConnectionFactory item expanded to show eis/bam/soap (selected) and eis/bam/soap1013 sub-nodes. The New and Delete buttons appear below the table.


This image is described in the text immediately above.


The image shows the Faults page. At the top are the following tabs from left to right: Dashboard, Statistics, Instances, Faults (selected), Deployed Composites, and Notification Management. Below this is the Search section, with fields for Fault ID, Fault Time From, Fault Time To, Composite Instance ID, and Component Instance ID. To the right are the Search and Reset buttons.

Below this is the Show only recoverable faults checkbox and Fault Type drop-down list, in which All Faults is selected. Below this are the Select and View drop-down lists. Below this is a table with the following columns from left to right: Error Message, Recovery, Fault Time, Composite, Component, Component Instance ID, and Logs.


13 Managing BPEL Process Service Components and Engines

This chapter describes how to manage BPEL process service components and service engines.

This chapter includes the following topics:

	
Section 13.1, "Recovering from BPEL Process Service Component Faults"


	
Section 13.2, "Managing BPEL Process Service Component Policies"


	
Section 13.3, "Recovering from BPEL Process Service Engine Faults"


	
Section 13.4, "Performing BPEL Process Service Engine Message Recovery"




For more information, see the following sections:

	
Section 1.2.4, "Introduction to Service Components and Service Component Instances"


	
Section 1.2.6, "Introduction to Service Engines"






13.1 Recovering from BPEL Process Service Component Faults

You can monitor and perform individual and bulk fault recoveries for BPEL process service components that are identified as recoverable. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault.

To recover from BPEL process service component faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application.









	
Select the BPEL process service component in the Component Metrics section.


	
Click Faults.

The Faults page displays the following details:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults that occurred in the service component, including the fault ID, error message, whether you can recover from the fault, time at which the fault occurred, service component instance ID, activity in which the fault occurred, and a link to a log file describing the fault.




[image: Description of bpel_comp_faults.gif follows]




BPEL process service component faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following methods. Note that fault recovery selection at the BPEL process service component level equals the SOA Infrastructure level, SOA composite application level, and Oracle Mediator service component level.


	For...	Then...
	Single fault recovery	There are three options from which to choose for single-fault recovery:
	
Click the row of the fault that has been identified as recoverable. With the row highlighted, select a specific action from the Recovery Action list, as described in Step 5.


	
In the Recovery column, click the Recover link to access the Faults page of the instance audit trail to perform fault recovery.


	
In the Error Message column, click the message of a fault that has been identified as recoverable. This displays complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. A Recover Now option is displayed for recoverable faults. Click Recover Now to access the Faults page of the instance audit trail to perform fault recovery.





	Bulk fault recovery	There are two options from which to choose for bulk-fault recovery:
	
Use Shift+Click or Control+Click to select specific faults in the rows.

or


	
From the Select menu, choose Select All Recoverable. Then use Shift+Click or Control+Click to deselect the faults to not include in the recovery operation.

Then:


	
Select an action from the Recovery Action list, as described in Step 5.

Note: Only the actions applicable to all selected faults are available.





	Recovery of all faults	
	From the Select menu, choose Select All Recoverable.
	
Select an action from the Recovery Action list, as described in Step 5.

Note: Only the actions applicable to all selected faults are available.














	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.








	
Select an action from the Recovery Action list.


	Action	Description
	Retry	Retries the instance directly. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.
	Abort	Terminates the entire instance.
	Replay	Replays the entire scope activity again in which the fault occurred.
	Rethrow	Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.
	Continue	Ignores the fault and continues processing (marks the faulted activity as a success).






	
Perform the following additional monitoring tasks from within the faults table:

	
Click the Show only recoverable faults checkbox to display only faults from which you can recover.


	
From the Fault Type list, select to display all faults, system faults, business faults, or Oracle Web Services Manager (OWSM) faults in the faults table. Click the Help icon for a description of these fault types.


	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Note that rejected messages do not have a component instance ID.


	
In the Logs column, click a link to access the Log Messages page with filtered messages specific to that instance.







For more information, see the following documentation:

	
Section 1.4.3.1, "Introduction to Fault Recovery"


	
Section 8.5.1, "Examples of Fault Recovery for BPEL Processes"


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite


	
Oracle Fusion Middleware Administrator's Guide for details about viewing and searching log files









13.2 Managing BPEL Process Service Component Policies

You can attach and detach policies to and from BPEL process service components in currently deployed SOA composite applications. Policies apply security to the delivery of messages. Oracle Fusion Middleware uses a policy-based model to manage web services.




	
Note:

Before attaching policies, see Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use in your environment.







To manage BPEL process service component policies:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application.









	
Select the BPEL process service component in the Component Metrics section.


	
Click Policies.

The Policies page enables you to attach and detach policies to and from BPEL process service components. The Policies section displays the attached policy name, the policy reference status (enabled or disabled) that you can toggle, the category (Management, Reliable Messaging, MTOM Attachment, Security, or WS-Addressing), the violations, and the authentication, authorization, confidentiality, and integrity failures since the SOA Infrastructure was last restarted.

[image: Description of bpel_comp_policy.gif follows]




	
Click Attach/Detach.

If multiple components are available, you are prompted to select the service or component for which to perform the attachment or detachment.


	
Select the service or component to which to attach or detach a policy.

This invokes a dialog for attaching or detaching policies.

Policies currently attached appear in the Attached Policies section. Additional policies available for attachment appear in the Available Policies section.


	
Select to attach policies appropriate to your environment.


	
Click Attach.


	
When you are finished attaching policies, click Validate.


	
If an error message appears, make the necessary corrections until you no longer have any validation errors.


	
Click OK.

The attached policy is displayed in the policies table.




For more information, see the following documentation:

	
Section 1.4.3.2, "Introduction to Policies"


	
Section 8.8, "Managing SOA Composite Application Policies" for the dialogs that are displayed during policy attachment


	
Oracle Fusion Middleware Security and Administrator's Guide for Web Services for definitions of available policies and details about which ones to use for your environment









13.3 Recovering from BPEL Process Service Engine Faults

You can monitor and perform individual and bulk recoveries of faults occurring in BPEL process service engines that are identified as recoverable. All BPEL process service component faults, regardless of the SOA composite application instance of which they are a part, can be viewed in the BPEL process service engine. For BPEL process faults to be identified as recoverable, there must be a fault policy defined that is bound to the fault (through the fault-bindings.xml file) and which triggers the action ora-human-intervention. However, without defining any fault policies, the fault takes its standard course as either a recoverable or nonrecoverable fault.

To recover from BPEL process service engine faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Service Engines > BPEL.


	
	Right-click soa-infra.
	
Select Service Engines > BPEL.











	
Click Faults.

The Faults page displays the following details:

	
A utility for searching for a specific fault by specifying criteria and clicking Search. Click the Help icon for details.


	
Faults that occurred in the service engine, including the fault ID, error message, whether you can recover from the fault, the time at which the fault occurred, the SOA composite application and service component in which the fault occurred, and the service component instance ID.




[image: Description of bpel_se_faults.gif follows]




BPEL process service engine faults identified as recoverable can be recovered.


	
Select faults for recovery using one of the following options. As with fault recovery at the SOA Infrastructure level, SOA composite application level, and Oracle Mediator service component level, you can perform single fault recovery, bulk fault recovery, and recovery of all faults. See Step 4 of Section 13.1, "Recovering from BPEL Process Service Component Faults" for instructions on selecting faults to perform these types of recovery.




	
Note:

In most cases, fault policy actions are automatically executed. The only exception is if you defined a fault policy that uses the action ora-human-intervention. This action creates a recoverable fault that can be recovered from Oracle Enterprise Manager Fusion Middleware Control.








	
Select an action from the Recovery Action list.


	Action	Description
	Retry	Retries the instance with an option to provide a retry success action. An example of a scenario in which to use this recovery action is when the fault occurred because the service provider was not reachable due to a network error. The network error is now resolved.
	Abort	Terminates the entire instance.
	Replay	Replays the entire scope activity again in which the fault occurred.
	Rethrow	Rethrows the current fault. BPEL fault handlers (catch branches) are used to handle the fault. By default, all exceptions are caught by the fault management framework unless an explicit rethrow fault policy is provided.
	Continue	Ignores the fault and continues processing (marks the faulted activity as a success).






	
Perform the following additional monitoring tasks from within the faults table:

	
Click the Show only recoverable faults checkbox to only display faults from which you can recover.


	
From the Fault Type list, select to display all faults, system faults, business faults, or OWSM faults in the faults table. Click the Help icon for a description of these fault types.


	
From the View list, select Columns > Fault ID to display the fault IDs for each error message. The fault ID is automatically generated and uniquely identifies a fault. The fault ID is also displayed when you click an error message.


	
In the Composite column, click a specific SOA composite application to access its home page.


	
In the Component column, click a specific service component to access its home page.


	
In the Component Instance ID column, click a specific service component ID to access task details about the instance (for example, the current state of a task). Note that rejected messages do not have a component instance ID.







For more information, see the following sections:

	
Section 1.4.3.1, "Introduction to Fault Recovery" for conceptual details about faults


	
Section 8.5.1, "Examples of Fault Recovery for BPEL Processes"









13.4 Performing BPEL Process Service Engine Message Recovery

You can perform a manual recovery of undelivered invoke or callback messages due to a transaction rollback in the process instance. Recovery of invoke messages applies to asynchronous BPEL processes only. Synchronous BPEL processes return an error to the calling client and are not recoverable from the Recovery page. Recoverable activities are activities that failed and can be recovered. For example, if you are using the file adapter to initiate an asynchronous BPEL process and your system fails while the instance is processing, you can manually perform recovery when the server restarts to ensure that all message records are recovered.

You can also manage messages that have failed automatic recovery attempts by the BPEL process service engine. To ensure that automatic recovery of these messages is not attempted multiple times, these messages are placed in the exhausted state. You can then perform one of the following actions on these messages:

	
Return them to the automatic recovery queue


	
Never attempt a recovery on them again


	
Attempt to recover them immediately




For example, assume you have a BPEL process that writes to a database adapter. If the database is down, these messages are sent to a recovery queue. Automatic recovery of these messages fails while the database is down. Such messages are marked with the exhausted state so that automatic recovery is not attempted on them again. When the database begins running again, you can reset these messages (return them to the automatic recovery queue) so that an automatic recovery is attempted on them again.

To perform BPEL process service engine message recovery:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Service Engines > BPEL.


	
	Right-click soa-infra.
	
Select Service Engines > BPEL.











	
Click Recovery.

The Recovery page displays the following details:

	
A Refresh Alarm Table button for resynchronizing lost, in-memory, Quartz-scheduled jobs in the database. For example, assume a timer on a wait activity or on an onAlarm branch of a pick activity was initiated, but the transaction was rolled back. You can resynchronize these jobs with the BPEL instances residing in the wait activity/onAlarm branch in the database.


	
A utility for searching for a specific message failure by specifying criteria and clicking Search. Click the Help icon for details.

You can enter the execution context ID (ECID) value in the ECID field. The ECID value enables you to track a message flow that crosses instances of different composite applications. If there are BPEL process messages requiring recovery and the AuditConfig property in the System MBean Browser is set to All (the default value), the following message is displayed in the Trace table of the Flow Trace page:


BPEL Message Recovery Required


Clicking Show Details or the recovery icon that appears next to this message displays a Warning dialog with information about the number of invoke, callback, and activity recoverable message types and the ECID value. You can copy the ECID value from the Warning dialog, paste it into the ECID field, and select the recoverable message type from the Type list as part of creating your search criteria on the Recovery page.

For more information, see Section 12.1, "Viewing the Audit Trail and Process Flow of a BPEL Process Service Component."




	
Note:

Oracle recommends that you add an index on the DLV_MESSAGE.ECID column of the DLV_MESSAGE table to improve SQL query performance when searching messages for a specific ECID value. This is because if there are too many entries in the DLV_MESSAGE table, the search query may be slow and may also overload the database. For information on adding an index, see Chapter "Creating Indexes" of the Oracle Database Administrator's Guide.








	
Message failures in the service engine, including the conversation ID, whether you can recover from the message failure, the service component and composite application in which the failure occurred, and the time at which the fault occurred. Depending on the state, you can recover these messages immediately, cancel these messages, or reset these messages for automatic recovery.




[image: Description of bpel_se_recov.gif follows]







	
Notes:

	
You can recover callback messages in resolved and undelivered states. These messages can be displayed for recovery when you execute search criteria in which you select Callback from the Type list and either Resolved or Undelivered from the Message State list. When a callback message first enters the BPEL process service engine, its state is undelivered. When this message is resolved to the target BPEL process instance either through matching a conversation ID or a correlation, the state is switched to resolved. In both of these states, the messages have not yet been consumed. Messages in these two states can be recovered (redelivered into the BPEL process service engine for consumption). In other situations, the callback messages can become stranded in both of these states. Messages in these states can also be recovered. However, there is no guarantee that stranded callback messages always remain in an undelivered state.


	
If you select Invoke from the Type list and Undelivered from the Message State list, and then click Recover, a recovery is performed. However, the Last Modified Date column remains empty for this instance on the Dashboard page of the Oracle BPEL Process Manager service component or service engine. This is the expected behavior. The last modified date is not displayed because the initial Oracle BPEL Process Manager instance (for example, bpel:70004) is created by the first invocation (that is, it is created, but has not yet been modified). The recovery of the undelivered invocation message always creates a new instance (for example, bpel:70005). The previously created instance (bpel:70004) is not used and remains permanently in the same status (the Last Modified Date column is empty). This information is provided for auditing purposes only.


	
The Message States list is applicable only to callback and invoke message type recovery, and not for activity message type recovery.













	
Select a fault in the table.


	
Select one of the following options:


	Action	Description
	Recover	Retries the message in which the fault occurred.
If you select messages in the exhausted state and click this button, an attempt is made to recover them immediately. Should this recovery attempt also fail, the message is returned to the exhausted state. You must then select the message and click Reset to return the message to the automatic recovery queue.

If an asynchronous BPEL process encounters a transaction rollback scenario because of any underlying exception error, it rolls back to the last dehydration activity. If this is a new instance, and a receive activity was the first dehydration activity, the BPEL process service engine creates a recoverable invoke. When you click Recover to recover the invoke, the service engine creates a new instance. This instance may run to completion with no exception error. However, you continue to see the older instance identified as faulted.


	Mark Cancelled	Marks the message so it is never delivered. If you select messages in the exhausted state and click this button, recovery is never attempted on them.
	Reset	Select to reset exhausted messages to the undelivered state. This returns the message to the automatic recovery queue. The messages that are displayed in the exhausted state disappear from the messages table. If you select Undelivered from the Message State list and click Search, these messages are displayed. Note that callback messages in the exhausted state can also be reset to the resolved state and still remain recoverable.






Once a message is submitted for recovery, the BPEL process service engine may take time to complete the action. This typically takes less than several seconds. During this time, the message remains visible in the Recovery page. Duplicate attempts to recover the same message in that period are ignored. Refresh the page every few seconds to receive the latest recovery status.




	
Note:

If you define a fault policy in a BPEL process with an ora-retry action and a fault occurs, the BPEL process attempts to recover from the fault the number of times you specified with the retryCount parameter. After this period, the process continues to be in a running state. The status of an activity in the process that has not completed (such as an invoke or receive) shows as pending a manual recovery. This is the expected behavior.







For information about configuring the maximum number of times to attempt an invoke and callback message recovery, see Section 11.4, "Configuring Automatic Recovery Attempts for Invoke and Callback Messages."








28 Configuring Oracle JCA Adapters

This chapter describes how to configure Oracle JCA Adapters.

This chapter includes the following topics:

	
Section 28.1, "Configuring the End Point Properties for an Inbound Adapter"


	
Section 28.2, "Configuring the End Point Properties for an Outbound Adapter"






28.1 Configuring the End Point Properties for an Inbound Adapter

This section describes how to configure the end point properties for an inbound adapter. It includes the following topics:

	
Section 28.1.1, "Editing a Predefined Property for an Inbound Adapter"


	
Section 28.1.2, "Adding Predefined Properties for an Inbound Adapter"


	
Section 28.1.3, "Creating a New Property for an Inbound Adapter"


	
Section 28.1.4, "Deleting a Property for an Inbound Adapter"


	
Section 28.1.5, "Reverting a Property Value for an Inbound Adapter"






28.1.1 Editing a Predefined Property for an Inbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible edit the predefined properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To edit a predefined property for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Edit a predefined property:

	
Click Properties to see a list of the currently defined binding properties.


	
Select the property you want to edit.


	
Edit the value in the Value text box, and then click Save.

You have edited a predefined property for an inbound adapter.







For more information about configuring adapters, see Section 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






28.1.2 Adding Predefined Properties for an Inbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to add properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.




	
Note:

Though the Properties page list both endpoint and the binding properties, you can only add endpoint properties.







To add a predefined property for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Add a predefined property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Click the Add button.

A new empty row is appended to the existing list of properties.


	
Click the Select Values icon in the Name field of the new row.

The Properties dialog is displayed.


	
Select a property that is valid for the particular adapter from the list of properties, and then click OK.


	
Click Save.

You have added a predefined property for an inbound adapter.







For more information about configuring adapters, see Section 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






28.1.3 Creating a New Property for an Inbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to add new properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To create a new property for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Create a new property:

	
Click the Properties tab to see the list of the currently defined binding properties.


	
Click the Add button.

A new empty row is appended to the existing list of properties.


	
Specify the property name and value in the Name and the Value fields of the new row.


	
Click Save.

You have created a new property for an inbound adapter.







For more information about configuring adapters, see Section 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






28.1.4 Deleting a Property for an Inbound Adapter

You can delete only properties that you added from the predefined list of properties or the ones that you newly created.

To delete a property for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Delete a property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to delete, and then click Delete.

A message asking you to confirm your action is displayed.


	
Click OK to confirm.


	
Click Save.

You have deleted a property for an inbound adapter.







For more information about configuring adapters, see Section 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






28.1.5 Reverting a Property Value for an Inbound Adapter

You can only revert the properties that you have changed. Also note that you can perform the revert operation only on the existing property values and not on those that you added from the predefined list of properties or the ones that you created.

To revert a property value for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA Composite home page is displayed.


	
Click the inbound adapter (service) from the Services and References section in the right panel.

The Service Home page is displayed.











	
Revert a property value for an inbound adapter:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to revert, and then click Revert.

A message asking you to confirm your action is displayed.


	
Click OK to confirm.


	
Click Save.

You have reverted a property value for an inbound adapter.







For more information about configuring adapters, see Section 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.








28.2 Configuring the End Point Properties for an Outbound Adapter

This section describes how to configure the end point properties for an outbound adapter. It includes the following topics:

	
Section 28.2.1, "Editing a Predefined Property for an Outbound Adapter"


	
Section 28.2.2, "Adding a Predefined Property for an Outbound Adapter"


	
Section 28.2.3, "Creating a New Property for an Outbound Adapter"


	
Section 28.2.4, "Deleting a Property for an Outbound Adapter"


	
Section 28.2.5, "Reverting a Property Value for an Outbound Adapter"






28.2.1 Editing a Predefined Property for an Outbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to edit the predefined properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To edit a predefined property for an outbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Edit a predefined property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to edit.


	
Edit the value in the Value text box, and then click Save.

You have edited a predefined property for an outbound adapter.










	
Note:

For Oracle MQ Series Adapter in an asynchronous outbound request/reply scenario, properties are differentiated by an (Enqueue) or (Dequeue) label. For example, QueueName(Enqueue) is used for putting a message and QueueName(Dequeue) is used for dequeuing the reply.
When editing Oracle MQ Series Adapter properties in this scenario, note the following:

	
If you change the ReplyToQueueName(Enqueue) property, you must also change the QueueName(Dequeue) property to the same value.


	
If you change the MessageId(Dequeue) property, you must also change the MessageId(Enqueue) property to the same value.


	
If you change the CorrelationId(Dequeue) property, you must also change the CorrelationId(Enqueue) property to the same value.












For more information about configuring adapters, see Section 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






28.2.2 Adding a Predefined Property for an Outbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to add predefined properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To add a predefined property for an outbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Add a predefined property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Click the Add button.

A new empty row is appended to the existing list of properties.


	
Click the Select Value icon in the Name field of the new row.

The Properties dialog is displayed.


	
Select a property that is valid for the particular adapter from the list of properties, and then click OK.


	
Click Save.

You have added a predefined property for an outbound adapter.







For more information about configuring adapters, see Section 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






28.2.3 Creating a New Property for an Outbound Adapter

The properties of an adapter are usually defined in Oracle JDeveloper during design time. However, it is possible to add new properties at a later stage using Oracle Enterprise Manager Fusion Middleware Control.

To create a new property for an outbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Create a new property:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Click the Add button.

A new empty row is appended to the existing list of properties.


	
Specify the property name and value in the Name and the Value fields of the new row.


	
Click Save.

You have created a new property for an outbound adapter.







For more information about configuring adapters, seeSection 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






28.2.4 Deleting a Property for an Outbound Adapter

You can delete only properties that you added from the predefined list of properties or the ones that you newly created.

To delete a property for an outbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Delete a property for an outbound adapter:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to delete, and then click Delete.

A message asking you to confirm your action is displayed.


	
Click OK to confirm.


	
Click Save.

You have deleted a property for an outbound adapter.







For more information about configuring adapters, see Section 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.






28.2.5 Reverting a Property Value for an Outbound Adapter

You can revert changes made, if any, only for the already existing property values and not those that you added from the predefined list of properties or the ones that you newly created.

To revert a property value for an inbound adapter:

	
Navigate to a SOA composite application by using either of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Click Home.
The SOA Infrastructure page is displayed.


	
Click the Deployed Composites tab.

The list of deployed composite applications is displayed.


	
In the Composite section, click a specific SOA composite application.

The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.




	
	Under soa-infra, click a specific SOA composite application.
The SOA Composite home page is displayed.


	
Click the outbound adapter (reference) from the Services and References section in the right panel.

The Reference Home page is displayed.











	
Revert a property value for an outbound adapter:

	
Click the Properties tab to see a list of the currently defined binding properties.


	
Select the property you want to revert, and then click Revert.

A message asking you to confirm your action is displayed.


	
Click OK to confirm.


	
Click Save.

You have reverted a property value for an outbound adapter.







For more information about configuring adapters, see Section 33.1, "Configuring Service and Reference Binding Component Properties" and Oracle Fusion Middleware User's Guide for Technology Adapters.







34 Monitoring Service and Reference Binding Components

This chapter describes how to monitor service and reference binding components included in SOA composite applications.

This chapter includes the following topics:

	
Section 34.1, "Monitoring Binding Component Instances and Faults"


	
Section 34.2, "Monitoring Binding Component Rejected Messages"




For more information, see the following documentation:

	
Section 1.2.5, "Introduction to Binding Components" for conceptual details about binding components


	
Part XII, "Administering Oracle B2B" for details about Oracle B2B


	
Oracle Fusion Middleware Developer's Guide for Oracle SOA Suite






34.1 Monitoring Binding Component Instances and Faults

You can monitor instances and faults for all binding components included in SOA composite applications.

To monitor binding component instances and faults:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application.









	
Click Dashboard (if it is not selected).


	
Select a specific service or reference in the Services and References section.


	
If you select a service that is a JCA adapter or web service, the Dashboard page displays the following details:

	
A graphic representation of the total incoming messages and faults since server startup.


	
Recently rejected messages, including the message name, time of the fault, and the type of fault (business or system).




[image: Description of bc_dashboard.gif follows]




	
If you select a service that invokes a SOA composite application through a remote RMI call (known as direct binding), the Dashboard page displays similar details as described in Step 4. Direct binding enables SOA composite applications to be invoked through an API that supports transaction and security propagation across JVMs.

The word Direct is displayed in the header to indicate that this is a direct binding component. However, no Polices and Properties tabs are available for direct binding components.

[image: Description of bc_direct.gif follows]




	
If you select a reference, the Dashboard page displays the following details:

	
A graphic representation of the total outgoing messages and faults since server startup.


	
Recent faults, including the time of the fault and the type of fault (business or system).




Reference binding components are only available for JCA adapters and web services.

[image: Description of bc_dashboard3.gif follows]











34.2 Monitoring Binding Component Rejected Messages

You can monitor rejected messages for all binding components included in a SOA composite application.

To monitor binding component rejected messages:

	
Access this page through one of the following options:


	From the SOA Infrastructure Menu...	From the SOA Folder in the Navigator...
	
	Select Home.
	
Select the Deployed Composites tab.


	
In the Composite section, select a specific SOA composite application.




	
	Under soa-infra, select a specific SOA composite application.









	
Select a service or reference in the Services and References section.


	
Click Faults and Rejected Messages.

The Faults and Rejected Messages page shows the list of faults and rejected messages, including details such as the error message, time of the fault, and the associated composite instance ID. Depending upon the type of the binding component selected, the faults can be on the incoming messages processed by a service binding component or outgoing messages processed by a reference binding component.

You can perform fault recovery from this page.

[image: Description of bc_rejectedmess.gif follows]




	
Click a specific message in the Error Messages column to display complete fault details, including the fault ID, fault time, fault location, fault type, and error message text. A Recover Now option is displayed for recoverable faults. Click Recover Now to perform fault recovery.


	
If you want to delete rejected messages., click Delete Rejected Messages.


	
This displays a dialog for specifying criteria for deleting rejected messages.

[image: Description of bc_delrejectmess.gif follows]




	
Specify criteria, and click Delete.








27 Managing Oracle User Messaging Service

This chapter describes how to manage Oracle User Messaging Service.

This chapter includes the following topics:

	
Section 27.1, "Deploying Drivers"


	
Section 27.2, "Undeploying and Unregistering Drivers"






27.1 Deploying Drivers

When you install Oracle UMS, preinstalled drivers are included (Email, XMPP, SMPP, and VoiceXML). Of these, only the Email driver is deployed to the WebLogic Server. To deploy the others, target that driver to the WebLogic Server (using Oracle WebLogic Server Administration Console, or you can target the drivers when creating or extending the domain using the Oracle Fusion Middleware Configuration Wizard).

The Worklist driver must be deployed to a SOA Server if you want to make use of the UMS integration with Worklist. Because this integration involves multiple JEE applications and a SOA composite, there is a special extension template you must use to enable this feature in one step. See Install the Worklist Driver on Oracle WebLogic Platform for more information.

You can deploy additional drivers in a variety of ways using: WLST commands (recommended), Oracle Enterprise Manager Fusion Middleware Control, and through the Oracle Fusion Middleware Configuration Wizard.




	
Note:

To deploy two or more driver instances of a particular driver EAR, you must use the custom deployment plan templates available at $ORACLE_HOME/communications/plans. Deploying drivers using WLST commands is recommended because these commands automatically modify your deployment plans for you; using other methods requires you to manually modify your deployment plans.









27.1.1 Deploying Drivers Using WLST Commands

You can deploy drivers using the WLST command deployUserMessagingDriver.



27.1.1.1 deployUserMessagingDriver

Command Category: UMS

Use with WLST: Online



27.1.1.1.1 Description

deployUserMessagingDriver is used to deploy additional instances of user messaging drivers.Specify a base driver type (for example: email, xmpp, voicexml, and others) and a short name for the new driver deployment. The string usermessagingdriver- is prepended to the specified application name. Any valid parameters for the deploy command can be specified, and is passed through when the driver is deployed.






27.1.1.1.2 Syntax


deployUserMessagingDriver(baseDriver, appName, [targets], [stageMode], [options])



	Argument	Definition
	baseDriver	Specifies the base messaging driver type.
Must be a known driver type, such as email, proxy, smpp, voicexml, or xmpp.


	appName	A short descriptive name for the new deployment. The specified value is prepended with the string usermessagingdriver-.
	targets
stageMode

options

	Optional. Additional arguments that are valid for the deploy command can be specified and passed through when the new driver is deployed.










27.1.1.1.3 Examples

To deploy a second instance of an email driver with name myEmail.


wls:/base_domain/serverConfig> deployUserMessagingDriver(baseDriver='email', appName='myEmail')


To deploy a second instance of an email driver, specifying deployment targets.


wls:/base_domain/serverConfig> deployUserMessagingDriver(baseDriver='email', appName='email2', targets='server1,server2')










27.1.2 Deploying Drivers Using Oracle Enterprise Manager Fusion Middleware Control

To deploy drivers using Oracle Enterprise Manager Fusion Middleware Control:

	
Retrieve a deployment template (for example: ORACLE_HOME/communications/plans)


	
Copy the plan to a location of your choice (to the same directory or any other directory).


	
Edit the plan:

Replace DriverDeploymentName with whichever name you want to use (ensure you replace all instances of the name).

Replace DriverShortName with any name you like.

Replace the @RunAsPrincipalName@ token with a valid principal for use by UMS. In a default deployment, the system principal OracleSystemUser is available for this purpose.


	
Start Oracle Enterprise Manager Fusion Middleware Control.


	
Enter the location of the .ear file.
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Click Next.

The Select Target page appears.


	
Enter the location of the deployment plan.

[image: Select Target screen]




	
Select the SOA target.


	
Enter an application name in the Application Attributes page. The application name must exactly match the string used for DriverDeploymentName (in Step 3 above) which is provided in the deployment plan. If it does not, the deployment and activation fails. The Deployment Setting page appears.

[image: Description of ns_dep3.gif follows]




	
Click Deploy. The Deployment Completed page appears.

[image: Deployment Complete screen]




	
To see the result (driver deployed), start the SOA Server.









27.1.3 Deploying Drivers Using the Oracle Fusion Middleware Configuration Wizard

To install the SMPP, XMPP, and VoiceXML drivers, extend the domain using the extension template available at $ORACLE_HOME/common/templates/applications/oracle.ums.drivers_template_11.1.1.jar.To extend a domain using Oracle Fusion Middleware Configuration Wizard:

	
Launch Oracle Fusion Middleware Configuration Wizard ($ORACLE_HOME/common/bin/config.sh or %ORACLE_HOME%\common\bin\config.cmd).


	
Select the Extend an existing WebLogic domain option.


	
Select the desired domain directory containing UMS.


	
Select the Extend my domain using an existing extension template option.


	
Click Browse, and navigate to $ORACLE_HOME/common/templates/applications


	
Select oracle.ums.drivers_template_11.1.1.jar.


	
Complete the remaining steps of the Oracle Fusion Middleware Configuration Wizard, and remember to target the required drivers to the desired Oracle WebLogic Servers and/or clusters.


	
Restart the appropriate Oracle WebLogic Servers.











27.2 Undeploying and Unregistering Drivers

Since Messaging Drivers are standard JEE applications, they can be undeployed from the Oracle WebLogic Server using standard Oracle WebLogic tools such as the Administration Console or WLST.

However, since the UMS server keeps track of the messaging drivers that have been registered with it in a persistent store (database), this registration must be cleaned in a separate step using a runtime MBean exposed by the UMS server. The procedure to do this from Oracle Enterprise Manager Fusion Middleware Control is as follows.

To undeploy and unregister drivers:

	
Ensure the UMS server is available.


	
In Oracle Enterprise Manager Fusion Middleware Control, select any usermessagingserver target in the domain.


	
From the target's menu, select System MBean Browser.


	
In System MBean Browser, locate the ComponentAdministration MBean of usermessagingserver:

Expand the folder com.oracle.sdp.messaging > Server (such as Server: soa_server1) > SDPMessagingrun time > ComponentAdministration.


	
Invoke the operation listDriverInstances.

	
Click the Operations tab.


	
Click the operation listDriverInstances.


	
Click Invoke.


	
Identify and copy the name of the driver you want to unregister. (for example: /Farm_soa_bam_domain/soa_bam_domain/soa_server1/usermessagingdriver-email:oracle_sdpmessagingdriver_email#Email-Driver)
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Click Return.


	
Invoke the operation unregisterDriverInstance with the desired driver name.

	
Click the operation unregisterDriverInstance.


	
Paste the driver name in the Value field (for example: /Farm_soa_bam_domain/soa_bam_domain/soa_server1/usermessagingdriver-email:oracle_sdpmessagingdriver_email#Email-Driver).


	
Click Invoke.
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Check the confirmation dialog for success.




This completes the unregistration of the specified driver from the UMS server and it is no longer used in future message delivery.





Part III


Administering the SOA Infrastructure

This part describes how to administer the SOA Infrastructure.

This part includes the following chapters:

	
Chapter 3, "Configuring the SOA Infrastructure"


	
Chapter 4, "Monitoring the SOA Infrastructure"






Part I



Introduction to Oracle SOA Suite and Oracle Business Process Management Suite

This part describes Oracle SOA Suite and Oracle Business Process Management Suite.


This part includes the following chapter:

	
Chapter 1, "Introduction and Concepts"






2 Getting Started with Administering Oracle SOA Suite and Oracle BPM Suite

This chapter describes how to access Oracle Enterprise Manager Fusion Middleware Control and SOA Infrastructure configuration, monitoring, and management tasks.

This chapter includes the following topics:

	
Section 2.1, "Logging In to Oracle Enterprise Manager Fusion Middleware Control"


	
Section 2.2, "Navigating to Oracle SOA Suite and Oracle BPM Suite Administration Tasks"


	
Section 2.3, "Logging Out of Oracle Enterprise Manager Fusion Middleware Control"




For more information about service engines, service components, binding components, and the SOA Infrastructure, see Chapter 1, "Introduction and Concepts."



2.1 Logging In to Oracle Enterprise Manager Fusion Middleware Control

This section describes how to log in to Oracle Enterprise Manager Fusion Middleware Control.

To log in to Oracle Enterprise Manager Fusion Middleware Control:

	
Use Microsoft Internet Explorer 7, Mozilla Firefox 2.0.0.2, Apple Safari 4.0, or Mozilla Firefox 3.0.x to access the following URL:


http://host_name:port/em


The variable host_name is the name of the host on which Oracle Enterprise Manager Fusion Middleware Control is installed and port is a number that is dynamically set during installation. This port is typically 7001, but is the HTTP port associated with Oracle HTTP Server. For environments in which the SSL port was enabled during configuration, the default port is 7002.


	
Enter weblogic/password and click Login.

where:

	
weblogic is the default administrator user name for Oracle Enterprise Manager Fusion Middleware Control (you can change this during installation).


	
password is the password you entered during Oracle SOA Suite installation.




The Accessibility Preference dialog appears the first time you log in. If you want, you can select to not display this option again.


	
Select an appropriate action and click Continue.

The farm home page is displayed. From there, you can navigate to Oracle SOA Suite and Oracle BPM Suite in several different ways, as described in the following sections.




For more information about installation, see Oracle Fusion Middleware Installation Guide for Oracle SOA Suite and Oracle Business Process Management Suite.






2.2 Navigating to Oracle SOA Suite and Oracle BPM Suite Administration Tasks

This section describes methods for navigating to Oracle SOA Suite and Oracle BPM Suite administration tasks in Oracle Enterprise Manager Fusion Middleware Control:

	
Section 2.2.1, "Navigating Through the SOA Infrastructure Home Page and Menu"


	
Section 2.2.2, "Navigating Through the SOA Composite Application Home Page and Menu"


	
Section 2.2.3, "Navigating Through the Partition Home Page and Menu"


	
Section 2.2.4, "Navigating to Deployed Java EE Applications"


	
Section 2.2.5, "Navigating to the Oracle WebLogic Server Administration Console and Other Pages"


	
Section 2.2.6, "Navigating to the SOA Infrastructure or SOA Composite Application Home Page"







	
Note:

The Farm menu is always displayed at the top of the navigator. As you expand the SOA folder in the navigator and click the links displayed beneath it, the SOA Infrastructure menu becomes available at the top of the page.









2.2.1 Navigating Through the SOA Infrastructure Home Page and Menu

You can navigate to Oracle SOA Suite and Oracle BPM Suite administration tasks through the SOA Infrastructure home page and menu. The SOA Infrastructure provides you with access to all deployed SOA composite applications, service engines, service components, business events, and other elements.

To navigate through the SOA Infrastructure home page and menu:

	
Expand SOA > soa-infra in the navigator.

This displays all SOA composite applications running in the SOA Infrastructure for that managed server. These composites are grouped into the partition in which they are deployed.

[image: Description of sca_soamenu2.gif follows]




	
Click soa-infra.

This displays the Dashboard page of the SOA Infrastructure. Click the help icon at the top of this page to access the Resource Center for the entire Oracle SOA Suite. The upper part of the page displays details about recently deployed SOA composite application instances, deployed composites, recent faults, and rejected messages. You can click a specific SOA composite application name or instance ID to access additional details. You can also click Show All at the bottom of each section to see more information about all items.

[image: Description of gs_soahomepage.gif follows]




The lower part of the page displays details about the service engines provided by the SOA Infrastructure and a graphical representation of the number of instances and faults for all SOA composite applications hosted in the SOA Infrastructure. You must expand these sections to see this information. Click a service engine name to access more specific details.


	
Note that the SOA Infrastructure menu appears below the soa-infra name at the top of the page.




	
Note:

Depending upon your current location, the context of this menu changes to provide you with the administrative options most relevant to your current location. For example, when you are within the pages of a SOA composite application, the SOA Composite menu is displayed or when you are on the home page of a specific partition, the SOA Partition menu is displayed.








	
Select the SOA Infrastructure menu.
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These administrative options enable you to perform the following tasks:


	Option	Description
	Home	This option displays the following details of the SOA Infrastructure Dashboard page:
	
Recent SOA composite application instances.


	
Deployed SOA composite details (status, instance, and fault counts).


	
Recent faults and rejected messages in all SOA composite application instances, including whether the instance is recoverable.


	
Number of components hosted by service engines and the faults in those components.


	
Graphical representation of the number of instances and faults for all SOA composite applications hosted in the SOA Infrastructure.




For more information, see Section 4.1, "Monitoring SOA Infrastructure Recent Instances and Faults."


	Monitoring	This option displays the following details:
	
A summary of performance statistics in the SOA infrastructure.


	
Request processing details that show the breakup of time spent in handshaking requests between the binding components, service infrastructure, and service engines.




For more information, see Section 4.2, "Monitoring Processing Requests."


	Logs	This option enables you to view and configure the logging levels for runtime loggers.
For more information, see Section 3.4, "Configuring Log Files."


	SOA Deployment	This option enables you to deploy, undeploy, or redeploy SOA composite applications.
For more information, see Section 5.1, "Deploying Applications."


	Manage Partitions	This option enables you to logically group your SOA Infrastructure into separate sections known as partitions in which you deploy your SOA composite applications. This helps you to logically group composites so that you can perform bulk lifecycle management tasks on large numbers of composites.
For more information, see Section 1.4.3.5, "Introduction to Partitioning of the SOA Infrastructure" and Section 8.10, "Grouping SOA Composite Applications into Partitions."


	Service Engines	This option provides access to monitoring and management tasks for the BPEL process, Oracle BPMN, Oracle Mediator, human workflow, and business rules service engines.
	Bindings	This option displays details about recently active document types and trading partners, and inbound and outbound end points for Oracle B2B.
	Services and References	This option displays message processing metrics for service and reference binding components in all SOA composite applications.
For more information, see Section 4.3, "Monitoring Service and Reference Binding Components in the SOA Infrastructure."


	Business Events	This option displays available business events, current event subscribers, and fault details.